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Quickstart

Learn how to image an evidence drive with Atola TaskForce 2.

Step 1. Start TaskForce 2
1. Press the Power button on the front panel of the hardware unit.

2. The following message shows on the small IP screen on the front panel: “Booting 3 min”. Wait until it disappears.

3. Open TaskForce 2 user interface:

Network mode: If TaskForce 2 is connected to your local network with an Ethernet cable or a Wi-Fi adapter, open a Chrome browser on your PC,
tablet or mobile, and enter the IP address displayed on the IP screen in its address bar.

Kiosk mode: If TaskForce 2 is not connected to the network, plug in a VGA display, mouse & keyboard. The “Kiosk mode” message appears on the IP
screen.

TaskForce 2 shows an IP address required to connect to its user interface.

https://atola.com/img/tf2/forensic-hardware-imager-front.jpg
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Step 2. Plug a source drive into TaskForce 2
1. To protect an evidence drive from any alterations, switch one of TaskForce’s 26 ports into the Source mode, using the red source/target switch next to this

port. The corresponding source indicator lights up signaling that the port is set to the Source mode and is write-protected.

2. Connect your evidence drive to the port switched to the Source mode.

Step 3. Diagnose the source drive
1. In the TaskForce 2 user interface, click Diagnose.

2. On the Select device panel, find the appropriate category (SATA, SAS, USB, File, IDE, or Extension*), expand it and select your source drive.

3. Click Start. The Diagnostics process takes a couple of minutes. If diagnostics results show that the drive is in good condition, proceed to imaging.

Diagnostics report proves the drive is in good condition.
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Step 4. Plug a target drive into the TaskForce 2
1. Switch one of the free ports into the Target mode, using the red source/target switch next to it. The corresponding source indicator turns off.

2. Connect a target drive to the port switched to the Target mode.

Step 5. Start imaging
1. In the TaskForce 2 user interface, click Image.

2. On the Select source device panel, find the appropriate category (SATA, SAS, USB, File, IDE, or Extension*), expand it and select your source drive.

3. On the Imaging sessions page, click Start new.

4. On the Select target devices panel, find the appropriate category (SATA, SAS, USB, File, IDE, or Extension*), expand it and select your target device or
devices. Then click Continue.

5. Check the imaging settings and adjust them if needed. The Settings page shows:
the source drive and the case ID
the default settings applied to this imaging session
the list of Targets to be involved in this session

6. Click Start.

Image acqusition in progress.

Atola TaskForce 2 technical specs

Drive ports
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26 drive ports

8 SATA (up to 540 MB/s)

8 SAS/SATA (up to 1000 MB/s)

4 NVMe M.2/U.2/U.3 PCIe 4.0 (up to 6000 MB/s)

4 USB (up to 400 MB/s)

1 IDE (up to 100 MB/s)

1 Extension

Drive port features

Physical source/target switch with LED indication

Hardware write protection in the source mode

Task status LED indication

Full low-level control over drive ports

Reset and SATA PHY control for the best handling of severely damaged hard drives

Drive's power control

Current sensor

Automatic overcurrent protection

Automatic short-circuit protection

Overvoltage protection

Supported drive interfaces

M.2 / U.2 / U.3 NVMe

SATA I/II/III

SAS3 (12 Gb)

USB 2.0/3.x

IDE

Flash cards via a card reader attached to any USB port

Other interfaces supported via Extension modules (see below)

Network
Two 10Gb Ethernet ports for imaging to a network server or NAS.

WiFi 802.11n 150 Mb/s adapter in access point mode. Included in the package.



CPU, motherboard, and RAM
Xeon CPU with 16 cores

Server-grade Supermicro motherboard

16 GB ECC RAM

Extension modules
Apple PCIe

FireWire

Thunderbolt 2 and 3 (2016-2017 models)

M.2 NVMe/PCIe/SATA

Indication

Power LED indicator

Signals that hardware is up and running

Color-coded port LEDs

Indicate that a task is running or finished, a process is OK or there are issues

IP display

OLED (20x2 characters). Shows an IP address to connect to the TaskForce 2 user interface or Kiosk mode

Auxiliary connections

Kiosk mode

VGA port

Two USB ports for connecting a keyboard and mouse



Database

Two DB USB 3.0 ports for connecting a USB flash media as database storage

Serial RS232 port

Fan power port

System SD card slot for boot drive

Power

Power consumption

190 Watt average, 550 Watt peak

Supply voltage

100–240 VAC, 50–60 Hz

Power supply

Internal power supply

IEC 60320 C14 power inlet

Power supply switch on the back panel

Size, weight, and temperature
Aluminum case

Dimensions

17.4 x 14.5 x 3.9 in (442 x 370 x 100 mm)

Required server rack height: 2.5U

Weight

17.2 lb (7.8 kg)

Working temperature

32° – 95°F (0°C – 35°C)



Lifetime warranty
TaskForce 2 hardware is covered by our Lifetime warranty, for as long as your software update subscription is active.

If you have an active subscription, you can request free replacement of a device, component, extension module, or cable, as well as free training and technical
support.

Learn more about Lifetime warranty →

TaskForce workflow

Atola TaskForce provides a complete feature set for a forensically sound evidence acquisition process. Based on our own decade-long experience of working with
data storage devices as well as the experience of our clients in digital forensics market we strongly recommend this workflow:

1. Diagnose the drive
TaskForce is equipped with a fully-automated diagnostics module, which diagnoses all drive systems: printed circuit board (PCB), spindle motor, head stack,
firmware, and file systems. Diagnostics will work properly even if the drive has burnt parts or damaged head stack – the routine makes use of the current monitor
that is embedded into TaskForce unit.

After diagnostics finishes, the tool prepares a report and lets you know the exact issue with the drive; it also suggests the next step to be able to retrieve the data.

https://atola.com/products/taskforce/warranty.html


Diagnostics of damaged drive.

2. Get access to the hidden drive areas
Unclip or change HPA, DCO, AMA limitations
TaskForce detects hidden areas on the drive Host Protected Area (HPA), Device Overlay Configuration (DCO), or Accessible Max Address (AMA) and can
automatically recover/remove them. To avoid change the state of the drive, HPA reset until power cycle option is available.

3. Image the evidence
To ensure efficient imaging of both good and damaged drives, TaskForce is equipped with a sophisticated and powerful imaging module that creates a bit-to-bit
copy of the evidence. Based on the diagnostics report, image drives with default settings or adjust them, should the media be damaged and require special
treatment.

https://atola.com/img/tf/manual/workflow-1.jpg
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Imaging damaged drive.
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Imaging good SSD. Speed: 550 MB/s.

4. Calculate hash
To ensure forensically sound evidence acquisition process, remember to calculate hash of the evidence and the image. It is essential way to prove image integrity.

With damaged devices, it is best to calculate hash during imaging (using segmented hashing). This way data on a fragile device is only read once, and less potential
damage to the media is caused.

Linear hash can only be calculated by reading data in sectors consecutively in one pass. When it encounters a bad sector, linear hash calulation is
discontinued.

Updating TaskForce firmware

Atola TaskForce firmware is updated on regular basis by our team. You can keep track of the updates we make to the firmware in TaskForce changelog.

Updating TaskForce firmware is easy using a remotely connected computer.

1. Plug TaskForce into to your local Ethernet network.

2. Open the Chrome browser on your PC.

3. Download the most recent version of the firmware.

4. Enter TaskForce IP address in the Chrome browser.

5. Go to the Menu on the top right.

6. Click Update firmware.
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The Update firmware command in the TaskForce 2 menu.

7. Choose update method and then click Select file.

https://atola.com/img/tf2/manual/update-firmware-1.jpg
https://atola.com/img/tf2/manual/update-firmware-1.jpg


Choosing update method on the Update firmware page.

8. In the file selector, select the firmware file and then click Open.
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Selecting the firmware file.

9. In the Update firmware dialog, click Update.
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The Update button in the Update firmware dialog.

Once the update process is completed, TaskForce software switches to the new version. No TaskForce reboot or Chrome restart is required.

To check the current firmware version, go to Menu > Update firmware.
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Check current firmware version.

Package contents (TaskForce 2)

The TaskForce 2 package includes the following items:

TaskForce 2 hardware unit Power cable
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20x SAS/SATA powered cables

2x Ethernet cat 7 cable Flash card reader
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IDE adapter
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USB-C cable IDE power cable

IDE interface cable

Quick setup guide Lifetime warranty
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USB DB

Wi-Fi adapter USB-A cable for Wi-Fi adapter
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Brackets for server rack

Set of screwdrivers
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Forensic hardware unit

To support many simultaneous imaging sessions and other forensic tasks running on its 26 ports at top speeds, TaskForce 2 hardware unit is built on extremely
robust, high-capacity components that include a server-grade motherboard, 16-thread Xeon CPU and 16 GB ECC RAM. To ensure the high quality and efficiency of
our tools, we test them on hundreds of storage devices.

This forensic hardware unit is designed for various types of digital investigations in the lab environment.

Ports, indicators & switches
Ports:

8 SATA
8 SATA/SAS
4 USB 3.0
4 NVMe M.2/U.2 PCIe 4.0
IDE
Extension slot (for Thunderbolt, Apple PCIe SSD and M.2 SSD extension modules)

Source/target switch on each of 26 ports enabling hardware write protection in source mode:

Source mode: helps safely connect and with the examined evidence drives to TaskForce 2.

Flexible port configuration: any TaskForce port can serve you as a source or target depending on your needs.

LED indicators: two indicators for each of the 26 ports. One indicator is located next to the port’s source/target switch and lights up when source mode is enabled.

https://www.linkedin.com/pulse/secret-making-atola-forensic-imagers-life-ready-atola-technology/
https://atola.com/img/tf2/tf2-front.jpg
https://atola.com/img/tf2/tf2-front.jpg
https://atola.com/products/taskforce/extensions.html
https://atola.com/img/tf2/tf2-back-angle.jpg
https://atola.com/img/tf2/tf2-back-angle.jpg


There are plenty of informative LED indicators on the front panel of the unit:

Power LED indicator to signal that hardware is up and running.

IP display to show an IP address you need to connect to the TaskForce 2 control interface using Chrome browser.

White LED source/target indicator on each of the 26 ports.

White light: port is in the Source mode, write protection is on.

No light: port is in the Target mode, write protection is off.

Color-coded LED indication of each port status

Running tasks:

https://atola.com/img/tf2/forensic-hardware-imager-ports.jpg
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Blinking green light: the task is running without issues.

Completed tasks:

Still green light: the task is completed successfully.
Still yellow light: the task completed with minor issues or warnings.
Still red light: the task failed.

Special statuses:

Still blue light: the connected drive is in Storage mode.
Blinking blue light: the task is running on a drive in Storage mode.
Blinking yellow light: user action required (in Express mode).
Blinking red light: short circuit.

Software startup and update:

Blinking blue LEDs forming a letter A: Taskforce software is booting.
Blinking yellow LEDs forming a letter A: firmware update in progress.

You can control LED brightness in TaskForce 2 settings.

Network ports:

Two 10Gb Ethernet ports handle 26 multiple imaging sessions utilizing two 10Gb network connections
One IPMI ETH port

Other connections:

Two USB 3.0 ports for connecting a USB flash media as TaskForce 2 database storage
Two USB 2.0 ports for keyboard/mouse in the Kiosk mode
VGA for connecting a monitor in the Kiosk mode
Auxiliary serial RS232 port
Auxiliary fan power port

The power socket is located on the back side of the unit.

Supported hard drive interfaces: SATA I/II/III, SAS3 (12Gb), USB 2.0/3.0, IDE, M.2/U.2 PCIe NVMe up to 4.0.

Flash memory cards are supported via a card reader plugged into any USB port of TaskForce 2.

Display
IP display: OLED (20x2 characters)

https://atola.com/products/taskforce/manual/imaging-to-e01-storage.html
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Physical / Environmental
Dimensions: 17.4 × 14.5 × 3.9 in (442 × 370 × 100 mm)
Weight: 17.2 lb (7.8 kg)
Working temperature range: 32° – 95°F (0°C – 35°C)
Power consumption: 140 Watt average, 650 Watt peak
Supply Voltage: 100–240 VAC, 50–60 Hz
RoHS compliant

Other specs
Internal OS: Linux running a custom kernel
Control interface: web-based TaskForce application
Removable NVMe SSD for internal case management database
Optional WiFi 802.11n 150 Mb/s adapter in access point mode for easy connectivity (purchased separately)

Inside TaskForce forensic hardware unit
TaskForce 2 forensic hardware unit is essentially a small server-grade computer running Linux. But because neither BIOS nor Linux kernel was designed to handle
hard disk failures, Atola engineers have invested a significant amount of research and development efforts to build a highly customized and fine-tuned Linux kernel
that fully overcomes these issues and handles damaged media properly. Additionally, this kernel features:

High-speed DMA data transfers, 500+ MB/s
Full low-level control over SATA, USB and IDE ports
Full native SATA support
Reset and SATA PHY control for best handling of severely damaged hard drives
All BIOS and standard kernel functions are disabled

TaskForce 2 hardware also features Atola's proprietary circuitry for the ultimate drive's power control:

Current sensor for in-depth hard disk diagnosis
Automatic overcurrent and short-circuit protection
Overvoltage protection

These features are a must for proper handling of damaged drives.

https://atola.com/img/tf2/manual/ip-screen.jpg
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For instance, low-level control of the SATA, SAS, USB and IDE ports allows TaskForce 2 to handle the devices that do not properly initialize, have many bad sectors,
or frequently freeze due to internal (mechanical) failures. SATA PHY control allows resetting a frozen hard drive without a power cycle, thus saving time during
imaging, and reducing the chances of further hard disk degradation and failure. Current sensing allows TaskForce to diagnose a failed drive even if it has electronic
or mechanical damage.

Overcurrent protection detects when the drive draws an abnormal current and stops it to prevent any further damage. An overvoltage protection circuit ensures
that in the unlikely event of a hardware malfunction, the attached drives are not damaged in any way.

TaskForce 2 forensic hardware unit is fully controlled by the software via Chrome browser, therefore no Linux experience is required to operate it.

M.2 SSD extension module

You can connect M.2 PCIe NVMe and M.2 PCIe AHCI solid state drives to Atola TaskForce 2 using the M.2 SSD extension module.

This extension module supports only B & M key and M key interface drives.
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M.2 SSD extension module works with Atola DiskSense 2 as well.

TaskForce features supported for the M.2 SSD extension
All standard TaskForce operations and features are supported for the M.2 PCIe NVMe and M.2 PCIe AHCI including:

Max read/write speed: 4000 MB/s
Drive hotplug (excluding M.2 PCIe AHCI drives)
Write protection with the physical source/target switch
Diagnostics
Physical and logical imaging
Hash calculation
Damaged drive support

Plug and unplug the M.2 SSD extension module
TaskForce hardware unit is equipped with the PCI Express port on its back panel, which is referred to as an Extension port. It is used to plug Atola hardware
extension modules supported by Atola TaskForce software.

Important: Do not plug or unplug the extension module when TaskForce is powered on, this can damage the extension module or TaskForce hardware unit.
However, you can hotplug M.2 PCIe NVMe drives when the extension module is already connected and fixed in place.

To connect the M.2 SSD extension module to TaskForce, do the following:

1. Power off TaskForce.

https://atola.com/img/tf/manual/m-key-b-key.png
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2. Align 3 holes on the extension module and 3 screw holes on the Taskforce back panel. Firmly plug the M.2 SSD extension module into the Extension port
and fasten the module with 3 screws.

3. Plug an M.2 PCIe NVMe, or M.2 PCIe AHCI, into the extension and fasten the drive in place with the black plastic slider.

4. Power on TaskForce.

To disconnect the M.2 SSD extension module or replace it with another extension module, do the following steps:

1. Power off TaskForce.

2. Disconnect the SATA cable from the extension module.

3. Release the screws, which hold the module, and unplug it from the Extension port.

4. Optional: Plug another extension module into the Extension port and fasten the module with a screw.

5. Power on TaskForce.

Distinguish between M.2 NVMe/M.2 AHCI, and M.2 SATA drives
All solid state drives with M.2 form factor look pretty much the same.

To define the type of the particular M.2 drive before connecting it to TaskForce, check the markings on the drive or refer to the manufacturer’s specifications.

Connect and identify an M.2 NVMe or M.2 AHCI drive
To identify the M.2 PCIe NVMe or M.2 PCIe AHCI drive, TaskForce must be first booted with that particular type of drive connected to the M.2 SSD extension
module:

1. Power off TaskForce.

2. Plug an M.2 PCIe NVMe or M.2 PCIe AHCI drive into the extension and fasten the drive with the black plastic slider.

3. Power on TaskForce and wait for the booting to be completed.

4. In the TaskForce main window, click Devices.

5. Click the port in the EXT section of the Select device panel.

https://atola.com/img/tf/manual/taskforce-m2-ssd-extension-led.avif
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NVMe M.2 drive in the EXT section of the Select device panel.

Work consecutively with several M.2 NVMe drives
Drive hotplug is supported for M.2 PCIe NVMe drives, but not for M.2 PCIe AHCI drives. You can plug several M.2 NVMe drives one after another, without turning
TaskForce off and on.

To identify the M.2 PCIe NVMe drive, TaskForce must be first booted with that particular type of drive connected to the M.2 SSD extension module. After you boot
TaskForce with an M.2 NVMe drive connected to the extension module, the system identifies all other M.2 NVMe drives without rebooting the hardware unit.

To define the type of the particular drive, check the markings on it or refer to the manufacturer’s specifications.

Connect a U.2 NVMe drive using adapter
To use a drive with U.2 interface, attach the drive to TaskForce with the help of a U.2-to-M.2 adapter and a cable (not included in the package).

To connect a U.2 drive to TaskForce, do the following:

1. Plug the U.2 drive into the U.2-to-M.2 adapter using the cable.

2. Plug the U.2-to-M.2 adapter into the Atola M.2 SSD extension.

3. Plug the extension into TaskForce while the unit is powered off.

U.2 SSD adapters are available to combine them with the Atola M.2 SSD extension. Please contact your Atola dealer for more information.
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Connect and identify an M.2 SATA drive
To connect an M.2 SATA drive to the TaskForce 2, you will need to use one of the SATA ports and an M.2 to SATA SSD adapter. Please contact your Atola dealer for
more information on adapters.

Apple PCIe SSD extension module

Apple PCIe SSD extension lets you connect TaskForce to the PCIe SSDs with the custom proprietary M.2 interface within Apple laptops:

MacBook Pro, Late 2013-2015
MacBook Air, 2013-2015

TaskForce Apple PCIe SSD extension module works with Atola DiskSense 2 as well.

TaskForce features supported for Apple PCIe SSD extension
The following TaskForce operations and features are supported for the Apple drives:

Write protection with the physical source/target switch

https://atola.com/img/tf/mac-ssd-pcie-adapter.jpg
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Diagnostics
Physical and logical imaging
Hash calculation
Damaged drive support

Plug and unplug the Apple PCIe SSD extension module
TaskForce hardware unit is equipped with the PCI Express port on its back panel, which is referred to as Extension port. It is used to plug Atola hardware extension
modules supported by Atola TaskForce software.

Important: Do not plug or unplug the extension module when TaskForce is turned on, it can damage the extension module or TaskForce hardware unit.

To connect the Apple PCIe SSD extension module to TaskForce, do the following:

1. Power off TaskForce.

2. Align the screw on the extension module and the top screw hole on the Taskforce back panel. Plug the Apple PCIe SSD extension module into the Extension
port and fix the module with a screw.

3. Plug an Apple PCIe SSD drive into the extension and fasten the drive with the black plastic latch.

4. Power on TaskForce.

Important: Drive hotplug is not supported yet. TaskForce must be powered off before installing or replacing Apple PCIe SSDs.

To disconnect the Apple PCIe SSD extension module or replace it with another extension module, do the following steps:

1. Power off TaskForce.

2. Release the screw, which holds the module, and unplug it from the Extension port.

3. Optional: Plug another extension module into the Extension port and fix the module with a screw.

4. Power on TaskForce.

https://atola.com/products/taskforce/extensions.html
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Thunderbolt extension module

Thunderbolt extension enables TaskForce to work on MacBooks with the following interfaces:

1. FireWire
2. Thunderbolt 2
3. Thunderbolt 3, 2016-2017 models

No SSD removal is necessary, the extension allows connecting TaskForce directly to a MacBook.

The extension module comes with:

FireWire cable (comes in white or black color)
Thunderbolt 2 to FireWire adapter (by Apple)
Thunderbolt 3 to Thunderbolt 2 adapter (by Apple)
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TaskForce Thunderbolt extension module works with Atola DiskSense 2 as well.

TaskForce features supported for Thunderbolt extension
TaskForce supports the following operations and features on MacBooks when connected through Thunderbolt extension:

Write protection with the physical source/target switch
Physical and logical imaging
Hash calculation
Damaged drive support

Plug and unplug the Thunderbolt extension module
TaskForce hardware unit is equipped with the PCI Express port on its back panel, which is referred to as an Extension port. It is used to plug Atola hardware
extension modules supported by Atola TaskForce software.

Important: Do not plug or unplug the extension module when TaskForce is turned on, this can damage the extension module or TaskForce hardware unit.

To connect the Thunderbolt extension module to TaskForce, do the following:

1. Power off TaskForce.

2. Align the screw on the extension module and the top screw hole on the Taskforce back panel. Plug the Thunderbolt extension module into the Extension
port and fasten the module with a screw.

3. Power on TaskForce.

To disconnect the Thunderbolt extension module or replace it with another extension module, do the following steps:

1. Power off TaskForce.

2. Release the screw, which holds the module, and unplug it from the Extension port.

3. Optional: Plug another extension module into the Extension port and fix the module with a screw.

4. Power on TaskForce.
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Connect MacBook using Thunderbolt extension module
First, write down or take a photo of the serial number located on the bottom side of the MacBook. It will be needed later.

Then do the following steps:

1. Turn off both the MacBook and TaskForce.

2. Plug the Thunderbolt extension module into the Extension port and fasten the module with a screw.

3. Connect the MacBook to TaskForce unit with the help of the Thunderbolt extension and the FireWire cable. Use adapters to connect to the MacBooks with
Thunderbolt 2 or Thunderbolt 3 interface.

4. Boot the MacBook in the Target Disk Mode. To do that, start it up while holding down the T key. You should see a Firewire or Thunderbolt icon displayed on
screen, signifying that Target Disk Mode is detected and working.

5. Power on TaskForce and wait for the booting to be completed.

6. In the TaskForce main window, open the Device panel.

7. Click the port in the EXT section of the Device panel.
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MacBook device in the EXT section of the Device panel.

8. If it is the first time this MacBook is identified by TaskForce, in the Enter MacBook serial window, enter the serial number located on the bottom side of the
MacBook, and then click OK.
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Enter MacBook's serial number.

During the subsequent identifications of the MacBook connected to TaskForce, its serial number can be selected from the drop-down menu in the Enter MacBook
serial window. TaskForce will look up its case management system and offer the choice of MacBooks with the same drive size.
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Select the MacBook with the serial number you have connected to TaskForce.

Extend subscription

Atola TaskForce 2 comes with a complimentary 1-year subscription. It covers regular software updates, includes training and technical support from our in-house
team of developers, and secures a lifetime warranty.

Buy subscription
To extend your subscription for another period, you first need to place a purchase order with the reseller that sold you the unit or on the Atola website.

If your subscription has not yet expired, you can still purchase and activate a new one. The new subscription period will commence the day following the current
subscription’s expiration date.

Extend subscription
You will need:

A device with an internet connection (PC or mobile).
The serial number located on the bottom side of the TaskForce 2 unit.

After you have purchased a subscription, do the following:

1. On a device with an internet connection, open the TaskForce 2 user interface in your web browser.

2. At the top right, click Menu > Activation status.
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The Activation status option in the TaskForce Menu.

3. Click Extend subscription.
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The Extend subscription button on the Activation status page.

4. Enter the serial number of the TaskForce 2 unit.

5. Select I already extended my subscription through a distributor, and then click Next.
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The Extend subscription page.

6. Visit the Atola licensing page: a.atola.com or scan QR code on the screen.

7. On the Atola licensing page, enter the license key shown in TaskForce web interface.

8. Fill out all other fields on the Atola licensing webpage, including:
Customer name
E-mail address for activation code
Telephone
Organization, country and city
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9. Click Submit. The Atola licensing webpage generates an activation code.

10. Go back to TaskForce 2 user interface and enter the activation code in the respective field.
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Entering the activation code on the Extend subscription page.

11. Click Activate. TaskForce 2 confirms that reactivation has been successfully completed.

Connectivity and multi-user access

Atola TaskForce 2 has three connectivity options:

1. 10Gb Ethernet network
2. Kiosk mode
3. Wi-Fi access point (optional)

10Gb Ethernet network
TaskForce is equipped with two 10Gb Ethernet ports. Whenever the system is connected to a local network via one of its Ethernet ports, an IP address will be
displayed on the IP screen on the system's front panel.

Supported network features:

Two 10Gb Ethernet ports
Dynamic (DHCP) IP / Static IP address
Settings: DNS nameserver, Default gateway, Jumbo frames
Secure connection with password-protected network folders
Support of HTTPS with external organizational and self-signed certificates
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TaskForce 2 shows an IP address required to connect to its user interface

If the system is connected via both Ethernet ports, two IP addresses will be displayed on the screen. These IP addresses are assigned to TaskForce by your DHCP
server.

Multi-user access
With the help of these IP addresses, TaskForce can be operated by multiple users simultaneously from their workstations or mobile devices:

enter either of the IP addresses as shown on the IP screen in Chrome browser on another device within the same local network.

Enter IP address in Chrome browser

Through the Chrome browser one can remotely track and manage tasks, power devices on and off, open, edit and print cases, etc.

Types of devices that can be used to access TaskForce simultaneously include:
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Desktop PC
Laptop
Tablet
Smartphone

TaskForce software can be opened in the Chrome browser within any OS.

This functionality enables a group of users to work on different assignments using the same tool. This helps utilize TaskForce’s multitasking capabilities to the
maximum and track operation progress remotely. The number of users accessing TaskForce simultaneously is unlimited.

Kiosk mode
Use TaskForce without any network connection in the Kiosk mode by plugging a VGA monitor, keyboard, and mouse into respective ports on the back side of the
TaskForce hardware unit.

Whenever the system is not connected to a network via its 10Gb Ethernet ports, the Kiosk mode status is displayed on the IP screen.

Once a monitor is plugged in, it displays the Taskforce user interface, and you can operate the system using a keyboard and mouse.

TaskForce 2 in the Kiosk mode.

Wi-Fi access point
The third way to access TaskForce's user interface is via a Wi-Fi 802.11n 150 Mb/s adapter (included in the package). Once the Wi-Fi access point is established,
TaskForce can be operated by multiple users simultaneously from their devices connected to the hotspot.

To enable the adapter, follow these steps:

1. Plug the adapter into one of the TaskForce's USB ports.

2. Go to Menu in the top right corner of the TaskForce web page.

3. Click Settings.

4. Enable Wi-Fi Hotspot. An IP address of the hotspot will appear on the unit’s IP screen as well as under the Wi-Fi Hotspot category in the Settings window.

5. Click Settings.
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Enable Wi-Fi Hotspot

5. Enable Wi-Fi Hotspot.

6. Set SSID and Password. To make the network invisible to other devices, select Hidden mode. Click Save.

7. Use these details to connect to the Hotspot from another device.
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Adjust Wi-Fi settings

8. To open the TaskForce interface, enter the unit’s IP address (indicated on the unit’s IP screen as well as under the Wi-Fi Hotspot category in the Settings
window, see Step 4) in the Chrome browser of the device connected to the Hotspot.

Use TaskForce with multiple user profiles

For security reasons, you can allow access to Atola TaskForce only for authorized users, protect each user profile with a password, and keep processes, reports, and
cases separate and confidential for each user.

Also, you can set up Atola TaskForce to automatically lock its screen after a certain time of inactivity and to prompt a user to log in.

Setting up user roles and profiles is an optimal solution when you want to:

Share one Atola TaskForce unit with multiple colleagues at the same time.
Prevent other users from interrupting the processes you started on your TaskForce.
Prevent your colleagues from seeing each other’s cases.
Temporarily pass your TaskForce to another forensic lab, department, or agency without giving access to your cases.

What others can see and do when you share one TaskForce
After you enable User management, you become an administrator and can create up to 20 profiles with either Admin or User roles. These roles have different
permissions.

What an Admin can see and do
The first profile that you create after enabling User management has an Admin role. You can have more than one profile with the Admin role on your TaskForce.
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As an Admin, you can:

See and edit all cases of other users.
See and stop all processes run by other users.
See and print all reports created by other users.
Access and change all TaskForce settings.
Enable or disable User management.
Add, edit, or delete other user profiles with either Admin or User role.
Change other user’s password.
Set TaskForce to automatically lock the screen after a certain time of inactivity.

Admin sees all processes and cases of other users.

What a User can see and do
A profile with a User role is created by Admin and has limited access to TaskForce.

As a User, you can:

Log in only to your user profile.
See and edit only your cases.
See and print only your reports.
See, run, and stop only your processes.
Change only your password.

As a User, you can’t:

Access somebody else’s user profile.
See and edit other users’ cases.
See and print other users’ reports.
See or interrupt other users’ processes.
Access a device that is being used by another user
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Access and change TaskForce settings.
Enable or disable User management.
Add, edit, or delete other user profiles.
Change other user’s password.
Disable or configure Automatically lock screen feature set by Admin.

Profiles with a User role see only their cases and processes.
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Profiles with a User role don’t see each other’s cases and processes.

Enable User management
The first profile, what you create after enabling User management, has an Admin role.

To enable the multi-user mode in Atola TaskForce, do the following steps:

1. In the Atola TaskForce window, go to Menu > Settings.

2. In the Users section, toggle User management.

3. Enter the username and password for the administrator’s profile, and then click Create.

Now you can add, edit, or delete other user profiles.

After you enable User management, Express mode is disabled due to security reasons.
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User management toggle in the Users section of the Settings menu.

Add, edit, or delete users
Only Admin can add, edit, or delete other user profiles with either Admin or User role.

Add a user
To add a user, do the next steps:

1. Log in to a profile that has the Admin role.

2. In the Atola TaskForce window, go to Menu > Settings.

3. In the Users section, click Manage.

4. On the Users page, click Create user.

5. Enter the username and password for a user.
Optional: To grant this user an Admin role, select Admin checkbox.

6. Click Create.
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The Create user button and dialog.

Edit a user
To edit a user, do the following:

1. Log in to a profile that has the Admin role.

2. In the Atola TaskForce window, go to Menu > Settings.

3. In the Users section, click Manage.

4. On the Users page, select a user you want to edit.

5. In the Edit user dialog, edit the username.
Optional: To grant this user an Admin role, select Admin checkbox.

6. Click Save.
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The Edit user dialog.

Delete a user
After deleting a user, you can still access their cases and reports under a profile with the Admin role.

To delete a user, do the following steps:

1. Log in to a profile that has the Admin role.

2. In the Atola TaskForce window, go to Menu > Settings.

3. In the Users section, click Manage.

4. On the Users page, select a user you want to delete.

5. In the Edit user dialog, click the Delete icon.

6. In the confirmation dialog, enter YES, and then click Delete.
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The Delete icon in the Edit user dialog.

Log in and log out
To log out, click Menu > Log out. Atola TaskForce locks itself and prompts you to enter a username and password. All the processes you started before logging out
are still running in the background.

To log in, enter your username and password, and then click Log in. Atola TaskForce unlocks itself and shows its Home screen.
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Atola TaskForce is locked and prompts you to enter a username and password.

Change the password
As a User, you can change only your password. As an Admin, you can change other users' passwords as well.

Change the password for your profile
To change the password for your profile, go to Menu > Change your password, enter your current and new passwords and click Save.
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Change your password command in the Menu.

Change the password for another user as an administrator
To change the password for another user, do the following:

1. Log in to a profile that has the Admin role.

2. In the Atola TaskForce window, go to Menu > Settings.

3. In the Users section, click Manage.

4. On the Users page, select a user you want to change the password for.

5. In the Edit user dialog, enter a new password, confirm the password, and then click Save.

If you forgot or don’t know the password for an administrator profile on your TaskForce, contact Atola Support.
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Changing a user password in the Edit user dialog on the Users page.

Automatically lock screen
As an Admin, you can set up Atola TaskForce to automatically lock its screen after a certain time of inactivity. To enable this feature, log in to a profile with the
Admin role and do the next steps:

1. Go to Menu > Settings.

2. In the Users section, toggle Automatically lock screen.

3. Enter a time interval in minutes you want TaskForce to wait before automatically locking in.
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The Automatically lock screen toggle in the Users section of the Settings menu.

Disable User management and password protection
As an Admin, you can disable user management and password protection for your Atola TaskForce.

If you disable User management, cases and reports will become available to all users of that TaskForce unit.

To disable user management and password protection, do the following steps:

1. Log in to a profile that has the Admin role.

2. Go to Menu > Settings.

3. In the Users section, toggle off User management.
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Toggling off User management.

Maximize 10Gb network throughput

If you image evidence drives to a file on a server or a computer using a local network and want to achieve the best imaging speeds, maximize your network
throughput by following these tips.

Set up 10Gb Ethernet network
Atola TaskForce 2 is equipped with two 10Gb Ethernet ports. To fully use this potential and achieve the best imaging speeds, every node in your local network
between the TaskForce unit and your computer or server need to support 10Gb connection as well.

Use 10Gb network adapter

Make sure that a network adapter on your server or your computer supports a 10Gb connection:

Check vendor specifications for your network adapter.
Check the network adapter speed in your OS settings.

How to check Ethernet connection speed on Windows 10 and Windows 11

1. Go to Control panel > Network & Internet > Network and Sharing Center.

2. In the View your active networks section, click your Ethernet connection.

3. In the Status window, check the connection speed. It must be equal to 10 Gbps.
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Use 10Gb network cable

Make sure that the network cable you use to connect your TaskForce unit and your local network nodes supports 10Gb connection. It must have Cat6 (with the
length of less than 55 meters), Cat6a, Cat7, Cat7a, or Cat8 marking on it.
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Use 10Gb router or switch

If your TaskForce unit is connected through a network router or switch, make sure that every such device in your local network in between TaskForce and the target
computer or server supports a 10Gb connection:

Check vendor specifications for your network router or switch.
Check that the 10Gb network cable is connected to a 10Gb port on your router or switch.

Enable jumbo frames
To speed up your 10Gb network, enable jumbo frames on your TaskForce 2, your target device, and every network switch or router in between them.

Jumbo frames increase the efficiency of broadband Ethernet processing because they carry 9000 bytes of payload, which is more than the standard limit of payload.

Enable jumbo frames on TaskForce 2

To enable jumbo frames on your TaskForce unit, do the following:

1. In the Atola TaskForce interface, go to Menu > Settings.

2. In the Network section, toggle Jumbo frames for respective Ethernet port (ETH1 or ETH2). Default MTU (maximum transmission unit) value is set to 9000
bytes, don’t change it.

Jumbo frames toggle on the Settings page in Atola TaskForce.

Enable jumbo frames on a target computer

To enable jumbo frames for 10Gb network adapter on a target computer running Windows 10 or Windows 11, do the next steps:
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1. Go to Control panel > Network & Internet > Network and Sharing Center.

2. In the View your active networks section, click on your Ethernet connection.

3. In the Status window, click Properties.

4. In the Properties window, click Configure and go to the Advanced tab.

5. On the Advanced tab, select Jumbo Packet and change its Value to 9014 Bytes.

6. Click OK.

Enable jumbo frames on a network router or switch

Jumbo frames need to be enabled on network routers or switches, which connect your TaskForce unit with your target computer or server.
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Many 10Gb routers and switches support jumbo frames by default.

For specifications and instructions, refer to a router or switch user guide provided by its manufacturer.

Use Samba version 3.0 or later
Samba is a free software that provides fast shared access to files and printers for all network clients using the SMB/CIFS protocol.

We recommend using Samba version 3.0 or later to speed up the imaging to the files on network-connected drives.

For guidance, refer to the Samba installation guide.

Update OS and drivers
Install the latest OS and driver updates.

Due to various software issues, the local network speed can be lower than expected if the operating system and network drivers are outdated.

Check server use quota
Sometimes, a network administrator can create quotas, which limit server space or throughput for end users.

Check if there is an opportunity to change or lift these quotas to achieve maximum data throughput during imaging.

Use faster target drives
To achieve higher imaging speeds, we recommend using faster destination drives with reading and writing speeds of no less than 600 MB per second.

If you’re using a RAID array as a storage, consider choosing RAID types with faster reading and writing speed, such as RAID 0 and RAID 5.

When storing very big files, opt for a large cluster size on your server. The bigger files you want to store, the larger cluster size should be.

Use a static IP address

If you plan to connect TaskForce 2 directly to your computer, we recommend configuring your computer and TaskForce to use a static IP address. Here’s how to do
it.

Configure TaskForce 2 for using a static IP address
1. On your computer, open a Chrome browser and in its address bar enter the IP address, displayed on the TaskForce front panel.

2. In the TaskForce interface, go to Menu > Settings.
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TaskForce system menu.

3. In the Network section, find the IP settings for the ETH1 or ETH2 port and click the Edit icon next to it.
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The Edit icon next to IP settings for the ETH 1 port.

4. Enter the following network settings:
IP address: 10.0.0.XXX, where XXX can be any number from 1 to 254.
Default static IP addresses of the TaskForce unit are 10.0.0.215 and 192.168.0.215.
The IP address of your PC's Ethernet card must be different from that of the TaskForce unit.
Network mask: 255.0.0.0.
If your PC and the TaskForce unit belong to different subnets, the connection can’t be established.
Default gateway and DNS can be left empty or set to any value.

5. Click Save. The new IP address appears on the TaskForce front panel.
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Network settings for the ETH1 port.

Connect TaskForce 2 directly to your computer
To use a static IP address, connect your computer to the ETH1 or ETH2 port of TaskForce 2 with an Ethernet network cable.

If your computer has no Ethernet port, you can use the USB-to-Ethernet adapter (not included in the package). Connect it to your computer before configuring a
network.

Configure your computer for using a static IP address
1. In Windows, open Network Connections: press Win+R, enter ncpa.cpl and click OK.

2. Right-click your Ethernet adapter, and then select Properties.

3. Select Internet Protocol Version 4, and then click Properties.

4. Enter the following network settings:
IP address: 10.0.0.XXX, where XXX can be any number from 1 to 254 except for 215.
Default static IP addresses of the TaskForce unit are 10.0.0.215 and 192.168.0.215.
The IP address of your PC's Ethernet card must be different from that of the TaskForce unit.
Network mask: 255.0.0.0.
If your PC and the TaskForce unit belong to different subnets, the connection can’t be established.
Gateway and DNS server can be left empty or set to any value.

5. Click OK.
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Jumbo frames for fast imaging to server

In TaskForce 2, Jumbo frames are activated by default to ensure maximum data transfer rates when imaging to a file on your server.

However, if Jumbo frames have been disabled, it is easy to enable them again and experience substantial boost to the speed of imaging!

First, create a file on the server, to which you will be imaging.

Creating a target file.

When you start to image to your server with Jumbo frame disabled, the data transfer speed will not exceed 700 MB/s. The actual speed will also depend on the
configuration and current traffic in the network.
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Speed of imaging without Jumbo frames.

To boost the speed:

1. Pause the imaging session.

2. Go to the Menu at the top right.

3. Click Settings.
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The Settings in the TaskForce Menu.

4. In the Network section, enable Jumbo frames of the Ethernet port you are using and set MTU to 9000.
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Enabling Jumbo frames.

For fast imaging of files to your server via 10Gb network, you need to activate Jumbo framework in the settings of the server’s network adapter as well as in
the settings of the network switch, should it be necessary (10Gb switches normally have Jumbo framework activated by default).

Then you can return to your imaging session:

1. Go to Image.

2. Select the source.

3. Click Resume.

This time, the speed is way higher!
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Imaging speed with Jumbo frames enabled.

Network setup tips

Configuring 10Gb network with DHCP-enabled switch
Getting maximum performance of Ubiquiti network
Configuring a dynamic IP for TaskForce 2 in a network without router or DHCP-enabled switch
Accessing Windows Server 2012 shared folder
Setting up Synology DS218 as storage server

Configuring 10Gb network with DHCP-enabled switch

You need to create or extend network with DHCP-enabled switch with 10Gb connection.

Example. Ubiquiti EdgeSwitch 16 XG: four 10Gb Ethernet ports, twelve 10Gb SFP ports. Approximate price: $600.

This kind of switch supports static IP setup via simple web admin. So you could set the IP addresses you need for each current network device.

How to configure Ubiquiti DHCP server:

1. Connect PC and TaskForce 2 to Ubiquiti switch.

2. Set static IP address of PC to 192.168.1.4.

3. Open a browser and enter 192.168.1.2 (default Ubiquiti switch IP).

4. Log in with default credentials: ubnt (both in name and password fields).

5. Go to System > Advanced Configuration > DHCP server > Global.

6. Activate Admin mode by checking a necessary checkbox and pressing Submit button.
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7. Go to Pool Summary and press Add to make a new address pool.

8. Enter your:
pool name
network base address (for example, 192.168.1.0)
network mask (in most cases, it should be 255.255.255.0)
put Default Router Address and DNS

After creating your pool, you can change it via Pool configuration tab.

9. Click Save configuration button in the upper right corner of the window and click Save.

You can check this Youtube guide for alternative instructions on network setup using Ubiquiti switch.

Getting maximum performance of Ubiquiti EdgeSwitch 16 XG network

To optimize performance using Ubiquiiti EdgeSwitch 16 XG, you need to enable 10Gb with jumbo frames:

1. Go to Basic > Port summary.

2. Select ports 0/13, 0/14, 0/15, 0/16 and click Edit.

3. Change Maximum Frame Size to 9014 in Edit Port configuration window.

Configuring a dynamic IP for TaskForce 2 in a network without router or DHCP-enabled switch

If there is no hardware in the network that assigns IP address, or if you want to keep a small network with TaskForce 2 and your server/PC connected directly, it is
possible to install and setup software DHCP server. The good news is, it does not require any investment. All you need is some time to set it up on any computer in
the server network. Follow the instructions from these guides:

Windows: Free DHCP server.
Linux: Included DHCP service.

Accessing Windows Server 2012 shared folder

If you want to store a target image file in a Window Server 2012 network folder but it appears missing, please follow these steps:

1. Go to Control panel.

2. Enable Guest account (Administrative tools > AD users and computers > Users).

3. Network and sharing center > Change advanced sharing settings > Turn On network discovery + Turn on sharing (file and printers + public folders).

4. In the shared folder access options, add Guest or Everyone.

If the shared folder demands restricted access, please follow this guide.

Setting up Synology DS218 as storage server

To set up Synology DS218:

1. Go to Control panel > File services > SMB > Advanced settings.

2. Set Maximum protocol to SMB3.

3. Go to Control panel > Shared folder.

4. Click Create button and specify network folder details.

If you need to get a guest account working, run the following actions:

1. Go to Control panel > User.

2. Edit for Guest user.

3. Clear the Disable this account checkbox.

For more instructions and information about check our Troubleshooting guide and FAQ page.
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Configuring TaskForce use with Synology or QNAP NAS as a LAN

Here is a guide to configure your NAS to be used with TaskForce 2 for storage of image files.

This manual is indicative and may vary between models and manufacturers. We have tested this setup on Synology DS218 and QNAP TS-431K.
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Setting up a Synology NAS
1. Install drives in the Synology NAS.

2. Use a LAN cable to connect the DiskStation to your switch, router, or hub.

3. Press the power button to turn on your Synology NAS.

4. Install DiskStation Manager (DSM) – Synology’s browser-based operating system – on your DiskStation.

5. Follow the instructions to create a RAID volume and a partition with a file system on it.

Enabling SMB3 is highly recommended for the best performance:

a. Go to Control panel > File services > SMB > Advanced settings.

b. Set Maximum protocol to SMB3.

c. Go to Control panel > Shared folder.

d. Click Create and specify network folder details.



6. Create a Shared folder in the new volume:
Control panel > File sharing > Shared folder > Create > Create Shared Folder

7. In the folder creation menu, set the folder name, e.g. Image Files and set access options.

Setting up a QNAP NAS
1. Install drives in the QNAP NAS.

2. Use a LAN cable to connect the QNAP to your switch, router, or hub.
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3. Press the power button to turn on your QNAP.

4. Install Qfinder Pro for quick find and easy access to QNAP NAS on the same LAN.

5. Find your QNAP using Qfinder Pro and go to its page in the browser.

6. Follow instructions to complete Smart Installation.

7. Create Storage Pool (RAID):
a. Storage & Snapshots.
b. Storage (left menu).
c. Storage/Snapshots.
d. New Storage Pool (in the the top right corner).
e. Follow the instructions to set up the Storage Pool.
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8. In the final stages of setting up the Storage Pool, create a New Volume.

9. In the File Station utility, you can find the new volume: QNAP. In it, there is a Shared Folder created by default called Public.
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10. For a Shared Folder with specific access or encoding settings, create a new one by clicking the icon showing a folder with a + and adjust the configuration.
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Direct connection with a Static IP:
Since we are not connecting TaskForce and Synology/QNAP NAS to a wider network, it is enough to set up the same Subnet Mask for the NAS and the TaskForce,
and configure Static IP addresses that will indicate the same network.

https://atola.com/img/tf/manual/nas-7.jpg
https://atola.com/img/tf/manual/nas-7.jpg


TaskForce 2 configuration
1. Go to Menu > Settings > Network section.

2. Select the Ethernet port through which Synology is connected (e.g. ETH1).

3. Click IP settings’s Edit icon.

4. In the ETH settings dialog, enter the address (e.g. 255.255.0.0) in the Subnet Mask field that is identical to that of Synology.

5. Assign an IP address using the Subnet Mask: the first two bytes of TaskForce’s IP must be identical to those of IP Synology (e.g. 10.0.0.15). This will ensure
that both TaskForce and Synology belong to the same network. (e.g. 10.0.0.8).
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6. Click Save.

Setting up a Static IP in Synology
1. Go to the Control panel.

2. Open Network interface.

3. Select the current connection to Synology.

4. Click Edit.
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5. On IPv4 tab, select Use manual configuration.

6. Assign Subnet Mask (e.g. 255.255.0.0), which is identical to that of TaskForce.

7. Assign IP address (e.g.: 10.0.0.15).

8. Click ОК.

9. After Synology has changed the settings, it can be disconnected from the current network.
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Setting up Static IP in QNAP
1. In the Control panel, go to Network & Virtual Switch.

2. Select the current connection to QNAP.

3. Open the Menu.

4. Click Configure.

5. On the IPv4 tab, select Use static IP address.

6. Assign a Subnet Mask (e.g. 255.255.0.0), which is identical to that of TaskForce.

7. Assign an IP address (e.g.: 10.0.0.16).

8. Gateway field should be left blank because you are configuring a LAN and connecting to other networks is unnecessary.

9. Jumbo Frame and Network speed should be left with the default values.

10. Click Apply.
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11. After the QNAP has changed the settings you can disconnect it from the current network.

Connecting to the Shared Folder in TaskForce 2
1. Connect the Synology/QNAP NAS to TaskForce’s ETH1 port.

2. Click the Devices icon in the upper right corner. Go to the File section and click Select File.

3. Click Connect.

4. Enter the Server name, Username, Password.
If you do not remember the server name, look it up:
Synology > Control Panel > Info Center > Server name
QNAP > Control Panel > General Setting > Server name

5. Click Connect.
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6. TaskForce 2 has connected to Synology and you can open the previously created Shared Folder.
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Setting up a LAN using router with DHCP (Dynamic IP)

Setting up router
1. Connect the router directly to your PC or laptop via the Ethernet port.

2. Log in to the web configurator.

3. Turn on the DHCP server in the local network settings.

4. Apply changes.
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Setting up DHCP in TaskForce 2
1. Open Menu > Settings, go to the Network section.

2. Select the Ethernet port to which Synology will be connected. (e.g. ETH1).

3. Click the Edit icon to adjust the IP settings.

4. Clear the Use static IP address checkbox.

5. Click Save.
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Setting up DHCP in Synology
1. Go to Control panel > Network > Network interface.

2. Select the current connection to Synology and click Edit.

3. On the IPv4 tab, select the Get network configuration automatically (DHCP) option.
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Setting up DHCP in QNAP
1. In the Control panel, go to the Network & Virtual Switch.

2. Select the current connection to QNAP, open the Menu and select Configure.
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3. On the IPv4 tab, select Obtain IP address settings automatically via DHCP.

Connecting the LAN devices
After all the reconfigurations, connect TaskForce 2, NAS and your PC or laptop to the router using Ethernet ports and connect to the Shared Folder as described
above.

Connecting drives & starting Atola TaskForce 2

This page provides information about the startup procedure of Atola TaskForce 2, to ensure the safe and effective operation of the unit.

Powering on TaskForce
The power button is located on the front panel of the unit. To start TaskForce, press the power button.
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Booting
The booting process takes up to 3 minutes.

Once booting is completed, the IP screen on the front panel will display either the "Kiosk mode" message or an IP address if the unit is connected to the local
network using an Ethernet cable. At this point, the unit is ready for operation.

Connecting drives
TaskForce supports SAS, SATA, USB, NVMe M.2/U.2 PCIe, and IDE drives via its 25 ports, as well as other storage devices via Thunderbolt, Apple PCIe, and M.2 SSD
extension modules.

To ensure both TaskForce and the devices connected to it are used properly and safely, read the instructions below.

Connecting M.2 devices

M.2 ports support hotplug to allow for drives to be regularly swapped, without restarting the whole system. To connect an M.2 drive to TaskForce 2, do the
following:

1. Push the tray ejection button located on the left side of an M.2 tray.

2. Pull the M.2 tray out from its bay.

https://atola.com/img/tf2/manual/ip-screen.jpg
https://atola.com/img/tf2/manual/ip-screen.jpg
https://atola.com/img/tf2/tf2-front.jpg
https://atola.com/img/tf2/tf2-front.jpg


3. Remove the 4 screws at the bottom side of the M.2 tray with a PH1 screwdriver.

4. Slide the black Icy Dock adapter to the side to remove it out of the tray.

5. Snap off the heatsink of the Icy Dock adapter by pushing it up from the sides.
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6. An adjustable M.2 locker slides to accommodate all the standard M.2 PCIe NVMe SSD drive lengths, including 2230 (30mm), 2242 (42mm), 2260 (60mm),
and 2280 (80mm). Adjust the M.2 locker to the drive length.
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7. Insert the M.2 drive into the M.2 connector and then slightly press the drive down. A spring latch locks the drive with a “click” sound. To release the spring
latch, slide the locker open by moving the two plastic levers situated on both sides of the drive.
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8. Once the drive is plugged into a connector and secured with a latch, snap the heat sink lid on.

9. Slide the Icy Dock adapter back into the M.2 tray.

10. Use at least one screw to secure the adapter onto the tray.

11. Important: Make sure that the U.2 connector of the adapter faces the bay and the heatsink with the “Icy Dock” logo faces up.

12. Insert the M.2 tray back into the M.2 bay, make sure it is pushed inside all the way, and then close the lock of the tray.

Connecting extensions

Before connecting an extension module, make sure TaskForce is powered off. Plug the extension module into the extension slot located on the back panel of
TaskForce and power the unit on.

https://atola.com/img/tf2/manual/icy-dock-03.jpg
https://atola.com/img/tf2/manual/icy-dock-03.jpg


Hardware write protection

Each port is equipped with an individual Source switch enabling hardware write protection on the port. To make sure data on an evidence drive is not overwritten,
check if the port is in the source before connecting the drive.

Connecting SATA & SAS drives

TaskForce has 8 SATA and 8 SATA/SAS ports. When a drive is connected to TaskForce, the port is powered off by default, therefore the device is not immediately
identified.

To identify the device, click the Devices button in the top panel of the TaskForce interface, and TaskForce will start drive identification process on all ports. The
system ensures a sustainable overall power consumption in situations when many drives are plugged in. That's why drives are powered not all at once but
sequentially, in a matter of a few seconds.

Powering off TaskForce
To power off the TaskForce hardware unit:
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1. In TaskForce window, stop all active tasks.

2. Press the power button on the front panel of the unit for 5 seconds.

Supported Drives

Atola TaskForce 2 supports all 1.8-inch, 2.5-inch, 3.5-inch IDE, SATA, SAS and USB hard drives, USB Flash media as well as SD, Compactflash, and Memory Stick cards
via a generic USB Card Reader. Its four ports for NVMe SSDs supporting the following form factors: M.2, U.2, U.3.

TaskForce 2 can also work with the following drive types using proprietary Atola extension modules:

M.2 NVMe/PCIe/SATA SSDs
latest Apple SSDs via Thunderbolt extension
the newest PCIe SSDs from Apple MacBooks (2013 - 2015)

Remote image acquisition can be performed using the iSCSI protocol. To do this, you need to mount a drive on another PC as an iSCSI target.

Most functions of Atola TaskForce 2 will work with any hard drive or flash card with either IDE, SATA-1/2/3 or USB-1/2/3 interface (including those attached via
adapters).

To ensure high quality and efficiency of our tools, we test them on hundreds of storage devices.

Head selection works for the following HDD models
SATA and IDE Seagate hard drives (including F3 series)
SATA and IDE Western Digital, HGST hard drives with exception of some models released since 2018
SATA and IDE Hitachi hard drives
SATA and IDE Toshiba hard drives: MG, MK, MQ, DT, HD families with exception of some models released since 2018

RAID support: unknown configuration detection, reassembly, and imaging
RAID 0, 1, 5, 6, 10, JBOD
Hardware RAID controllers: Adaptec, Areca, HP, Dell, LSI, Intel RST, IBM ServeRAID, other generic controllers
Software RAID: mdadm
Synology NAS RAID
File systems: NTFS, exFAT, ext4/3/2, XFS, ZFS, Btrfs, APFS, HFS/HFS+, FAT32/16

TaskForce drive identification

Atola TaskForce is designed to perform multiple processes simultaneously and provide its users with unprecedented flexibility when it comes to a variety of devices
and configurations in which they can be used. TaskForce also efficiently communicates how a device is being used and helps a user to handle drives correctly.

Switch between the Source and Target mode
When connecting a drive to the system, make sure the right mode is set on the port: in the source mode, an evidence drive is automatically write-protected. It can
only be changed with Source hardware switches.
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Source hardware switches.

Initial drive identification
As soon as you choose a particular task or click Devices in the top bar, TaskForce starts sequentially supplying power and sending commands to identify all
connected devices.

After a connected drive receives power supply and identification commands from the unit, it responds with device info including:

device model and serial number;
device capacity;
limitations of the drive.

Detection of password protection and HPA/DCO/AMA restrictions
TaskForce software also immediately detects whether the drive is locked by an ATA password or the drive’s max readable address is limited via HPA/DCO/AMA. The
unit indicates these restrictions and notifies a user about those with the red color indication in the device menu.
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TaskForce detects ATA, HPA/DCO/AMA limitations

These indicators allow a user to make informed decisions on how to proceed with the device, whether unlocking is required to get access to the whole drive space
before starting an imaging session.

The ‘Device not detected’ notification
Notification Device not detected may point to one of these issues:

there is no device on the port;
the cable is not properly plugged in;
the device is connected to another port;
the device is heavily damaged.
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Device not detected

Re-identify device
You might want to re-identify a device in one of the following cases:

A device hasn’t been detected from the first try.

You have connected another device to the drive port.

To re-identify a single device from the Select device panel:

1. In the port with your device, click the More icon (the one with three dots).

2. Select Re-identify.

To re-identify all connected devices, use the Re-identify button in the top right corner of the Select device panel. It affects only the devices in unfolded sections of
the panel.

You can also re-identify a single device from its device page by clicking the Re-identify button at the bottom.

When the drive port is unavailable
If a source drive is busy with a running operation, the port will be temporarily unavailable for selection when launching other tasks. In such a case, the fonts in the
respective box will be a lighter shade of grey, making the port unclickable.
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Busy source drive

When selecting a target device for wiping or imaging, source drives are also unavailable to ensure that data on an evidence drive doesn’t get overwritten by
mistake.
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Selecting target device

Add a device to a case
Once a drive is connected to a drive port and identified, you can add it to a new or existing case right from the Select device panel:

1. In the port with your device, click the More icon (the one with three dots), and then select Add case.

2. Choose between Create new case or Select existing case and click Next.

3. Enter details for a new case or select an existing case from a table.

Power off and power on a drive
From the Select device panel, you can power off and power on any connected device. To do that, in the port with your device, click the More icon (the one with
three dots), and then select the Power on or Power off option.

Power on all devices: if this checkbox at the top right is selected, TaskForce automatically powers on all plugged drives after the sliding panel appears.

You can also power a device on and off from a device page, by clicking the respective button at the bottom of the page.

When a device is idle for 5 minutes, TaskForce automatically powers it off. This is the setting that you can disable.

However, we recommend powering off a device before disconnecting it from TaskForce.

Atola TaskForce: Main window

This article helps in understanding TaskForce’s main window, its controls and buttons and how to use them.
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An overall view of the TaskForce 2 main window: 1 - Home icon, 2 - Taskbar, 3 - Cases button, 4 - Reports button, 5 - Current overall
performance, 6 - Devices button, 7 - Menu.

1. Home icon
The Home button brings you back to the Home screen. This is where you can check the active and recently completed tasks in the respective sections of the
screen.

The number of current active processes is indicated next to the Home icon in a small orange circle.

2. Taskbar
The Taskbar on the left shows main TaskForce operations:

1. Diagnose
2. Image
3. Logical
4. RAID
5. Wipe

Click the Other button in the Taskbar to access 4 more important TaskForce operations:

1. Hash: Calculates hash of a device: MD5, SHA-1, SHA-256, SHA-512.
2. View SMART: Shows all SMART attributes as a table.
3. Browse files: Shows the content of partitions on a device.
4. Hidden drive areas: Lets you to unclip or change HPA, DCO, AMA limitations.
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Section with other tasks: Hash, View SMART, Browse files, Hidden drive areas.

3. Cases
By clicking the Cases button in the top panel you get to the Cases page with a list of the latest cases. With the help of the Search bar you can find a specific case.
The cases are available for import and export between different TaskForce units.
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An overall view of the Cases page with a list of the latest cases.

4. Reports
By clicking the Reports button in the top panel you get to the Reports page that is equipped with a similar search bar. The reports can be selected and printed
directly from this page.
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The Reports page with a list of the latest reports.

5. Current overall performance
To check the Current overall performance, click Atola logo in the top panel. This lets you to keep track of the unit’s capacity usage. TaskForce allows running
processes at 25 TB/hour and more.
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Current overall performance shows after you click Atola logo.

6. Devices
Click Devices button in the top panel to see all the drives connected to TaskForce to obtain maximum information about each by simply clicking it.

The Devices panel provides additional options for working with the drives: add a case for a device, re-identify or power off any device.
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The Devices panel is expanded and shows all the drives connected to TaskForce.

7. Menu
The Menu contains device settings and features that regulate your use of the TaskForce unit.
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The Menu gives access to Atola TaskForce settings, express mode, full screen mode, release notes, and manual.

In Settings you can adjust the general, database, network, print, and other settings.

Express mode enables automatic launch of multiple imaging sessions on all ports that are set to source. For more details, see Express mode: self-launching
imaging.

Toggle fullscreen option is handy when working with other programs or files.

In Update firmware you can check the current TaskForce firmware, choose update method and perform the firmware update by selecting and downloading the
firmware file.

Activation status lets you to look up, reactivate the status, or extend the subscription.

In Release notes you can read the information about the most recent Atola TaskForce firmware release and track all updates and enhancements by clicking
corresponding links.

ATA registers: what they mean

Link Register
It's only enabled when port powered on, device presence detected and PHY communication established.
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Status Register
This register contains hard drive status information. It is updated after every single command sent to the drive.

ERR: means last command failed to execute. In this case the Error register contains more details on the specific error.
INDX: obsolete, used to trigger after each spindle revolution
CORR: obsolete, used to trigger after a bad sector was automatically corrected by ECC
DREQ (Data Request): is asserted when hard drive wants to exchange data with the host controller (in either direction)
DRSC (Device Seek Complete): is obsolete; always asserted on modern hard drives
FAULT (Write Fault): is obsolete
DRDY (Device Ready): is obsolete; always asserted on modern hard drives
BUSY: indicates that the hard drive is busy executing a command OR initializing (after power on or reset)

Error Register
Error register provides more details if the last command failed. This register is only valid when ERR bit of the Status Register is asserted.

AMNF: means Address Mark Not Found (usually occurs on failed read attempt)
T0NF (Track 0 Not Found): obsolete
ABRT: command aborted (unsupported command or other failure)
IDNF: sector ID not found (usually occurs on failed read attempt)
UNC: uncorrectable read error; the hard drive was unable to read data even after applying ECC recovery algorithms
ICRC (Interface CRC error): there was CRC error while transferring data between host and the hard drive (usually indicates bad interface cable)

Diagnosing a drive with Atola TaskForce 2

When an evidence drive lands on investigator’s table for the first time, there is always an uncertainty when it comes to the drive's condition. A broken head or
scratched surface of the media require different imaging tactics. That’s why it is strongly suggested that before imaging, each drive should first be diagnosed.

TaskForce 2 has Atola's unique diagnostics module which checks all systems of the drive:

Hard drive's motor and electronics (PCB)
Head stack
Media surface
All firmware/system areas
Partitions and file systems

At the end the system produces a report which sums up all issues. The process will take only 2-5 minutes.

To start, go to Diagnose, select the drive and then click START.



Start diagnostics.

First, TaskForce 2 checks the drive's printed circuit board. The system applies power to the device and records and analyzes spin-up current curve. This helps detect
most issues with the PCB and the motor. Next, TaskForce 2 analyzes the contents of the hard drive's ATA registers and device identification sector.
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Circuit board check.

After that, the head stack is tested. Several factors are taken into consideration when diagnosing heads: media access time for each head, power consumption
curves, and internal drive's error reporting systems.

If the head stack looks good, the system performs a short media scan. The purpose of this scan is to verify if there are any bad sectors in the starting, middle and
ending sectors of the drive pointing to a damage to the media surface or logical errors.

https://atola.com/img/tf/manual/diagnose-2.jpg
https://atola.com/img/tf/manual/diagnose-2.jpg


Heads and media surface check.

Next, several firmware tests are performed:
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Firmware check.

If TaskForce detected no issues by this point, it performs a file system checkup:
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File system check.

After this final stage of diagnostics, TaskForce 2 displays the full report. The Diagnostics result message box contains a short summary of all tests. It also provides
estimated imaging time for this drive.
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Diagnostics report.

Tracking a drive's SMART table status before and after imaging

SMART table is a valuable source of information about a hard drive’s health. SMART (Self-Monitoring, Analysis and Reporting Technology) provides stats of a drive’s
operation, thus helping predict its future failure.

Making a definitive conclusion based on the indices in SMART table is not easy: not all parameters are critical, it is usually a combination of bad values of a few
parameters that point to a trouble, time factor plays a role too (how fast has the state of the drive been deteriorating).
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View SMART table
SMART table is included in the Diagnostics report. If you want to have a look at the current indices:

1. Go to Other > View SMART.

2. Select the drive.

3. Click Start.

SMART table report.

SMART table attributes may differ depending on the drive manufacturer. The most critical attributes are:

Reallocated sectors count.
Current pending sector count.
Uncorrectable sector count.

When RAW value of any of these attributes is greater than zero, TaskForce highlights it in yellow.

The worse the values, especially in these critical attributes, the more carefully the drive needs to be treated.

Track changes of the SMART table attributes
To keep track of the changes occurring to the attributes of the SMART table, the imaging settings can be easily adjusted to records SMART table indices prior and
after each imaging session.
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Adjust the imaging settings to keep the record of SMART prior and after the imaging session.

By comparing the two tables, user can evaluate whether the health of a drive has been deteriorating throughout the imaging session and thus assess how quickly
its health has been getting worse. Any discrepancies between the two SMART tables will be highlighted in yellow.
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How SMART table state changed after image acquisition

Whenever you need to evaluate how the state of the drive has been changing long-term, go to previous imaging sessions and look up SMART table. TaskForce
stores this information in its case management system.

Imaging an evidence drive to 5 targets

Atola TaskForce allows imaging to up to 5 targets at a time.

The targets may include:

E01, AFF4, RAW file on a network server.
target drive plugged into one of 26 TaskForce ports.

To start an imaging session that includes 5 targets:

1. Go to Image.

2. Select a source device.

3. On the Select target devices panel:

a. Switch to the Drives tab and select your target drives.

Selecting target devices.
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b. Switch to the Files tab and click Create File.

Creating target image file.

4. In the Select image file window, open the folder on the server where you want the file to be created and click Create file.

5. In the Create image file dialog, enter a name for the file, select its type (E01, aff4, dd, img, or raw), and then click Create.
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Entering the name of the file.

6. On Select target devices panel, click Continue.

7. On the imaging settings page, double-check all settings and the targets selected for the imaging session, and then click Start.
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The imaging settings page.

In the imaging page, there are two diagrams that show the progress of imaging. The upper one is called imaging map bar and shows imaging progress throughout
the whole drive space (all successfully imaged sectors on the source drive are marked green, all damaged ones are marked red). The lower diagram is called read
speed graph and shows the time TaskForce spent reading sectors on the source drive.

Overall imaging speed is always limited by the slowest device: either by the read speed of the source or the write speed of the slowest target.
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Imaging in progress.

When imaging is completed, you are redirected to the imaging summary page, where you can review the details of the session including source and target drive
details, imaging settings, hash values and the time when imaging session started and when it was completed.
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The Imaging completed report.

Imaging a drive to two targets with post-hashing

Atola TaskForce's imaging functionality provides many adjustable settings to help forensic examiners follow the guidelines set by their organizations as well as
common-sense evidence handling routines.

When you need to create two images of a source drive and verify that both images are identical to the source drive, you will need to calculate the hashes of both
targets after imaging. To optimize the process, post-hashing of both target devices is easily configured in imaging settings.

Here's how to do it:

1. Go to Image.

2. Select Source and Target devices.

3. TaskForce 2 redirects you to the page with the summary of current imaging settings. By default, hashing of source drive during imaging is enabled.

4. To adjust the imaging settings, click Change.
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Changing default imaging settings.

5. In the imaging settings, open the Hashes tab and toggle Post-hash target devices.

6. To proceed with imaging, click Start.
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Enabling post-hashing of targets.

Hashing of source drive during imaging is a preferred option because it only requires the data on the evidence drive to be read once, for both imaging and hash
calculation. This ensures both a forensically sound process and minimal impact to potentially unstable media. Hashing during imaging does not slow down imaging
process.
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Imaging progress.

Once imaging is completed, post-hashing begins immediately on both target devices:
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Post-hashing in progress.

In the end, TaskForce 2 produces a report that documents hashes of both source and target devices:
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Imaging report with source and target hashes.

Imaging to an E01 file with dual hash

E01 file format is the de facto standard format for forensic examiners to store images due to its ability to store not only a copy of the evidence drive, but also case
and evidence details. E01 file can also store both MD5 and SHA1 hash values calculated during imaging.

To image a source evidence drive to an E01 file, you have to create a new target file.

Creating a new E01 file
1. Go to Image.

2. Select the source evidence drive.
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3. On the Select target devices panel, switch to the Files tab and click Create file.

4. In the file selector, find the folder to store the image and click Create file.

5. In the Create image file dialog, select the E01 file type.

6. Fill in E01 file information, and then click Create.

7. On the Select target devices panel, click Continue.

Creating an E01 file.

Enable dual-hash and start imaging
1. Once you have selected the source drive and created the target file, you end up on the Settings summary page. To adjust the imaging settings, click

Change.

2. On the Hashes tab, make sure that Hash source during imaging is selected, also select both MD5 and SHA1 hash types.

3. To proceed with imaging, click Start.
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Adjusting imaging settings.

The report and the E01 file
Upon completion of imaging, you can see both MD5 and SHA1 hash values indicated in the Imaging completed report.
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Imaging report.

It is also possible to look up the information of the created E01 file. To do that, perform the following actions:

1. Click Devices at the top right.

2. Expand the File section and click Select file.

3. Choose your file. TaskForce 2 opens the file information page with all the metadata of the E01 file. The MD5 and SHA hash values are listed there, too.
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E01 file with calculated MD5 and SHA1 hashes.

Imaging to a compressed E01 file on a target drive

In TaskForce 2, you can image source drives to target files on a storage device connected directly to one of the imager’s drive ports. E01, AFF4, and RAW file
formats are supported. E01 and AFF4 files can be compressed.

To create multiple target images on a directly connected drive, first, you need to set this device to the Storage mode.

If a drive is already in the Storage mode, plug it into one of the TaskForce drive ports and use it to store target image files without additional formatting. You can
image several evidence devices to target files on storage simultaneously.

The drive in the Storage mode is marked with a special blue icon on the Select target devices panel. A LED status indicator of the respective drive port on the
TaskForce 2 front panel also turns blue.

Set a device to the Storage mode
To set a target device to the Storage mode:

1. Go to Image.

2. Select the source evidence drive.

3. On the Select target devices panel, switch to the Files tab and click Create file.
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Selecting a target file.

4. In the Select image file window, click Add storage.
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Adding a storage drive.

5. On the Select device panel, choose the drive you want to use in the Storage mode. TaskForce 2 uses a lighter shade of blue to indicate that a storage drive is
being configured.
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Selecting a storage drive.

6. If TaskForce 2 cannot find the appropriate exFAT partition on the selected drive, it offers you to format the device accordingly. In that case, select Format
device to exFAT and click Next.
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Formatting the target to exFAT.

7. To launch target device formatting to exFat with a large cluster size (32 MB), click Format and enter YES for confirmation. This cluster size enables faster
imaging to this drive.
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Formatting the target to exFAT.

Once the target device is formatted, TaskForce 2 perceives it as a Storage target and you can proceed to create a compressed E01 image file on the storage device.

The drive in the Storage mode is marked with a special blue icon on the Select target devices panel. A LED status indicator of the respecting drive port on the
TaskForce 2 front panel also turns blue.
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A drive in the Storage mode.

Image to a Storage drive
If you already have a drive configured as a Storage, you can plug it into one of the TaskForce drive ports and use it to store target image files without additional
formatting:
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1. Go to Image.

2. Select the source evidence drive.

3. On the Select target devices panel, switch to the Files tab and click Create file.

Selecting a target file.

4. On the bottom left in the Select image file window, select your Storage drive. Then proceed to create a target image file.
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Selecting a target file.

Create a compressed E01 image file
To proceed with creating a compressed E01 image file on the storage device, do the following:

1. In the Select image file window, select the storage drive and then click + Create file.
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Adding a new file.

2. In the Create image file dialog, enter the file name and select the E01 file type.
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Creating an image file.

3. Select the Compress E01 option.

4. Fill out other file details, and then click Create.
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Configuring the compressed E01 file.

5. Check your imaging settings and click Start to proceed with imaging.

When you select the Compress E01 option in the imaging settings, the multipass imaging system or reverse imaging option cannot be applied to such an
imaging session. However, other fine-tuning options remain available including advanced hashing options (pre-hash, post-hash, segmented hashing, etc.)
and selective imaging.
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The imaging settings screen.

Image several devices to a Storage drive in parallel
You can run multiple imaging sessions to E01/AFF4/RAW files on a Storage drive simultaneously.

To do that, follow the steps described in the Image to a Storage drive section and then Create a compressed E01 image file for each evidence device.

Imaging completed report
The Imaging completed report provides all the time stamps, hash values, and hash verification result. To look up the settings of the imaging session, you can also
see the Imaging started report in the case management system.
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The Imaging completed report.

Imaging to an AFF4 file

Atola TaskForce 2 supports performing an image acquisition of an evidence device to an AFF4 forensic file.

AFF4 is a highly optimized open-source forensic file format used for the storage of digital evidence and data. It offers a wide range of benefits:

Is an open-source format: you can describe it in a court.
Supports multipass imaging.
Offers fast compression methods: Snappy and LZ4.
Supports block hashes.
Stores binary zeroes as spans similar to sparse files.
Is vendor-neutral.
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AFF4’s block hashes are calculated for small segments of data on the drive and are stored in a table inside AFF4 metadata. There is a Block map hash that
represents a single SHA-512 hash value for all the individual block hashes based on Merkle tree model. This is great for imaging of damaged drives to a file using
TaskForce’s multipass imaging algorithms.

Create an AFF4 file as an imaging target
1. In the TaskForce main window, click Image.

2. Select a source device.

3. Optional: On the Imaging sessions page, click Start new.

4. On the Select target devices panel, switch to the Files tab and click Create file.

Creating a file as an imaging target.

5. Choose a folder for your file. You can save a file:
on a computer or server in your local network or
on a storage device connected to your TaskForce.

6. After selecting a folder, click Create file.

7. In the Create image file dialog, change file Type to AFF4.

8. Define hashing type and compression algorithm for your target AFF4 file:
Block hashes: choose from MD5, SHA1, MD5 + SHA1, SHA256, or SHA512
Compression: choose from LZ4, Snappy, or Not compressed.

9. Enter other case details and then click Create.
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The settings for AFF4 target image file.

10. Click Continue.

11. Check imaging settings, change them if needed, and then click Start.

TaskForce 2 starts imaging your evidence device to an AFF4 target file. After imaging is finished, the system shows an Imaging completed report.
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The Imaging completed report with an AFF4 file as a target.

Image a remote drive using the iSCSI protocol

Some devices can’t be plugged directly into the TaskForce hardware unit for imaging. These could be drives soldered into a motherboard, servers that can't be
turned off, or devices you have legal access to but lack the right to seize.

To image such devices remotely with TaskForce, use the iSCSI network protocol.

To set up an iSCSI target correctly and expose a physical or logical drive via iSCSI on a network, you can utilize a Python script provided by Atola that automatically
creates iSCSI targets for all drives except for a boot device.

Automatically create iSCSI targets
To expose a physical or logical drive via iSCSI on a network, you need first set up the iSCSI target correctly. To help you with that, Atola engineers created a Python
script named iscsi-targets, which automatically creates iSCSI targets for all drives except the boot device.

Download iscsi-targets from GitHub →

Features of the ‘iscsi-targets’ script

Automatically creates iSCSI targets for all drives except the boot device.

Ensures that the iSCSI Qualified Name (IQN) of every iSCSI target includes the drive model and serial number. When you add such an iSCSI target in Atola
imagers as a source drive, the imager’s software automatically extracts the model and serial number from the IQN into the case details.

Lets you specify a block device as a script argument to create an iSCSI target only for that device.
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What you need to run the ‘iscsi-targets’ script

The script runs on Linux only. It was tested on various distributions such as Ubuntu, Fedora, CentOS, and RHEL, including DFIR boot environments like Paladin,
Caine, and Tsurugi.

1. Python 3.6 or higher must be installed.

2. On the first run, the script automatically checks for and installs two required dependencies:
targetcli
python3-rtslib

How to use the ‘iscsi-targets’ script

Here are some examples of using the ‘iscsi-targets’ script.

1. Create iSCSI targets for all drives except the boot device:
`sudo python3 iscsi-targets.py`

2. Create a single iSCSI target for the specified /dev/sdb1 partition:
`sudo python3 iscsi-targets.py /dev/sdb1`

The example below shows the first run of iscsi-targets.py on Paladin. It has added 3 iSCSI targets for SATA and USB drives.

Automated iSCSI target creation in Paladin.

Image remote drives in parallel using iSCSI
To image a remote drive in TaskForce using the iSCSI protocol, follow these steps:

1. Expose a physical or logical drive via iSCSI on a network.

2. In the TaskForce window, click Image.

3. Scroll down to the Remote section and click Connect iSCSI target.

4. Enter Target IP or DNS and Target port. If needed, also enter a username and password for remote authentication.

5. Click Discover.
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Discovering the iSCSI target.

6. TaskForce searches for and lists all iSCSI devices available at the IP address and port you provided. Select your iSCSI target, enter a username and password
if required and click Login.

https://atola.com/img/tf2/manual/iscsi-discover-target.png
https://atola.com/img/tf2/manual/iscsi-discover-target.png


Selecting the iSCSI target.

7. Optional: Select the LUN if multiple devices are exposed.

8. Enter or correct the device model and serial number.

9. Click Connect.

10. TaskForce opens the selected iSCSI device as a source. You can now image this device as usual.

Templates for target image files

If you image evidence devices to target files on a network server or storage drive, you can benefit from highly customizable and flexible target file templates.

Thanks to configurable variables, such as the current date, case ID, device serial number, and more, a template lets you create complex subfolder paths and file
names with a couple of clicks, according to your internal naming conventions.

Additionally, you can set up other target parameters, such as file type, compression, hashing method, and autofill repeating case details, such as case number,
investigator name, or location.

Once created, a template for a target image file can be applied with a single click.

You can use templates when performing physical or logical imaging, as well as in Express mode.

Create template
To configure a template for target image files, do the following:

1. On the Taskbar, click Image and select your Source device.

2. On the Select target devices panel, switch to the Files tab and in the Templates section click Add Template.
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Adding a template from the 'Select target device' panel.

3. The Add template dialog opens.
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The 'Add template' dialog.

4. To edit the template's name, click the Pencil icon next to it.

5. Specify a Target folder by clicking Select folder and choosing the desired location.

6. Set up a Subfolder path and Name template for your target files using constants (such as department name) and available variables:

a. Year: YY (two-digit format) or YYYY (four-digit format).

b. Month: MM (two-digit format).

c. Day: DD (two-digit format).

d. Current time: hh-mm (24-hour format).

e. Case ID: CASE_ID (as specified in the TaskForce case system).

f. Evidence ID: EVIDENCE_ID.

g. Drive model: MODEL (acquired automatically by TaskForce during identification).

h. Drive serial number: SERIAL (acquired automatically by TaskForce during identification).

i. Ordinal number variable: {NUM+} (increments from the number you specify in curly brackets if the file or folder with the same name already exists).

Variables are highlighted with pale green for better visibility.

To create nested folders in the specified Target folder, use the forward slash symbol (/) in the Subfolder path field.

7. Select the target file Type: E01, AFF4, IMG, DD, or RAW.
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Selecting target file type for a template.

8. Optional: Configure additional parameters of a target file:

For E01 files: Segment size and Compression.

For AFF4 files: method for Block hashes (MD5, SHA1, MD5 + SHA1, SHA256, SHA512) and Compression algorithm (LZ4 or Snappy).

9. Choose how to fill in file metadata: automatically (default) or manually.

If you choose Automatically, specify the values for Case ID, Investigator’s name, Evidence number, Description, or Notes.
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Option to fill in file metadata automatically.

If you choose Manually, TaskForce will ask you to enter file metadata whenever you create a target file using the template.
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The 'Set file metadata' dialog.

10. When all the parameters of the template are set, click Create.

Use template
To create a target image file using an existing template, after selecting a Source device, simply click your template on the Select target devices panel.

After that, TaskForce creates the required subfolder(s) and adds a file with the specified parameters as an imaging target.

The target file appears on the Files tab of the Select target devices panel.

Then you can proceed to the Imaging settings screen by clicking Continue.
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A template for target image files on the 'Select target device' panel.

Edit or delete template
To edit or delete a template for target image files, use the three-dots icon next to the template’s name on the Select target devices panel.
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Editing or deleting a template for target image files.

Accessing password-protected servers

Accessing password-protected servers allows saving image files on such servers, imaging or calculating hash of the files located there, etc.

To create an image file on a password-protected server:

1. In the TaskForce main window, click Image.

2. Select a source device.

3. Optional: On the Imaging sessions page, click Start new.

4. On the Select target devices panel, switch to the Files tab and click Create file.

5. In the Select image file window, choose the server from the list. If the server does not appear in the list, click Refresh icon to search for all available
directories. If the server still does not appear in the list, click Connect.
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Selecting a server from the list.

6. The Connect to server dialog opens. Enter the name of the server and fill out login details, including domain or workgroup, and then click Connect. To learn
these details, contact your network administrator.

TaskForce supports NTLM protocol, which is enabled by default in Active Directory and Windows.
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Entering server and login details.

7. Go to the folder on the server where you need to store your image and click the Plus icon in the right bottom corner of the window.
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Creating a new file in the directory.

8. Enter the name of the new image file and select the format. Click Create.
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Entering the name and selecting the format of the new image file.

9. On the Select target devices panel, click Continue.
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The Continue button on the Select target devices panel.

10. Check your imaging settings and click Start to proceed with imaging.
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The Start button on the Imaging settings page.

Imaging to a file on an encrypted drive with TaskForce 2

With Atola TaskForce 2 it is possible to image into files on an encrypted target drive using VeraCrypt for data encryption. Multiple target drives can be encrypted for
the same or different sessions.

Create encrypted storage
To image into files on an encrypted target drive, connect the source drive to a port in the Source mode and take these steps:

1. In the TaskForce main window, click Image.

2. Select a source device.

3. Optional: On the Imaging sessions page, click Start new.

4. On the Select target devices panel, switch to the Files tab and click Create file.

5. In the Select image file window, click Add storage.
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6. On the Select device panel, switch to the Drives tab and choose the drive connected to a port in the Target mode.

7. Select Create an encrypted VeraCrypt container (exFAT) and click Next.
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8. Enter and confirm the password for the encrypted volume on the drive. Then click Create.
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9. Confirm the formatting of the device by entering YES and clicking OK. After this step, the formatting takes a few seconds.

10. Click + Create file.

11. Enter the name of the image file and choose the file format (E01, raw, img or dd). Then click Create.
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12. Once you have created the file, you may add more image files in the same or a different folder.
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After you click Continue, TaskForce 2 images the evidence into the file on your encrypted target.

Upon completion of the imaging session, check the Imaging completed report.
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Extract data from an encrypted volume
To find the VeraCrypt volume and the imaged file, do the following:

1. Plug the target drive into your computer.

2. Use VeraCrypt software to safely access encrypted data from your drive.

3. Select the drive label (A, B, C, etc.) on which you want the volume to be mounted.

4. Click Select device.

5. In the pop-up window, select your encrypted volume.

6. Click Mount. Now you can view the partition name, size and encryption algorithm.

7. Use the password set prior to the imaging session to get access to the encrypted volume.
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After you enter the password, the volume is mounted and you can access it from Windows Explorer and use the image for subsequent operations.
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Restore E01, AFF4, RAW image file to drive

To restore data from an image file to a drive using Atola TaskForce 2, follow these steps:

1. In the TaskForce main window, click Image.
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2. On the Select source device panel, expand the File section and then click Select file.
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3. Select the E01, AFF4 or RAW file you are planning to restore.

4. Select the target drive and click Continue.
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If your target drive is larger than the size of the image, the hash values of the target drive will not be identical to that of the image file. With
TaskForce 2, you can limit a SATA target drive's capacity via Host Protected Area (HPA) or Accessible Max Address (AMA). Applying the HPA or AMA
will set a new max address in the drive’s firmware, which will make the sectors beyond the required capacity inaccessible. This will make the hashing
process straightforward and the hashes will match.

To limit SATA target drive's capacity via HPA or AMA, go to the imaging Settings and click the Change button.

https://atola.com/img/tf2/manual/restore-imagefile-todevice-04.png
https://atola.com/img/tf2/manual/restore-imagefile-todevice-04.png
https://atola.com/products/taskforce/manual/clip-target-drive.html


Go to the Miscellaneous tab and enable the Limit target disk size to source size using HPA/AMA option.
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5. Click Start for the imaging to begin.

TaskForce 2 automatically creates detailed reports for every session. The imaging report lists all the details of the source, the target, the imaging settings and
timestamps including the setting of the new max address of the target drive. This makes such data extraction from a file transparent and forensically sound.
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Clip target drive to source evidence size

When you image data from an evidence drive, but the target drive is larger than that of the source, the hash values for the source and for the target drives will not
be identical. This will happen even if there is no data in the remaining space of the target.

To avoid it, you can limit your SATA target drive's capacity using Host Protected Area (HPA) or Accessible Max Address (AMA). It will make the sectors beyond this
limit inaccessible to the hashing tools or the end user. In TaskForce, it only takes one quick adjustment to the imaging settings:

1. In the TaskForce main window, click Image.
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2. Select a source and target device.

3. On the Imaging sessions page, click Start new.

4. On the Settings page, click Change.

5. On the Miscellaneous tab, toggle the Limit target disk size to source size using HPA/AMA (SATA target ports only) option.

Enabling HPA/AMA restriction for target.

You can now proceed with the imaging process by clicking the Start button.

Before the imaging starts, TaskForce 2 looks up the size of the evidence drive and limits the space of the target using HPA/AMA to make its capacity identical to
that of the evidence drive.

When imaging is complete, the report will contain information about the time when HPA/AMA was enabled.
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The Imaging report indicates the change to the target drive capacity.

The target disk's port in Devices menu now contains an HPA/AMA indicator, thus informing you that HPA/AMA has been enabled on this drive.
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The HPA indicator in the port of the Device menu.

There will also be a report created in the case management system, which indicates the old (native) and the new (as set by HPA/AMA) max address.
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The report about HPA activation.

Now you can calculate hash on both drives to make sure the hash values are identical.

Enabling HPA/AMA is an option available only for SATA target drives.

To learn how to unclip HPA/AMA, read Unclip or change HPA, DCO, AMA limitations in our manual.

Exporting sector lists from an imaging session

When an imaging session is completed or paused, it is possible to see its summary in the Imaging sessions summary page. Now there is also a possibility to export
lists which would clearly indicate which of the sectors on the source drive have been successfully imaged, which have not (if any), and which of the sectors
contained errors.

To export such list:

1. Go to Image and select the source drive.

2. In the session summary, click the Export icon.
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The Export icon in the session summary.

3. Select the sectors you are interested in (for example, Imaged sectors).
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Selecting the type of sectors.

4. Save the downloaded .csv file. This file shows the ranges of imaged sectors:
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Should an imaging session be completed, the list of non-imaged sectors will be blank.

Imaging presets

For examiners who need to ensure they are using specific imaging settings for certain types of drives or cases, TaskForce 2 allows creating different presets for easy,
one-click switching to a specific imaging routine. Presets also allow these specific imaging settings to be shared with colleagues who use another TaskForce 2 by
exporting presets from one device and importing them onto another one.

TaskForce 2 has two presets called Default and Damaged recommended for healthy and faulty drives respectively.
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Default presets.

Manage custom presets
To create a custom preset:

1. Go to Image and select source and target devices.

2. On the Imaging settings page, click Change.

3. Change the imaging settings.

4. Click the three-dot icon in the bottom right corner and choose Save to.

5. In the dialog window, enter the name of the preset and click Save.
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Saving a preset.

Once you have saved a preset, they are stored in TaskForce's work folder and can be used by other operators using the same imager. They can find the presets you
created under the Custom button.

The Chrome browser of the user who created a preset, saves a copy of the preset locally. When this user opens the Custom menu, both presets are displayed:

one is the preset saved in TaskForce's work folder,
another one is the local copy.

If one becomes redundant, it can be easily deleted.
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All custom presets.

To delete a preset:

1. Select the preset in the Custom menu.

2. Go to the three-dot menu in the bottom-right corner and click Delete.

Share presets with another TaskForce
Once you have created your custom presets, you can share them with colleagues who use another TaskForce imager.

To export a preset:

1. Select the preset from the Custom menu.

2. Click the three-dot icon.

3. Click Export.

The preset will be downloaded in .json format.

https://atola.com/img/tf/manual/presets-custom.jpg
https://atola.com/img/tf/manual/presets-custom.jpg


Exporting a preset.

To import a preset:

1. Click the three-dot icon.

2. Click Import.

3. In the Import settings window, click Select file.

4. Find the file in the file selector and click Open.

5. Double-check the preset and click Import.
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Importing a preset.

After this import, the preset can be found in the Custom menu.

Imaging a drive with a damaged head

The diagnostics module, selective head imaging and multipass imaging algorithm allow Atola TaskForce 2 to handle a drive with damaged heads gently and
effectively. All these techniques help minimize the risk of losing more data on the working part of the head stack.

Diagnose first
The built-in diagnostics module of TaskForce 2 automatically checks all major subsystems of the evidence drive: circuit board, heads, media surface, firmware and
file system.

A diagnostics report provides detailed information about the heads. In addition, it offers recommendations for the optimal imaging strategy for your damaged hard
drive.

The above diagnostics report informs the operator that the drive’s hardware has major issues and points to defects in the media and a damaged head (Head#3).
The report contains a recommendation to disable the damaged head in the imaging settings.

Diagnostics completed
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Selective head imaging
Atola engineers recommend that the good heads are imaged first. To do that:

1. Go to Image.

2. Select your source and target devices.

3. Click Continue.

4. If a head was identified as damaged during the diagnostics, at this stage TaskForce 2 shows a dialog prompting you to disable the damaged head. To
confirm that the head should be automatically disabled for the subsequent imaging session, click YES.

Alternatively, the damaged head can be disabled in the imaging settings:

1. On the Imaging settings page, click Change to adjust the settings for your imaging session.

2. In What to image section, click on All sectors to configure the selective imaging.
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3. Unselect the damaged head and сlick Save.

4. To launch your imaging session, click Start.
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Multipass imaging algorithm
As you can see in the screenshot below, some errors were found in the course of imaging on the space of the drive that is read with the Head#4. It is common for a
drive with a bad head to also contain errors on the platters that are read with other heads.
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TaskForce 2 uses its multipass imaging algorithm when encountering a bad sector that belongs to a good head. It allows handling errors and retrieving data from
some of the bad sectors. For as long as it is possible to read data from the sector or block of sectors within the specified pass timeout, TaskForce 2 will be able to
image this data.

Having completed imaging from the good heads, the system pauses the session and produces a detailed imaging report with a log of all actions performed during
the imaging session.

TaskForce 2 allows editing settings of all unstarted imaging passes, adding or removing passes, etc. So if later you think you may be able to retrieve important data
with Head#4, you can add another pass and configure the settings of the new pass accordingly.

TaskForce 2 automatically inserts and launches an additional imaging pass after you click Resume on the pause session. The new pass will include all non-imaged
sectors.
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TaskForce 2 automatically creates reports for every single action applied to each device connected to it. The reports are stored in the case management system.

Working with a bad head
After you successfully retrieved data from the good heads, you have two options:

To replace the head stack before you get down to imaging of the remaining data. You should be aware of the risk, however, that data on the drive can
become unreadable due to head stack replacement.

To attempt imaging data with the Degraded or Damaged head.

To image the unselected bad head, simply click Resume.
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TaskForce 2 resumes the imaging session to focus on the area that belongs to the damaged head.
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If the number of errors keeps growing, while the number of the imaged sectors remains unchanged, pause your imaging session and power down the drive
because the head seems to be completely inoperable.
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In the Imaging report above, you can see that TaskForce 2 imaged 520,961,167 sectors out of 625,142,448, having extracted as much data from good heads as was
possible with the default settings.

For more details scroll the report down to check the Log:
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Multipass imaging of damaged drives

Damaged media require a sophisticated imaging approach to balance out thorough data extraction with forensic units’ need for expediency and careful treatment
of damaged media.

Atola TaskForce has a complex imaging functionality that lets you image even physically damaged drives while avoiding causing further drive damage. You can use
a predefined setting for imaging a damaged drive, or fine-tune all imaging parameters yourself.

Diagnose first
Before imaging any evidence device, we strongly recommend diagnosing it.

To image an evidence drive without causing further damage to it, TaskForce is equipped with an automatic diagnostics module that evaluates the state of the drive,
identifies specific errors and their location, and recommends the best approach for data acquisition.

The detailed diagnostics report contains detailed recommendations on how to acquire data from this particular drive, based on its condition.

If Automatic Checkup detects a damaged or degraded head, disable the head in the imaging settings for the initial imaging session. For details, see Imaging
drives with damaged heads.
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The diagnostics report for a damaged device.

Preset for imaging damaged drives
If a device has issues or is damaged, TaskForce shows the respective tag next to it and suggests using the Damaged preset, designed specifically for imaging faulty
drives.

In this case, the Damaged preset is automatically selected on the Imaging settings screen.

The default preset for bad drives is based on our decades-long experience in the data recovery market to overcome most types of damage to the drives. That's why
we suggest that you use the Damaged preset for bad drives unless a particular drive requires a specific imaging approach.
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The Damaged preset is selected on the Imaging settings screen.

To thoroughly retrieve maximum data from an unstable drive in a forensically sound way, the preset for damaged hard drives has several major differences from
default imaging settings:

Number of passes: 5 passes for damaged drives instead of 1 pass for good drives.

Different timeouts for each pass: 1 second on the first pass, 5 seconds on the second, third, and fourth passes, and 60 seconds on the last fifth pass.

Jump on errors: from 1,000,000 sectors on the first pass to only 1 sector jump on the last pass.

Different read block sizes for each pass: 4,096 on the first, second, and third passes, 256 for the fourth and fifth passes.

Segmented hashing with 4 GB segments instead of linear hashing used by default for good drives.

If you use an E01 file as a target along with a linear hashing method, multiple passes aren’t available. In such a case, we recommend using an AFF4 or RAW
file format instead.
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The Damaged preset for imaging faulty drives.

Pass is a single complete cycle of reading blocks from a source device and writing them to a target device, beginning from a start sector and finishing at an
end sector (as specified in the What to image field).

Timeout is a max time for a single read block attempt during this pass.

Jump on errors is a number of consecutive sectors that TaskForce will skip if it can’t read a block from a source device.

Max read block size is a maximum number of sectors that TaskForce reads from a source device at a time.

Segmented hashing is a process of calculating hashes for a series of corresponding LBA ranges of the image. For more details, see Segmented hashing for
data verification.

Multipass algorithm for imaging damaged drives
To approach bad drives in the most gentle way possible, TaskForce uses its special multipass imaging system.

Most forensic imagers can only do linear imaging, which dramatically slows down the imaging process whenever a bad sector is encountered, and, as a result, the
drive may freeze. To speed up the imaging of damaged media and maximize the amount of successfully retrieved data, TaskForce has a special imaging algorithm
that includes a deliberate timeout and block size control.

Timeouts and block size control

Using a small block size pays off when you need to thoroughly retrieve maximum data from an unstable drive, but it also significantly slows down the imaging
process. What’s worse, such an imaging approach may cause further damage to the media.

That's why TaskForce's multipass imaging engine uses large blocks with short timeouts on the first few passes, scheduling reads inside slow areas for later and
then using the smallest block size on the last pass when very few sectors are left to be read. TaskForce handles block size automatically, to provide the best
possible results in the shortest time.
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This technique helps achieve imaging max speeds in good areas of the drive. At the same time, it lets you approach bad areas in the most delicate way possible and
retrieve as much data as possible.

First pass

On the first pass, TaskForce allows a 1-second Timeout per block, and the Max read block size is set to 4096 sectors. This allows smooth sequential imaging of all
healthy modern drives.

But when imaging damaged media, these settings let TaskForce skip any areas that slow down the process and perform Jump on error by 1,000,000 sectors at a
time.

This way all the good areas of the drive are imaged at top speed, while forcing TaskForce to return to the problematic areas on the following passes, narrowing
down the bad areas and allowing more time to retrieve the data within them.

Imaging the first pass. Empty areas where errors were encountered and jumps were performed.

Second and third passes

While the Max read block size remains the same during the second and the third passes, the Jump on error is set to 20,000 sectors and 4,096 sectors respectively,
and slightly longer, 5-second Timeouts are allowed for attempted reading of the blocks.
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Empty areas start filling up with data, as the jumps become smaller.

Fourth pass

On the fourth pass, both Jump on error and Max read block size are reduced to 256 sectors to try reading problematic zones in a more granular way.
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The amount of data retrieved is already 99%.

Fifth pass

On the fifth pass, TaskForce allocates 60-second Timeouts to read the Maximum block size of 256 with just 1-sector Jump on error. It is the last and the most
thorough attempt to retrieve data from the remaining bad areas of the drive.

The last pass has a unique feature that is not used during previous passes: an internal sector-by-sector auto-reread procedure for an error block. It is defined by an
unchangeable Jump size = 1 sector.

How the imaging engine works on the last pass:

It reads a block using the Max Block Size pass setting (256 by default).
If the reading is successful, it proceeds to the next non-imaged block.
If a read error occurs, the engine re-reads the whole error block sector by sector.
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On the fifth pass TaskForce attempts to read the data for the last time.

After the final pass, the Imaging Results report will indicate the eventual number of errors on the drive and other detailed statistics.
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The Imaging Results report shows the number of errors on the drive.

Customize imaging settings for each pass
To cope with a severely damaged drive, you can adjust the following parameters of any imaging pass:

Timeout
Jump on error
Max read block address
Start and end LBA
Image in reverse direction
Disable read look-ahead

Also, you can add or delete an imaging pass.

To customize settings for a certain imaging pass, do the following:

1. On the Imaging settings page, click Change.
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The Change button on the Imaging settings page.

2. Click the pass you want to change.
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An imaging pass is highlighted on the Imaging settings page.

3. In the Edit imaging pass window, enter new settings or toggle the options you need.

4. Click Save.
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The Edit imaging pass window shows the current settings for the first pass.

Start and End LBA

For each pass, you can define the starting and ending sectors by entering logical block addresses in the respective fields (Start LBA, End LBA) or by dragging
markers of the slider below.

Alternatively, you can select All sectors with data in the What to image field. It makes TaskForce search for all known partitions and image only the sectors that
contain data. This option is a good use when you are facing a lack of time to take a full image.

Currently supported partitions: NTFS, ext4/3/2, exFAT, XFS, ZFS, Btrfs, APFS (with encrypted volumes), HFS/HFS+, FAT32/16.
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Image in reverse direction

With this function selected, TaskForce approaches skipped areas of the drive from the other side on any selected pass. That means the imaging engine reads a
source drive backward and reaches the damaged areas from the opposite direction.

This way, the imaging module can retrieve more data from a drive before entering a damaged zone, which needs to be concentrated on during the following
passes. But the speed decreases due to auto disabling of the drive's cache.

Hint: It is one of the best options we recommend you enable to get more data from a severely damaged drive.
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Disable the read look-ahead mode

Most contemporary hard drives have a read look-ahead functionality, which makes the drive read more blocks sequentially than requested by software.

In good drives, this functionality helps the drive operate faster by reading more data and caching it.

But with bad drives, the read look-ahead feature leads to bad areas being addressed more often. This slows down the process and may lead to a complete freeze of
the drive. In such cases, we recommend disabling the read look-ahead option.
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Add a pass

You can add new passes even when an imaging session is not yet started or when it’s paused.

To add a new pass to an imaging session, do the following:

1. On the Imaging settings page, click Change.

2. Click Add pass.
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Adding a pass.

3. Adjust the settings for the new pass.

4. Click Save.

Delete a pass

You can delete any pass that has not been started yet. To delete an imaging pass, do the following:

1. On the Imaging settings page, click Change.
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The Change button on the Imaging settings page.

2. Click the pass you want to delete.
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An imaging pass is highlighted on the Imaging settings page.

3. In the Edit imaging pass window, click the Delete icon and confirm the deletion.
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Imaging freezing drives

The core part of the imaging process is based on reading a source drive by sending multiple Read sectors commands and handling the drive's response at the low
native I/O level.

When a drive receives and runs a Read sectors command but is unable to read any data from that sector. So it goes into Retry mode, trying to get data from the
damaged area again and again.

After a certain number of tries, it gives up on a particular command and returns an error with timeout.

In TaskForce, you can detect a freezing drive during diagnostics or during imaging.

Freeze detection and handling during imaging
Imagine that the drive is unable to read data from the damaged sectors and goes into a long-lasting retry mode before it gives up on a particular sector and
returns an error.

If TaskForce simply waited for each Read sectors command to be completed:

it would take ages to get an image of a drive with numerous errors;
it could cause the drive to slip into complete freeze;
in the worst-case scenario, further damage could be caused to the data on the drive.

The Reset command

To avoid causing further damage to the data on the drive and long waiting periods, TaskForce issues a Reset command whenever a drive attempts to read a block
of sectors longer than allowed by the pre-configured timeout.

Reset is a device interface operation, using which TaskForce stops the previously sent Read sectors (or any other) command and then continues imaging from the
next planned block on the drive.
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If the device is still running the Read Sectors command, even after the first Reset attempt, TaskForce waits 3 seconds and performs the second Reset command. At
the moment of the second Reset, a new entry appears in the imaging Log reading

Device hangs while reading block X – Y.

Log entry: Device hangs while reading block X – Y.

Performing a power cycle

If 20 seconds after the second Reset command the drive still tries to read the bad block, TaskForce performs the Power cycle command by forcibly cutting power to
the drive for 5 seconds.

At this point, TaskForce adds two entries to the imaging Log:

Performing power cycle...   (when the power is cut off) and

Waiting for the device to become ready…   (when the power is switched back on).
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Log entry: Performing power cycle.

After a successful power cycle

In case the first Power cycle command is successful, and the drive become ready to accept the next command, there will be a final log entry for this problematic
block of sectors saying:

Cannot read block of data at X – Y (Timeout).

And then TaskForce continues imaging from the next planned block.

After an unsuccessful power cycle

If the first Power cycle command is ineffective, and the drive is still in Busy state and can’t run the next command, TaskForce makes the second Power cycle.

If the second Power cycle does not help either, imaging is terminated. It can be resumed afterward, and TaskForce will continue to image all remaining sectors.

Freeze detection during diagnostics
TaskForce diagnostics module automatically checks the status of each head (for HDDs) and the condition of the media surface by reading several hundreds of
thousands of sectors from the starting/outer, middle, and ending/inner part of the head or drive.

If a drive freezes, unable to read certain sectors, it may or may not be detected during diagnostics because not all sectors of the drive are being read at this stage.

If an HDD has a damaged head causing it to enter a busy state, a diagnostics report notifies you about that with the line

Device freezes when checking head N. Performing power cycle...
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Notification “Device freezes when checking head N” in the diagnostics report.

Also, the diagnostics report shows a table with a freeze count and the number of read errors for each HDD head:

A table with a freeze count for a drive with a damaged head.
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A table with a freeze count for a drive with good heads.

If the heads status is OK, but some freezes were detected during diagnostics, the result of the diagnostics show the following line:

According to this test, the device sometimes falls into complete freeze, which will require power cycling.

The Diagnostics results notifying that the device sometimes falls into complete freeze.

Imaging a shorted hard drive

Atola TaskForce has built-in short circuit protection and can detect shorted hard drives. In most cases, a drive has become shorted after experiencing overvoltage,
either due to a power supply failure or as a result of a user error. Here is what happens to a drive in these scenarios and how to fix this.

How drives become shorted
Most drives are equipped with two TVS diodes to protect the circuit from overvoltage. One diode is located on the 5V rail and another on the 12V rail.

If the drive experiences an overvoltage, the diodes convert the excess electrical power into heat energy and warm up, thus protecting the drive's circuit. Similarly, in
the case of reverse polarity, the diode warms up as it conducts the current in the opposite direction.

If the overvoltage or reverse polarity event is short and the dissipated energy is not too high, the diodes can recover and continue working. However, if the
dissipated energy is too high, the diodes will "sacrifice" themselves and get shorted.

https://atola.com/img/tf/manual/taskforce-diagnostics-freezing-head-03.png
https://atola.com/img/tf/manual/taskforce-diagnostics-freezing-head-03.png
https://atola.com/img/tf/manual/taskforce-diagnostics-results-freezing.png
https://atola.com/img/tf/manual/taskforce-diagnostics-results-freezing.png


When the drive is subsequently powered, the shorted diodes create a low resistance connection between two nodes, known as a short circuit. This is exactly what
happens to a drive when its TVS diodes are shorted.

Detect a shorted drive
When you connect a shorted drive to Atola TaskForce, the Home screen shows a short circuit alert to notify the operator about the detected issue.
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The Home screen with a short circuit alert.

On the Select device panel, TaskForce marks the port to which a shorted drive is connected with the Short circuit tag and icon.
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The Short circuit tag and icon on the Select device panel.

A drive with a shorted TVS diode cannot be identified, diagnosed, or imaged with TaskForce, until you replace or remove the diode.

Image a shorted drive
If you need to image a shorted drive but do not have new TVS diodes on hand to replace the shorted ones, you can image the drive using Atola TaskForce after
removing the diodes. This process is safe because Atola TaskForce has short circuit and overvoltage protection, which guards both the imager and the drives
connected to it against circuit failures.

To remove the diodes, heat the area of the drive where they are located with a hot fan (such as in a hot air soldering station) and then gently remove them with
tweezers.
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Once the diodes have been detached, you can plug the drive into Atola TaskForce and proceed with imaging data from it.

Express mode: self-launching imaging on 25 drive ports

Self-launching imaging mode is a perfect solution when it comes to processing large amounts of data under time pressure, while still allowing gentle treatment of
damaged media.

Express mode enables the automatic launch of multiple imaging sessions with predefined settings on all drive ports set to source, except the Extension port (25 in
total). Once an examiner plugs drives into TaskForce 2, imaging sessions start automatically. Drive images are saved as a RAW, E01, or AFF4 file in a specified folder
on the local server. Two 10Gb Ethernet ports of TaskForce 2 enable high data throughput.

Additionally, there is the option to group ports in Express mode and assign different imaging settings for each group. TaskForce 2 can be set to automatically
diagnose all source drives before imaging and proceed only if diagnostics show no issues.

In this article, you will learn how to:

Configure Express mode

Activate Express mode

Image drives in Express mode
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Deactivate Express mode

Configure Express mode
Before activating Express mode, you need to configure it first: specify the target folder, file image format, and other imaging details.

To open the Express mode settings page, click the Menu in the top right and select Express mode.

Choosing Express mode from the Menu.

TaskForce 2 can process 25 self-launching imaging sessions in Express mode on almost all of its ports, except for the Extension slot. The ports that can be used for
imaging in Express mode are:

4 NVMe M.2/U.2
8 SATA
8 SATA/SAS
4 USB
1 IDE

When activated, Express mode controls all source ports, leaving target ones available for other tasks. If a port is switched from target to source, it also becomes
available for imaging in Express mode.

By default, Express mode settings are applied to all drive ports set to source. However, you can combine any number of TaskForce ports into a custom group with
specific imaging parameters for Express mode. See Port groups for details.
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Express mode settings.

Port groups

In cases where different types of drives require different approaches to image acquisition, you can assign specific imaging settings for certain groups of drive ports
in Express mode.

For example, to balance image acquisition time, you can image new NVMe drives to your faster server and older/smaller SATA drives to slower storage. Or image
healthy drives to the “Good” network folder and faulty ones to the “Bad” network folder to treat them differently later.

In Express mode, for each custom group of drive ports, you can specify:

Network folder where to save an image file
Which image file format to use
Which type of hash to calculate
Whether to diagnose the source device before imaging
How to fill in case report fields: Case ID, Organization, Investigator

Add a new group of ports

By default, Express mode settings are applied to all drive ports set to source. Thus, the group tab on the Express mode settings page is named All ports. All the
ports included in the group are listed in the Ports section.

To add a new group of ports:

1. Next to the All ports group tab, click the Plus icon.
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The All ports group tab and the Plus icon.

2. In the dialog window, select ports for the new group.
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Selecting ports for the new group.

3. Click Select.

To avoid confusion and accidental mistakes, TaskForce excludes selected ports from any existing groups and adds them to the new one.
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Several port groups in the Express mode settings.

4. The group name changes to clearly show port types and numbers included in it, for example, “NVME 1-4” or “SATA 1-8 SAS 1-8”. Switch between port
groups by clicking the tab with the group name.

Now you can proceed with assigning different imaging settings in Express mode to different port groups.

Change a port group

To change the drive ports included in an existing port group:

1. On the Express mode settings page, switch to the port group you want to change by clicking on the tab with its name.

2. On the right, click Change.

3. In the dialog window, select the drive ports you want to include in the group or deselect the drive ports you want to exclude.

4. Click Select.

5. The group name changes to clearly show port types and numbers included in it.

Target folder

In Express mode, TaskForce 2 stores drive images on a local server.

To activate Express mode, you need to specify a target folder on a local network to store drive images:

1. On the Express mode settings page, find the Target folder section and click Select folder.

2. In the Select target folder window, go to the existing folder and click the Select folder button. To create a new folder, click the icon with three dots and
select Create folder.
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The 'Select target folder' window.

What image files to create: type, compression, hash, templates and more

To set up the parameters of a target image file, such as file type, compression method, segment size, and hash type, on the Express mode settings page, find the
What image file to create section and click Change.

Configuration dialog appears.

On the File tab of this dialog, configure the target image file.

On the Template tab, you can also create the templates for image file names.

Selected parameters apply to an active port group only. Here are the details about each parameter.

Image file type

In Express mode, drive images can be saved as RAW, E01, or AFF4 files.

To change the target image file type for a specific group of ports, select it from the Type list on the File tab.
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Selecting target image file type.

Compression

TaskForce 2 supports the default compression method for the E01 file format and LZ4 or Snappy compression methods for the AFF4 file format.

Choose the compression method from the respective list on the File tab. The Not compressed option is also available for both E01 and AFF4.

The RAW file format does not support compression.
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Selecting the compression method for a target image file.

Segment size

For the E01 file format, TaskForce 2 can split the target image into segments of predefined size. Each segment is stored in a specified folder as a separate file.

The Segment size list becomes available on the File tab when the E01 file type is selected. You can choose the segment size from the following options:

Single file
4.7 GB (DVD)
8.5 GB (DVD DL)
25 GB (Blu-ray)
50 GB (Ultra HD Blu-ray)
100 GB (Blu-ray XL 3L)
Custom (enter the segment size you want)
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Selecting the segment size for a target image file.

Hash type

For AFF4 file format, TaskForce 2 can calculate built-in block hashes during the imaging process in the Express mode.

To select the hash type you want to calculate, use the Block hash list on the File tab. The available hashing options for the AFF4 file format are:

MD5
SHA1
MD5+SHA1
SHA256
SHA512
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Selecting the hash type for a target image file.

Create template for image file names

To create a template for naming target subfolders and files according to your organization rules, find the What image file to create section, click Change, and
switch to the Template tab. For details, see Target file templates.
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Creating a template for a target image files names in Express mode.

Diagnose before imaging and Start imaging only if diagnostics has no issues

As essential as imaging speed is, the proper treatment of evidence drives remains a priority. That’s why we recommend that diagnostics is always performed as
soon as a drive is connected to TaskForce 2 for the first time.

To enable the automatic launch of imaging of the healthy devices and avoid potential deterioration of drives in a shaky condition, the Express mode settings have
two handy options:

select Diagnose source drive before imaging so that diagnostics start automatically,

then select Start imaging only if diagnostics has no issues.

When enabled in Express mode, Atola’s signature automated diagnostics module checks all drive systems:

hard drive’s motor and electronics (PCB),
head stack,
media surface,
all firmware/system areas,
partitions and file systems.

For more information about TaskForce’s diagnostics module, see Diagnosing a drive with Atola TaskForce 2.
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Diagnostics options for Express mode.

Imaging presets

To ensure that all imaging sessions in Express mode fit your organization’s demands and procedures, in Express mode you can use one of the preconfigured
imaging presets.

TaskForce 2 has two built-in imaging presets, Default and Damaged, for good and bad drives respectively, but you can also create and configure your own preset.
For guidance, see Imaging presets.

To select an imaging preset for Express mode, use the Type list in the Imaging settings preset section.

Changing the imaging preset is available only when Express mode is deactivated.
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The 'Type' list in the 'Imaging settings preset' section.

Set case details

To streamline your acquisition workflow in the Express mode, you can pre-fill case details for each evidence drive using predefined information:

Case ID
Investigator’s name
Organization
Location
Description

To enter predefined case details for Express mode and allow filling them up:

1. On the Express mode settings page, go to the Set case details section and toggle this option on.
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2. Click Change.

3. In the dialog window, enter case details and click Save.
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Activate Express mode
Once Express mode settings are specified, click the Activate button and connect your evidence drives for an immediate start of imaging.

If any drives are already connected to the source ports, TaskForce starts to image those devices immediately using Express mode settings once you click Activate.

To indicate that TaskForce now operates in Express mode:

1. In the user interface, the color of the top panel and the Image icon on the left changes.
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2. On the TaskForce’s IP screen, the message “Express mode” appears.

Image drives in Express mode

Plug drives

Once all settings are configured and Express mode is activated, simply plug in the drives one by one and watch the imaging sessions start automatically.

Control imaging status in Express mode

Home screen: All diagnostics and imaging processes launched in Express mode appear on the Home screen. Click any process to see its details.

LED indicators on the TaskForce front panel:

Blinking green - everything is OK, the process is running smoothly.

Yellow - user action required.

IP screen: TaskForce 2 keeps the user updated by displaying the number of user actions required on the IP screen on the front panel of the unit.

User action required

When TaskForce 2 detects an issue with an imaging session, the User action required notification appears on the Home screen for the user to make a decision.
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The number of user actions required is also displayed on the IP screen on the front panel of the hardware unit.

TaskForce prompts for user to take action if:

Diagnostics detect any issues with a device.
A user pauses the imaging process.
Imaging finishes.
A source device has already been imaged, fully or partially.
A source device has been formatted as storage.

Pause and resume imaging session

As in standard imaging mode, in Express mode you can pause any imaging session and then resume it later.

To pause an imaging session in Express mode:

1. On the Home screen, click on the running imaging process you want to pause.

2. On the imaging details page, click the Pause button at the bottom.

3. Confirm pausing the imaging process.

4. TaskForce shows the notification that the port has been powered off.

5. Optional: Unplug your evidence drive from the port.

6. Optional: Plug the next drive or do not plug any.

7. In the dialog, click Continue.

Once the imaging process is paused, TaskForce creates an Imaging paused report available either from the Home screen or from the Reports page.

To resume the paused imaging session in Express mode:

1. On the Home screen, click the paused session.

2. In the dialog, click Resume.
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Check imaging reports

Once the imaging process is started, paused, resumed, or completed in Express mode, TaskForce creates the respective report.

Reports contain the various details of the session in its current stage including source and target drive details, imaging settings, hash values, the time when the
imaging session started, when it was completed and more.

Reports are available either from the Home screen or from the Reports page.

Change drives

Once an imaging session in Express mode is completed, TaskForce powers the respective port off and prompts a user to plug in the next evidence device.

To start a new imaging session, plug in the next source device and click Continue in the dialog.
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Deactivate Express mode
To deactivate Express mode:

1. Click the Menu in the top right and select Express mode.

2. On the bottom of the Express mode settings page, click Deactivate.

To show that Express mode is deactivated, TaskForce changes the color of the top panel and the Image icon on the left back to normal. The message “Express
mode” on the IP screen also disappears.

Logical imaging

The Logical imaging module saves you time and storage space by copying only selected files and folders from an individual physical drive, image file, or RAID array
in a forensically sound manner, without altering the original content of a source device and its metadata.

As a result of logical imaging, you get an image file in L01 or ZIP format, which contains only the data you selected manually or using include/exclude filters. L01
image will also include MD5/SHA1 hashes of the files.

After the logical imaging process is completed, TaskForce 2 generates a comprehensive report with the details about the source, target, number of imaged files and
bytes and more.

Key features of logical imaging in TaskForce 2
25+ parallel logical imaging sessions.
Pause/Resume for each session.
L01 or ZIP target images created in a network folder or on a storage drive.
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Compression of a target file is available.
Supported file systems: NTFS, ext4/3/2, exFAT, XFS, ZFS, Btrfs, APFS (with encrypted volumes), HFS/HFS+, FAT32/16.
Smart include/exclude filters.

Start logical imaging
There are two ways to start the Logical imaging module in TaskForce 2.

From the Homescreen: On the Taskbar, click the Logical icon.

The Logical icon in the Taskbar.

From the RAID module: On the RAID Configuration page, click the Go to logical button. For details, see Logical imaging of a RAID array.
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The Go to Logical button on the RAID configuration page.

Logical imaging workflow in TaskForce 2
Once you started the Logical imaging module, follow these steps to create a logical image of your source device:

1. Select your source device.

2. Select partitions, folders, or files to image.

3. Apply smart filters, if needed.

4. Select target file.

5. Optional: Pause and resume the imaging process.

6. View the logical imaging report.

Let’s see in detail how to perform each step.

Select source device
After clicking the Logical icon on the Taskbar, select your source device.

TaskForce 2 supports the following source types:

1. Individual physical drive:
SATA,
SAS,
NVMe,
USB,
IDE,
drives with M.2 interface within Apple laptops using the Apple PCIe SSD extension module,
Apple MacBooks with FireWire, Thunderbolt 2, and Thunderbolt 3 interfaces using the Thunderbolt extension module.
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2. Image files:
IMG, RAW, DD
E01
AFF4

3. Reassembled RAID arrays.

File systems, supported by the Logical imaging module, are NTFS, ext4/3/2, exFAT, XFS, ZFS, Btrfs, APFS (with encrypted volumes), HFS/HFS+, FAT32/16.

Selecting a source device for logical imaging.

Select partitions, folders, or files to image
After you select your source device for logical imaging, TaskForce takes you to the Logical imaging page. Here you can preview the content of available partitions
and folders, apply smart filters or use presets with predefined filtering settings.

Your source device and its case ID are shown at the top of the page.
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Selecting partitions, folders, and files for logical imaging.

Preview, select, or deselect partition

The Partition section on the left lists all the partitions available on your source device.

To preview the partition contents, click on its name.

By default, all partitions are selected for imaging.

To exclude a partition, clear the checkbox next to it.

To include a partition again, select the checkbox.

Preview folder, manually include or exclude folders and files

Folders and files of the selected partition are shown in the middle section. By default, TaskForce images all files from all partitions.

To preview a folder's contents, click on the folder name.

To manually include a folder or file for imaging, click on its icon once. The icon turns green. The folder or file appears in the Filters section on the right as
manually included.

To manually exclude a folder or file, click on its icon twice. The icon turns orange. The folder or file appears in the Filters section on the right as manually
excluded.

Use smart filters and presets for selecting folders or files
Automatically include or exclude folders and files for imaging by using the built-in smart filters or custom filtering presets.

The Filters section on the right provides flexible options for fine-tuning your selection of folders and files for imaging.

By default, TaskForce images all files from all partitions.
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Apply filters

Use smart filters to automatically include or exclude specific files or folders:

1. In the Filters section, select the Custom option from the list.

2. Click the Include or Exclude button. The respective dialog appears.
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3. Automatically include or exclude folders:

a. In the respective dialog, select the Folders option from the list at the top.

b. Click in the Folders field.

c. Select one of the predefined options: User folders or OS folders.

d. Or enter the folder paths, separated by commas.

e. Click Apply.

4. Automatically include or exclude files:

a. In the respective dialog, select the Files option from the list at the top.

b. Specify File types by selecting predefined options from the list: archives, audio, databases, documents, emails, financial, pictures, security keys, video,
and virtual machines. You can enter file extensions yourself as well.

c. Enter file size range: from 1 byte to infinity.

d. Narrow down time spans: when files were modified, accessed, or created.

e. Click Apply.
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All applied Include or Exclude filters appear in the Filters section.
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Check filters before imaging

To test your filtering settings before imaging and get a list of files that match the selected filters, click Check at the top of the Filters section:
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TaskForce scans the selected partition(s) and lists all files matching the filtering criteria. You can download this file list in CSV format by clicking the Download
button at the bottom.

https://atola.com/img/tf2/manual/logical-imaging-09-check-filters.png
https://atola.com/img/tf2/manual/logical-imaging-09-check-filters.png


Downloading the list of files matching the filtering criteria.

Save filtering settings as a preset

To reuse your filtering settings later or share them with your colleague, save them as a logical imaging preset:

1. In the bottom right corner of the Logical imaging page, click the More icon with three dots.

2. Select Save to.

3. Enter the name for your preset and click Save.
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Saving a logical imaging preset.

From the same three-dots menu, you can also:

Export a preset to use it on another computer.

Import a preset created on another computer.

Delete a preset.
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To switch between presets, use the Current settings list on the bottom right of the logical imaging page.

Selecting a preset from the Current settings list.

Select target file
Once you have adjusted the logical imaging parameters, click Continue.

TaskForce takes you to the Select target folder window.

The target file in L01 or ZIP format (with or without compression) can be created either on a network drive or on a storage device connected directly to the
TaskForce hardware unit:

1. Select the folder for your target file and click Create file.
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The Select target folder window.

2. Adjust the settings of the target file:
a. Name.
b. File type: L01 or ZIP.
c. Hashing method (Digest type): MD5, SHA1, or MD5+SHA1.
d. Compression.
e. Case ID and details.

3. Click Create to start the imaging process.
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Creating logical imaging file.

How to set a drive to Storage mode

To create a target file on a drive connected directly to the TaskForce, you must first add this drive as a storage device:

1. In the Select image file window, click Add storage.

2. On the Select device panel, choose the drive you want to use in Storage mode. TaskForce uses a lighter shade of blue to indicate that a storage drive is
being configured.

3. If TaskForce cannot find the appropriate exFAT partition on the selected drive, it offers you to format the device accordingly. In that case, select the Format
device to exFAT option and click Next.

4. To launch target device formatting to exFat with a large cluster size (32 MB), click Format and enter YES for confirmation. This cluster size enables faster
imaging to this drive.

5. Once the target device is formatted, TaskForce perceives it as a Storage target.

Logical imaging process. Pause and resume
The logical imaging process starts immediately when you click Create in the Create logical image file dialog.

Once imaging is launched, TaskForce creates a Logical imaging started report. It contains all details about the imaging source and target(s), as well as information
about the include or exclude filters. You can find this report on the Home screen, on the Case page, or the Reports page.
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A Logical imaging started report.

During the imaging process, you can track the progress of individual files.

To check the filtering parameters of this running session, click View filters at the bottom of the page.
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The logical imaging process.

Pause and Resume

TaskForce lets you pause any logical imaging session and resume it later:

1. While the logical imaging process is running, click the Pause button at the bottom of the page.

2. To resume a session, click Logical on the Taskbar and then select your source device.

3. On the Recent logical imaging sessions page, click Resume next to your session.
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Resuming the logical imaging session.

Use cases of Pause/Resume

When you have to temporarily power off your TaskForce:

1. Pause logical data acquisition.

2. Turn off the TaskForce.

3. Power it on later.

4. Resume the logical imaging session exactly from the very "pause" moment.

When you want your colleague to continue imaging on another TaskForce:

1. Pause logical data acquisition.

2. Export the case.

3. Transfer the source drive and the exported case to a different location that has another TaskForce.

4. Import the case.

5. Resume the logical imaging session.

Logical imaging completed report
After the logical imaging process is completed, TaskForce 2 generates a comprehensive report with all the details of the imaged data:

The number of scanned and imaged files
The volume of imaged data
Time stamps
and more
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You can find this report on the Home screen, on the Case page, or on the Reports page.

The 'Logical imaging completed' report.

Imaging only sectors with data

Capacity of an average drive is constantly growing, and selective imaging becomes a way out for many investigators to keep their backlogs smaller.

We at Atola have developed selective imaging functionality to make it possible to image only sectors containing data.

The feature is supported in these file systems: NTFS, APFS, XFS, ext2/3/4, HFS, HFS+, ExFAT, FAT16, FAT32.

To image only sectors with data, do the following:

1. On the Imaging settings page, click Change to adjust imaging settings.

2. On the Passes tab, click on the value in the What to image column.
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The value in the What to image column.

3. In the Edit what to image on passes dialog, select Sectors with data.
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Selecting the Sectors with data option.

4. To preview the partitions on the source drive, click Show.

Imaging individual partitions is possible: just unselect the partitions you do not want to image. The imaging report will document this setting and
indicate, which of the partitions have been imaged and the sector ranges in which the partitions were located.
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Partitions preview.

5. In the Edit what to image on passes dialog, click Save.

6. To proceed with imaging, click Start.
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The Start button on the Imaging settings page.

You can see the partitions being imaged in the imaging log. In the imaging bar, the blue areas represent the sectors that are planned to be imaged. These are the
sectors that belong to the drive's partitions and contain data.
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Information about the partitions imaged in the log.

Imaging cheat sheet

When source drive is damaged

Use these imaging settings and follow the recommendations to cope with severely damaged drives.

Optimal target types for damaged source device

AFF4 image, RAW image file, or target drive plugged into the unit. Best to use segmented hashing with linear hashing disabled.

E01 is a linear format. It limits the use of TaskForce's advanced imaging features, e.g. reverse imaging or manual jumps.

Segmented hashes

Imaging with linear hash: one MD5/SHA1 hash.

Imaging with segmented hashes: many hashes of corresponding LBA ranges of the image.

The sum of these LBA ranges represents the entire image, though not necessarily in sequential order. You can still prove that the entire image has not been
modified by verifying all hashes in a set.

https://atola.com/img/tf/manual/6sectors-data1.jpg
https://atola.com/img/tf/manual/6sectors-data1.jpg


Damaged head

If Diagnostics detects a damaged or degraded head, disable the head in the imaging settings for the initial imaging session.

Read more here: Imaging a drive with a damaged head.

Damaged SATA drive on SAS port

TaskForce's SATA module and ports have more in-depth support of damaged SATA drives than the SAS subsystem. For instance, SAS doesn't allow sending so-
called vendor ATA commands that TaskForce uses in SATA to detect heads.

To be most effective against damaged SATA drives, it is best to connect them to SATA ports.

USB drive read errors

Use high-quality short USB3 cables. Longer or lower-quality USB3 cables can produce read errors during imaging.

Reverse direction

Imaging pass setting.

When enabled, the imaging engine reads a drive backwards.

Pros:
disables Read Look-Ahead effect
reaches damaged areas from the opposite direction

Cons:
speed decreases due to auto disabling of drive's cache

Manually skip bad sectors

If TaskForce can’t read a block from a source device, it will automatically skip sectors and try to image them on later passes. When the imaging process seems
to be stuck, you can move the imaging cursor manually by clicking another area on the top progress bar.
Manual sector jumps work only if linear hashing is disabled. You can use segmented hashing instead.

Disable read look-ahead

Imaging pass setting.

When enabled, a source device switches off its read-cache. Disabling read look-ahead decreases speed; but, it can be helpful against damaged drives.

Last imaging pass is too slow

Reduce a max time for a single read block attempt:
1. Pause imaging.
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Faster imaging

If you want to speed up image acquisition, follow these hints.

2. Add a new pass.

3. Change its Timeout setting to 500 ms (milliseconds).

4. Use the Go to pass button to switch to the newly added pass.

How imaging works on the last pass

The last pass has a unique feature which does not occur during previous passes: internal auto-reread procedure for error block sector-by-sector. It is defined
by an unchangeable Jump size = 1 sector.

How imaging engine works on the last pass:

1. It reads block using Max Block Size pass setting (256 by default)

2. If reading is successful -> proceed to a next non-imaged block

3. If a read error occurs -> re-read the whole error block sector by sector.

4. If a read error occurs and ReadLong setting is enabled -> re-read using ReadLong command.

Diagnose source before imaging

How it is useful:

1. Make sure the drive is in good condition or learn about the type of damage to make an informed decision about your following steps.

2. Prioritize the drive. Diagnostics report tells you if there is any data at all.

3. Use imaging time estimation.

Use faster targets

Good options:
target SSD
target NAS
network server with RAID

When imaging a network, 10Gbit network connection is highly recommended.

When to use Logical imaging

Time-constrained scenarios
Large capacity drives (e.g., 10TB and above) or RAID arrays
When specific files are of interest, not the entire drive

Image output format will be L01 or zip.



Change the timeout for a single read block attempt on-the-fly

You can read the data from your source device with a different timeout by adding another pass to your imaging session when it’s paused:

1. Pause the currently running imaging, using the Pause button.

2. Click Image and select your Source device.

3. On the Recent imaging sessions page, find your paused session and click the Edit imaging settings icon next to it.

4. In the Imaging settings dialog, click Add pass.

5. Click on the new pass, edit the Timeout value and Save it.

6. Select the new pass, click Go to Pass and Apply.

7. Next to your paused session, click the Resume button.

Important: The resumed imaging session will complement the data imaged prior to the pause with only the sectors that were not yet copied.

Express mode

Express mode is ideal for processing large amounts of data quickly. It automatically starts an imaging session for a newly inserted drive:

1. In the TaskForce window, go to system Menu > Express mode.

2. Specify Express mode Settings and click Activate.

3. Plug devices into Source ports: SATA, SAS, USB, IDE.

4. Imaging will start automatically.

5. If imaging doesn't start and the corresponding front LED is off, check the Home screen.

Integrate TaskForce into your workflow via Web API

Web API helps external software to communicate with TaskForce. Another software may control TaskForce this way. To put it simply, there are simple
operations in TaskForce Web API that any external software can run:

Get available Source drives
Optionally: diagnose drives
Start imaging
Check task status
Stop running task (if necessary)
Download created report

RAID 0 imaging

Atola TaskForce 2 can automatically detect a RAID 0 configuration, assemble and image such RAID array.

Assembling a RAID 0 with unknown configuration
1. Connect the drives to the TaskForce hardware unit's ports that are switched to the Source mode.

2. On the left in the TaskForce main window, click RAID.



3. On the Select source device panel, select the drives that make up a RAID array and click Continue.
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Selecting source RAID drives.

You can see key RAID configuration parameters at the top of the page:

Order of drives/images
RAID type
Start LBA
Block size
Block order

Before you enter other values either manually or by applying Autodetection module results, the most commonly used values are displayed in the given fields.

The Autodetection module starts running immediately.

RAID 0 autodetection
Stage 1: TaskForce 2 is reading data on the drives to identify the RAID type.

To change the order of drives in the array, simply drag a drive to its new position. To remove a device from the current array, grab it and put it into the bin.
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Analyzing devices.

Stage 2: TaskForce 2 goes through thousands of possible variants of RAID parameters.

Click Apply as soon as a Possible configuration tile appears.
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Possible RAID configuration.

After you click Apply, TaskForce 2 automatically applies the suggested configuration and checks the file system for partitions. At the bottom of the screen, a
preview of the partitions is available.

Observing files and folders in the preview confirms the detected RAID 0 configuration is correct.

Imaging RAID 0 array
1. After RAID configuration is successfully applied, click Go to Image to proceed with imaging.
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The Go to image button.

2. Select your target device or network folder and click Continue.

3. To launch your imaging session, click Start.

RAID imaging may take much longer than imaging a drive. You can optimize the imaging speed by using a fast target or a high-speed server.
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How to make raid image.

TaskForce 2 automatically generates reports for every session. The Imaging completed report will contain all RAID details as well as timestamps.
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The Imaging completed report.

RAID 5 forensics: Automated reassembly and imaging

TaskForce 2 is equipped with configuration autodetection module that makes assembling and imaging a RAID 5 array with an unknown configuration fast and easy.

Autodetection of RAID 5 configuration
1. Connect the drives to the TaskForce hardware unit's ports that are switched to the Source mode.

2. On the left in the TaskForce main window, click RAID.
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Initiating work with RAID.

3. On the Select source device panel, select the drives that make up a RAID array and click Continue.
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Selecting the drives that make up a RAID.

To assemble a RAID from images instead of drives or to use a combination of drives and images, on the Select source device panel, expand the File section and
click Select file. Then browse and select images.

After you selected the drives that make up a RAID array, TaskForce 2 redirects you to the RAID configuration screen. It consists of three parts:

The selected devices (and/or image files) are shown in the top RAID configuration part.
The RAID Partitions viewer below it provides a preview of partitions and files within them, once RAID has been successfully assembled.
The Autodetection module in the right-hand part of the screen immediately starts running and produces an output of RAID configuration suggestions.

Autodetection module reads data from all the selected devices and/or images to detect these RAID parameters:

Order of drives/images.
RAID type.
Start LBA.
Block size.
Block order.

Should the configuration be known, these parameters can also be set manually by the operator.

The time required for configuration detection can vary from a few seconds to a few hours depending on the numbers of drives involved, RAID volume and type,
and how metadata is distributed on the drives in the RAID. In certain cases, Autodetection may produce several configuration suggestions, which can be applied
one by one to find the exact match. TaskForce's Autodetection is based on heuristics algorithms that help speed up the variant check.

4. Click the Apply button to apply the configuration suggested by the Autodetection module.
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Autodetection module searching for possible RAID configurations.

If the suggested configuration matches the RAID native configuration, partitions of the RAID will be displayed and a preview of data within the partition will be
enabled.
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Detected RAID 5 configuration applied

Imaging selected partitions of RAID 5
1. To adjust the imaging settings and define the target for the image, in the left bottom corner of the screen, click Go to image.

2. Select the target for the imaging session. Both a local server and a target device in Storage mode can be used for imaging of a RAID array.

3. Click Create file.

4. In the Create image file dialog, fill out the image details and click Create.
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Imaging RAID. E01 details.

5. On the Settings page, click Change and then click the settings of an imaging pass.
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Imaging settings.

6. In Edit imaging pass dialog, select the individual partitions to be imaged if selective imaging is required and click Save.
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Selecting partitions in imaging settings

7. To launch the imaging session, click Start.

TaskForce 2 will be imaging RAID 5 array or its partitions as configured in the imaging settings.
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Imaging RAID 5 in progress

At the end of the imaging session, TaskForce 2 produces an Imaging completed report with all the details of the source drives, the RAID configuration, the target,
the partition, the timestamps, etc.
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RAID 5 forensics. Imaging report

Reassembling RAID 5 with a missing drive from image files

Imagine you have image files that are created from source RAID 5 drives. If one of RAID 5 drives was missing or heavily damaged, one image file is missing or
incomplete, too. TaskForce 2 uses RAID 5 redundancy to create a full image of the RAID even in such cases.

To reassemble a RAID from image files:

1. On the left in the TaskForce main window, click RAID.

2. On the Select source device panel, expand the File section and click Select file.

3. In the Select image file window, find the directory with the images you want to use and select the files. Then click Select.
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Selecting RAID 5 image files.

5. On the Select source device panel, check source image files and then click Continue.
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Selecting RAID 5 image files.

6. Autodetection module starts running automatically to find a suitable RAID configuration. You know that there is an image file missing from the selection (it
may have been lost or damaged), so click Add missing device underneath the list of image files.
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Adding missing RAID 5 drive.

7. Autodetection will recommence when a new image file or device is added. If the RAID is type 5, TaskForce 2 will be able to identify the right configuration
and reassemble the RAID by using the redundancy. When a possible configuration is found, click Apply.
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Applying the found RAID configuration.

The configuration application automatically changes the order of the drives/images, the detected RAID type, block size and order is applied automatically, too. In
the bottom part of the screen, the found partitions are available for preview.

8. To proceed with imaging, click the Go to image button and follow the instruction in subsequent screens to select the target and adjust imaging settings.
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Preview the found partitions and proceed to image

During the imaging, TaskForce 2 takes advantage of the redundancy to create an image of the RAID despite one of the devices is missing.
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Imaging RAID 5 with a missing drive.

The imaging report clearly indicates which of the devices that make up the RAID array was missing. Other RAID parameters, such as type, block size and order are
also clearly reflected in the report.
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Imaging report clearly indicates the missing device in RAID 5.

Imaging RAID 5 array with 2 damaged drives

Even if a RAID 5 array contains errors, Atola TaskForce 2 is able to detect its parameters and image such RAID.

Reassemble RAID 5
1. Connect the drives to the ports of the TaskForce 2 hardware unit. Make sure the ports are in Source mode.

2. On the left in the TaskForce main window, click RAID.

3. Select the drives that make up the RAID array.

4. Click Continue.
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Selecting RAID members

Detecting errors
The TaskForce 2 autodetection module starts running immediately, after you select the RAID devices.

Stage 1: TaskForce 2 reads data on the drives to identify RAID type. If it runs across an error, TaskForce 2 displays error tags next to the respective RAID member.

To see the number of errors encountered on a RAID member, simply hover the cursor over the error tag.
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Error tags

Stage 2: TaskForce 2 goes through thousands of possible RAID configurations to identify a suitable one.

Once the configuration is detected, click the Apply button.

Applying the suggested RAID configuration
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After you click Apply, TaskForce 2 automatically applies the suggested configuration and checks the file system for partitions.

Despite read errors, TaskForce 2 can mount the partitions for preview by rebuilding the data in the bad sectors using data redundancy inherent to this RAID type.

Imaging RAID 5 array with errors
1. After RAID configuration is successfully applied, click the Go to image button to proceed with imaging.

2. Select your target device or folder and click Continue.

3. To launch your imaging session, click Start.

4. When the TaskForce system encounters an error, it automatically reconstructs the missing data, using the data in the parity blocks on the remaining RAID
members.
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Coping with errors.

Thus TaskForce 2 can recover the full image. No operator involvement is necessary.

Imaging RAID 5 array.

In case 2 drives of the RAID 5 array contain errors in the same sector, TaskForce 2 can still recover the data from those, using the multipass imaging system.
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Imaging report
TaskForce 2 automatically generates the Imaging completed report with all RAID details and timestamps.

TaskForce 2 managed to successfully reconstruct and image all the data. That is why the number of errors in the Imaging completed report is zero.

Imaging report.

RAID 6 with unknown configuration

Atola TaskForce 2 lets you automatically detect all parameters of a RAID 6 array, preview its contents, and then create its full physical image or perform logical
imaging of only selected partitions, folders, and files.

To reassemble and image a RAID 6 array with an unknown configuration, do the following:

1. On the left in the TaskForce main window, click RAID.
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Initiating work with RAID.

2. On the Select source device panel, select the devices that make up a RAID array. They can be physical drives of all supported types, connected to the
TaskForce 2 hardware unit, image files (raw, E01 or AFF4 image files), or a combination of both.
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Selecting RAID members.

3. Once all the RAID members are selected, click Continue.

4. TaskForce 2 redirects you to the RAID configuration screen and immediately starts the Autodetection module.
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The RAID configuration screen in Atola TaskForce 2.

5. Optional: If you know some of the RAID parameters, such as RAID type, Start LBA, Block size, and Block order, you can select them manually from the lists at
the top of the RAID configuration section. To change the device order, drag the devices up or down, as needed.

https://atola.com/img/tf2/manual/raid-6-six-drives-03-autodetection.png
https://atola.com/img/tf2/manual/raid-6-six-drives-03-autodetection.png


Lists with RAID parameters for manual selection.

6. Optional: If you know that one or two RAID members are missing, choose RAID 6 from the RAID type list and then click the Add missing device button
once or twice respectively. For details, see RAID 6 with two missing devices.
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Adding a missing device to a RAID.

7. Wait for a couple of minutes while the module is checking thousands of variants to find a possible RAID configuration. The Autodetection progress is
displayed on the right side of the screen. To learn more about our heuristic RAID autodetection algorithm, see How autodetection of an unknown RAID
works.

8. Once TaskForce 2 has detected a possible configuration, click Apply. TaskForce 2 automatically changes the order of the devices, applies the detected RAID
type and other parameters, and then parses and verifies the file system of an array.

https://atola.com/img/tf2/manual/tf2-raid6-two-missing-03.png
https://atola.com/img/tf2/manual/tf2-raid6-two-missing-03.png
https://atola.com/products/tf1/forensic-raid-image.html#auto
https://atola.com/products/tf1/forensic-raid-image.html#auto


Applying a possible RAID configuration.

9. To make sure that the suggested RAID configuration is resulting in tangible data, check the Partitions section at the bottom left and preview the contents of
a reassembled RAID, including partitions, folders, and files. To help you decide whether the applied configuration is valid or not, TaskForce 2 displays a small
tag with the accuracy percentage next to the partition. In some cases, TaskForce will suggest alternative configurations, and you can try to improve the
accuracy percentage by applying these alternative configurations.
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The preview of the RAID contents.

10. Click Go to image to acquire a full bit-by-bit copy of the array to E01, AFF4, or raw image. Or click Go to logical to copy only selected partitions, folders, or
files to L01 or ZIP.

11. After imaging is finished, TaskForce 2 automatically generates an Imaging completed report. It includes all the details of the source drives, the RAID
configuration, the target, the partition, the timestamps and more.
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The Imaging completed report.

RAID 6 with two missing devices

Even if two of the devices in a RAID 6 array are damaged or missing, Atola TaskForce 2 can rebuild and image a RAID of this type, taking advantage of its extra
redundancy. To accomplish that, TaskForce 2 uses both types of parity blocks, XOR parity and Reed-Solomon parity, distributed across all the devices in a RAID 6
array.

TaskForce 2 automatically detects all parameters of a RAID 6 array with two missing devices, reassembles the array, and enables a preview of its contents. Once the
RAID is reassembled, you can acquire its full physical image or perform logical imaging of only selected partitions, folders, and files.

To rebuild and image a RAID 6 array with one or two missing devices, do the following:

1. In the Taskbar, click RAID.

https://atola.com/img/tf2/manual/raid-6-six-drives-07-report.png
https://atola.com/img/tf2/manual/raid-6-six-drives-07-report.png


Initiating work with RAID.

2. On the Select source device panel, select the devices that make up a RAID array. They can be physical drives of all supported types, connected to the
TaskForce 2 hardware unit, image files (raw, E01 or AFF4 image files), or a combination of both.
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Selecting RAID members.

3. Once the available RAID members are selected, click Continue.

4. TaskForce 2 redirects you to the RAID reassembly screen and immediately starts the Autodetection process to find the suitable configuration.
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The RAID configuration screen in Atola TaskForce 2.

5. Since you know that one or two RAID members are missing, select RAID 6 from the RAID type list and click the Add missing device button once or twice
respectively. When checking variants of possible RAID configuration, TaskForce 2 will take into account that there are missing RAID members.
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Adding a missing device to a RAID.

6. Optional: If you know some of the RAID parameters, such as RAID type, Start LBA, Block size, Block order, Parity block order, you can select them manually
from the lists at the top of the RAID configuration section.
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Lists with RAID parameters for manual selection.

7. Wait while the module is checking thousands of variants to find a possible RAID configuration. Autodetection progress is displayed on the right side of the
screen. To learn more about our heuristic RAID autodetection algorithm, see How autodetection of an unknown RAID works.

8. Once TaskForce 2 has detected a possible configuration with two missing devices, click Apply. TaskForce 2 automatically changes the order of the devices,
applies the detected RAID type and other parameters, and then parses and verifies the file systems of an array.
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Applying a possible RAID configuration.

9. To make sure that the suggested RAID configuration is correct, check the Partitions section at the bottom left and preview the contents of the reassembled
RAID, including partitions, folders, and files. To help you decide whether the applied configuration is valid or not, TaskForce 2 displays a small tag with the
accuracy percentage near the partition.
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The preview of the RAID contents.

10. Click Go to image to acquire a full bit-by-bit copy of the array or Go to logical to copy only selected partitions, folders, or files.

11. After imaging is finished, TaskForce 2 automatically generates an Imaging completed report. It includes all the details of the source drives, the RAID
configuration, the target image, the timestamps and more.
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The Imaging completed report.

RAID 10: reassembly and imaging

RAID 10 arrays combine mirroring and striping techniques. This helps these arrays have higher performance and better resiliency against data loss or corruption.
TaskForce 2 uses both of these advantages: it images data faster from a RAID 10 compared to other RAID types and rebuilds the image using the data redundancy
in case of disk failure.

TaskForce's configuration autodetection module will help identifying the type and other parameters of a RAID 10, should there be a lack of information about the
given RAID and its configuration.
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To mount an unknown RAID 10 and image it:

1. On the left in the TaskForce main window, click RAID.

2. Select the drives that make up the RAID array and click Continue.

RAID 10. Selecting RAID members.

3. When the autodetection module (in the right part of the screen) comes up with a suggestion of RAID configuration, click Apply.

In rare cases, there can be more than one suggestion. Try them out one by one by clicking Apply next to each suggestion.
If you know the type and parameters of the RAID, you can enter them manually in the drop-downs.
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RAID 10. Applying the detected configuration.

4. TaskForce 2 arranges the drives into respective groups and applies other RAID settings to mount the partitions, which you can browse through in the
Partition preview below.

RAID 10. Previewing the partitions.

5. Click the Go to image button and select the target.
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RAID 10. Selecting target.

6. Check the settings. Please note that you can choose to image only part of the data (only one of the partitions).
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RAID 10. Imaging.

7. The automatically generated Imaging report contains the details of the RAID and its members, the target, hashes, signatures found as well as the
timestamps.
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RAID 10. Imaging report.

Synology NAS RAID auto reassembly

Synology NAS RAID is a popular network storage solution. It has a complex structure and can include several RAIDs combined via LVM (Logical volume manager)
and SHR RAID management system.

Atola TaskForce 2 can automatically detect the configuration of a Synology NAS RAID array and perform immediate forensic RAID reconstruction.

To automatically reassemble and then image a Synology NAS RAID array with an unknown configuration, do the following:
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1. On the left in the TaskForce main window, click RAID.

Initiating work with RAID.

2. On the Select source device panel, select the devices that make up a RAID array.

They can be physical drives of all supported types, connected to the TaskForce 2 hardware unit, image files (raw, E01 or AFF4 image files), or a combination
of both.
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Selecting RAID members.

3. Once all the RAID members are selected, click Continue.

4. TaskForce redirects you to the RAID configuration screen and immediately starts the Autodetection module.

Despite the complexity of the Synology NAS RAID structure, the autodetection module instantly identifies the array by detecting controller metadata and
applies the RAID configuration.
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Synology NAS RAID configuration found and applied.

If the Synology NAS RAID configuration wasn’t immediately found and the Autodetection process is still running, there are two possible reasons:

a. One or more selected devices aren’t part of this Synology NAS RAID array.

b. One or more devices of the array are missing.

In this case, stop the Autodetection module, go back to Step 2 and try selecting different devices that make up a RAID array.

5. Once the RAID configuration is found, proceed with imaging the assembled RAID:

Click Go to image to acquire a full bit-by-bit copy of the array to E01, AFF4, or raw image.

Or click Go to logical to copy only selected partitions, folders, or files to L01 or ZIP.

6. At the start of the imaging process, TaskForce creates an Imaging started report with detailed information about Synology NAS RAID configuration and
partitions.
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The 'Imaging started' report.

7. After the imaging is finished, TaskForce generates an Imaging completed report. It includes all the details of the source devices in a RAID, the target(s), the
number of imaged sectors, the timestamps and more.

Instant forensic RAID reconstruction: Linux mdadm

Atola TaskForce 2 can automatically detect configuration of software RAID created with mdadm in Linux and perform immediate forensic RAID reconstruction.

Autodetection of the mdadm-created software RAID
1. Connect the drives to ports in Source mode.

2. On the left in the TaskForce main window, click RAID.

3. Select the drives that make up a RAID array and click Continue.

Autodetection module has instantly recognized and applied the RAID configuration. TaskForce 2 automatically identifies mdadm-created RAID arrays with great
precision by detecting controller metadata.

This RAID’s Start LBA is different from 0. TaskForce’s autodetection module is trained to detect this parameter for different types of RAID arrays and mdadm
versions.

A partition is displayed in the bottom part of the screen, confirming that the applied configuration is correct.
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Forensic RAID reconstruction.

Imaging the mdadm-created RAID array
1. To proceed with imaging the assembled RAID, click the Go to image button.

2. Select the target and click Continue.

3. Click Start and confirm the overwriting of data on the target.

The imaging session runs as fast as the target speed allows.

The imaging report contains all the RAID details and timestamps.
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Imaging report for an mdadm-created RAID.

Logical imaging of a RAID array

Imaging of a RAID can potentially take too long. When you are under time constrains, TaskForce's logical imaging module helps you focus on imaging only the data
that can make an immediate impact.

Once a RAID has been reassembled, you have a preview of the RAID's contents in the RAID module. This helps you decide which files or folders you want to image
immediately.

Create logical image of a RAID array
1. On the RAID Configuration page, click the Go to logical button.
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The suggested RAID configuration applied, partitions preview shows partitions.

2. In the Logical imaging module, adjust your selection if needed.
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Specify the partitions, files and folders to included or excluded in the imaging.

By default, logical imaging is set to image all files from a drive or a RAID. To fine-tune your selection, include or exclude what you need:

All or selected partitions.
Manually selected files or folders.
Specified file types: archives, emails, documents, databases, financial, virtual machine, audio, video, pictures, security keys.
Folder types: only user or only OS folders.
Time spans: when files were accessed, created, modified.
File size: from 1 byte to infinity.
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Multiple search parameters allow you to fine-tune your selection.

3. Once you have adjusted the logical imaging parameters, click Continue.

4. Select the Target for your L01 file and click Create file.

5. Adjust the settings of the L01 file and click Create to start the imaging session.
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Settings of an L01 file.

When the imaging is running, you can track the progress of imaging of the individual files. As for the overall imaging progress, the upper graph indicates the
amount of imaged data as related to the whole space of the RAID volume, not to the selected volume.
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Logical imaging of a RAID array.

Imaging report
TaskForce 2 generates the Imaging completed report with all the details of the imaged selection from this RAID:

The number of scanned and imaged files
The volume of imaged data
Time stamps
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Imaging completed report of a logical imaging session

Imaging started report is created the moment the imaging launched: it is a detailed report of all the settings including the elements selected for this acquisition
(partitions, files and folders).
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Imaging started report of a logical imaging session.

Imaging selected partitions of a RAID array

With Atola TaskForce 2, you can image individual partitions of an assembled RAID array to avoid imaging excessive amounts of data.

Once the RAID array has been reassembled, you can preview the contents of its partitions. It helps you conclude which of the partitions may contain the critical
evidence and which are irrelevant.
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Image selected partitions
To image only selected partitions of an assembled RAID array, do the following:

1. On the RAID configuration page, click Go to image.

The suggested RAID configuration applied, partitions preview shows partitions.

2. Select your target device and click Continue.

3. On the imaging Settings page, click the imaging pass to adjust the imaging range.
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The suggested RAID configuration applied, partitions preview shows partitions.

4. In the Edit imaging pass dialog, click on the What to image and select Sectors with data.
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Selecting only sectors with data from the What to image list.

5. Unselect the partitions you do not need and click Apply. Then click Save to keep this change.
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Select partitions for imaging

The selective imaging does not linear hashing of the imaged range, segmeted hashing is suggested for such imaging.

6. To launch your imaging session, click Start.
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The suggested RAID configuration applied, partitions preview shows partitions

Imaging report
TaskForce 2 generates the Imaging completed report with all the details of the RAID:

The imaged range.
Time stamps.
A link to the file with the segmented hash, calculated for the imaged range.
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The Imaging completed report

How to unmount an assembled RAID

After you selected specific drives or images as RAID participants, they constitute virtual RAID array and become unavailable for individual tasks. For instance, you
cannot recalculate hash of one of such drives.
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To use the individual drives that are a part of a mounted RAID array, you need to unmount the RAID first.

Follow these steps:

1. At the top right, click Devices.

2. Scroll down to the bottom of the Devices panel and in the RAID section select the currently connected and mounted RAID.
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Assembled RAID array.

3. At the bottom of the RAID configuration page, click the Unmount RAID button.
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Unmount RAID with a single click.

Now you can proceed with other sessions, using any of the drives connected to TaskForce 2.

Supported RAID types and parameters

RAID stands for "redundant array of independent disks" or "redundant array of inexpensive disks". It is a technology of data storage that combines two or more
physical disk drives into one or more logical units (arrays). This approach improves data storage reliability, performance, or both.

The data can be distributed across physical drives of a RAID array using different standardized methods, which are called RAID types or RAID levels.

Atola TaskForce can reassemble and image the following RAID types:

JBOD

RAID 0 (Stripe)

RAID 1 (Mirror)

RAID 10 (Stripe of mirrors)

RAID 5 (Distributed parity)

RAID 6 (Dual parity)

This article covers currently supported RAID types and their parameters in more detail.
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RAID types comparison

RAID type
and
method

Scheme of
data
distribution

Description Common
usage

Performance Fault
tolerance

Capacity
Minimum
number
of disks

JBOD:
Spanning

Multiple physical
drives are
spanned, or
concatenated,
together to form
a single logical
disk with no
redundancy.

Increasing
capacity. Cost-
effective
storage with
no
performance
or security
benefits.

No benefits. Array
performance
equals the
performance of
each drive
depending on
data location.

Very low.
Redundancy is
not provided.
If one drive
fails, a failure
is typically
isolated to this
drive.

Array capacity
is the sum of
the capacities
of its
members. 2

RAID 0:
Striping

Data is split
('striped') evenly
across the drives
forming a logical
array, without
parity or
mirroring.

Improving
reading and
writing speed.

The highest read
and write speed
because data is
striped across all
disks, and the
controller can read
and write several
drives in parallel
with no delay due
to parity
calculation.

Very low. If
one drive fails,
data is lost.

Volume is the
sum of the
capacities of
the drives in
the set. No
overhead is
provided by
parity blocks.

2

RAID 1:
Mirroring

Mirroring
without parity or
striping. Data is
written
identically to two
or more drives,
producing a
"mirrored set" of
drives.

Standart app
servers;
applications
that require
higher fault
tolerance, than
storage
capacity or
performance.

High read speed:
the controller can
read several drives
in parallel. Lower
compared to
RAID 0 write
speed: all data
must be written to
two disks.

High. If one
drive fails, data
is restored
from the
“mirror”
drive(s).

Storage
capacity is
reduced by
1/2 as all data
is written
twice.

2

RAID 10 (1+0):
Striping and
mirroring

Striped set from
a series of
mirrored drives.
Data is shared
between disks
and duplicated.

Highly utilized
database,
email, web
servers.

High read speed
similar to RAID 1
due to improved
read rates through
simultaneous disk
reads.Moderate to
high write speed
because data is
mirrored across
pairs, but the
striping allows for
higher write
speeds compared
to just RAID 1.

Very high fault
tolerance. The
array can
sustain
multiple drive
losses so long
as no mirror
loses all its
drives.

Storage
capacity is
reduced by
1/2 as all data
is written
twice.

4
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RAID type
and
method

Scheme of
data
distribution

Description Common
usage

Performance Fault
tolerance

Capacity
Minimum
number
of disks

RAID 5:
Striping and
parity

Data is split
('striped') evenly
across the drives
with added
distributed
parity.

Normal file
storage and
app servers.

High read speed
but slightly lower
than RAID 0
because of the
overhead from
parity calculations
and distribution
across all disks.
Moderate write
speed due to the
need for parity
calculations and
writing both data
and parity
information.

High. If one
drive fails, data
can still be
calculated
from the
distributed
parity.

Due to parity
blocks,
storage
capacity
equals the
smallest drive
capacity
multiplied by
(N−1) drives.

3

RAID 6:
Striping and
double parity

Data is split
('striped') evenly
across the drives
with two
distributed parity
blocks, instead of
one.

Large file
storage and
app servers.

High read speed
similar to RAID 5,
but can be slightly
slower due to
additional parity
calculations. Write
speed is lower
than RAID 5
because it requires
two parity blocks
to be written.

Very high fault
tolerance due
to double
parity. Data
can still be
calculated
even if two
drives fail.

Due to dual
parity blocks,
storage
capacity
equals the
smallest drive
capacity
multiplied by
(N−2) drives.

4

RAID parameters
Each individual RAID is defined by a combination of several main parameters:

RAID type (or RAID level)

Number of devices

Device order

Start LBA (or Disk offset)

Block size

Block order

Parity block order

File system

To identify RAID type and exact parameters, TaskForce automatically checks up to 200,000,000 RAID parameter combinations. However, if you know the exact RAID
configuration, you can enter it manually.
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Depending on the RAID type, different sets of parameters can be applied:

Parameter JBOD RAID 0 RAID 1 RAID 10 RAID 5 RAID 6

Number of devices  + missing  + missing

Device order

Start LBA

Block size − −

RAID 1 groups − − − − −

Block order − − − −

Parity block order/type − − − − −

Here’s what each of the RAID parameters means.

RAID type (or RAID level)

RAID type is defined by the method in which data is distributed across physical drives combining the array. TaskForce currently supports the following RAID types:

JBOD

RAID 0 (Stripe)

RAID 1 (Mirror)

RAID 10 (Stripe of mirrors)

RAID 5 (Distributed parity)
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RAID 6 (Dual parity)

In TaskForce, the RAID type can be automatically identified by the Autodetection module along with other parameters.

However, if you know the RAID type, you can select it manually from the RAID type list in the RAID configuration section.

The RAID type list in the RAID configuration section.

Number of devices

Applies to: all supported RAID types.

The minimum number of disks needed to build a RAID array is:

two for JBOD, RAID 0, and RAID 1,
three for RAID 5,
four for RAID 10 and RAID 6.

The actual number of RAID members is determined by you when you select in the TaskForce RAID module physical disks (SATA/SAS/USB drives) or their images
(raw, E01 or AFF4 image files) as Sources that make up a RAID array.
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Selecting source RAID drives.

Missing RAID members. For the RAID types that use redundancy (parity blocks), TaskForce can reassemble an array and create its image even with a missing
device:

with one missing device for RAID 5 that uses distributed parity,

with two missing devices for RAID 6 that uses double distributed parity.

See RAID 5 with a missing drive for more details.
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Adding missing RAID 5 drive.

Device order

Applies to: all supported RAID types.

The drive order is the order in which physical devices (or their images) follow each other within a logical array (think pages within a book). That order is defined by
a RAID controller during the setup of an array. To reassemble and image a RAID array, you need to determine which of its members go first, second, third and so
on.

In TaskForce, the drive order can be automatically detected by the Autodetection module along with other parameters.

However, if you know the drive order, arrange the RAID members manually by dragging them up or down in the RAID configuration section of the TaskForce RAID
module.
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Start LBA (or Disk offset)

Applies to: all supported RAID types.

LBA stands for Logical Block Address. It is a scheme used for addressing a particular area on a storage device in a linear way using sequential integer numbers,
starting from zero: 0, 1, 2, 3… Thanks to LBA a single drive or a RAID controller identifies the exact location of bytes it needs to read from or write to.

When we talk about RAIDs, Start LBA, also known as Device offset, refers to an address of a logical block on each physical RAID member where user data begins.
Start LBA of each member of the same RAID is identical.

If RAID’s Start LBA is 0, RAID blocks (chunks) start from the first logical block on each drive in an array, without any offset (it is the most common case).

If RAID’s Start LBA is greater than 0, a space created by this offset is skipped. RAID blocks start from the specified Start LBA on each drive in an array. Typically, the
skipped space can be used to store RAID metadata (data about data).

In some cases, TaskForce can identify RAID’s Start LBA during autodetection using a heuristic algorithm.

If you know Start LBA, you can enter it in the Start LBA field of the RAID configuration section.
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When we talk about logical partitions, Start LBA refers to the logical block address where a particular partition starts in an already assembled RAID array. In
this case, Start LBA of each partition is different.

Block size

Applies to: RAID 0, RAID 10, RAID 5, RAID 6 (types that use striping method).

Some RAID types use striping method for distributing data across physical drives: data is split into consecutive logical blocks (also called “stripes” or “chunks”),
which are stored on different physical storage devices.

The Block size parameter in TaskForce RAID module refers to the size of these logical blocks (or “stripes”) measured in bytes. TaskForce supports RAID block sizes
from 512 bytes to 1 megabyte and can detect that parameter automatically using a heuristic algorithm. The most frequently used block size is 64 kilobytes.

If you know the block size of a RAID, you can select it manually from the Block size list in the RAID configuration section.
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Block order

Applies to: RAID 5, RAID 6 (types that use block-level striping with distributed parity).

The Block order parameter defines the layout (or pattern), in which RAID logical blocks (“stripes”) are distributed among the devices in the array. It is the sequence
of writing data and parity blocks across the RAID members and depends on:

1. The direction of data blocks writing: left to right or right to left on the disk array.

2. The placement of the parity blocks: at the beginning or the end of the stripe.

3. The location of the first block of a stripe relative to the parity of the previous stripe.

For RAID 5, the Block order parameter can be:

Left symmetric. This is the default RAID 5 layout under Linux.

Left asymmetric. This is the 'standard' RAID 5 layout.

Right symmetric.

Right asymmetric.
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For RAID 6, the Block order parameter can be following:
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Parity block order

Applies to: RAID 6.

Unlike RAID 5, RAID 6 uses not one, but two types of parity blocks. The Parity block order parameter defines, which parity block type comes first and which follows:

PQ: XOR parity block comes first, Reed-Solomon parity block comes second.

QP: Reed-Solomon parity block comes first, XOR parity block comes second.

File system

After reassembling RAID using other parameters, TaskForce automatically identifies its file system and shows a preview of its partitions, folders, and files.

Currently supported file systems are: .
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The preview of the RAID file system with partitions, folders, and files.

JBOD
JBOD is an abbreviation of "Just a Bunch Of Drives" and refers to a method for concatenation (or spanning) of multiple physical drives into a single logical disk with
no redundancy. Data is written consecutively, from the beginning to the end of the first drive, and then spans to the second, the third and so on.

JBOD provides cost-effective storage with no performance or security benefits. It needs at least 2 drives to function. Array capacity is the sum of the capacities of its
members.

If one drive fails, all data stored across the entire array may be compromised or lost, as JBOD does not implement any form of redundancy or fault tolerance.

JBOD advantages:

Increasing capacity.
Cost-effective storage.

JBOD disadvantages:

No performance benefits.
Redundancy is not provided.

JBOD parameters

When reassembling JBOD in Atola TaskForce, the following parameters are available for manual selection:

Device order
Start LBA
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RAID 0 (Stripe)
In RAID 0, data is evenly distributed into stripes across two or more drives, forming a logical array, without parity or mirroring. RAID 0 provides higher reading and
writing speed, as it can read and write multiple drives in parallel. As RAID 0 does not use mirroring or parity blocks, there’s no redundancy and fault tolerance: if
one drive fails, data is lost.

RAID 0 needs at least 2 drives to function. Array volume is the sum of the capacities of the drives in the set, there’s no overhead provided by parity blocks.

RAID 0 advantages:

Highest reading and writing speed.
No overhead provided by parity blocks.
Maximum capacity: sum of all RAID members.

RAID 0 disadvantages:

No fault tolerance: if one drive fails, data is lost.

RAID 0 parameters

When reassembling RAID 0 in Atola TaskForce, the following parameters are available for manual selection:
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Device order
Start LBA
Block size

See also

Imaging RAID 0 with unknown configuration

RAID 1 (Mirror)
RAID 1 creates an exact copy of the drive's data (“mirror”) on another drive or drives. Thus RAID 1 usually consists of mirrored drives which are exact copies of each
other. No spanning, striping, or parity is being used. The capacity of the array is limited to the size of the smallest member drive.

If one member drive fails, data is restored by copying from the mirror drive. Because of that RAID 1 can still work even if only one member drive is in good
condition.

RAID 1 reads multiple drives in parallel, increasing overall reading performance. But writing speed is lower, as it takes additional time to duplicate data on the
mirror drive.

When TaskForce detects a mirrored pair of devices (drives or image files), it labels both of them with the “Mirror” tag.
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RAID 1 advantages:

Improved reading speed.
High fault tolerance. Data can be restored from the “mirror” drive.
Simplest RAID storage system.

RAID 1 disadvantages:
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Storage capacity is limited to the size of the smallest member drive.
Writing speed is lower due to data duplication.

RAID 1 parameters

When reassembling RAID 1 in Atola TaskForce, the following parameters are available for manual selection:

Device order
Start LBA

RAID 10 (Stripe of mirrors)
RAID 10 is called “stripe of mirrors” as it combines RAID 1 (“mirroring”) and RAID 0 (“striping”) methods within a single logical array. Data is shared between drives
and duplicated. It is a RAID 0 array consisting of mirrors and thus requires a minimum of four drives: two for striping and two for storing mirrored data of each
drive.

High read and write performance is achieved by striping RAID 1 mirrored segments.

If one member drive fails, data is restored by copying from the mirror drive. The overall storage capacity is reduced by 1/2 as all data is written twice.
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RAID 10 typical use is highly loaded databases, email, or web servers.

When TaskForce detects a mirrored pair of devices (drives or image files), it labels both of them with the “Mirror” tag.

RAID 10 advantages:

High reading and writing speed.
High fault tolerance. Data can be restored from the “mirror” drive.

RAID 10 disadvantages:

Storage capacity is reduced by 1/2 as all data is written twice.
Limited scalability.

RAID 10 parameters

When reassembling RAID 10 in Atola TaskForce, the following parameters are available for manual selection:

Device order
Start LBA
Block size
RAID 1 groups

See also

Reassembly and imaging of RAID 10

RAID 5 (Distributed parity)
In RAID 5, data in the form of block-level stripes is evenly distributed across at least 3 drives, along with parity information which is used to restore data.

RAID 5 can still operate without one of its members. If one drive fails, its data is calculated from the parity blocks distributed across other members. Atola TaskForce
can detect the parameters of the RAID 5 array with two damaged drives and successfully image such RAIDs regardless of errors.

The storage capacity of RAID 5 is reduced due to parity blocks.

Reading and writing speed is high since RAID 5 can read from and write to all array members in parallel.

RAID 5 is typically used for file servers, database servers, and application servers.

RAID 5 can have different layouts, or block orders, depending on the pattern in which RAID 5 data blocks (“stripes”) and parity blocks are distributed among the
devices in the array. The layout is defined by:
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1. The direction of data blocks writing: left to right or right to left on the disk array.
2. The placement of the parity blocks: at the beginning or end of a stripe.
3. The location of the first block of a stripe relative to the parity of the previous stripe.

There are four RAID 5 layouts (or block orders):

1. Left symmetric.
2. Right symmetric.
3. Left asymmetric.
4. Right asymmetric.
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RAID 5 advantages:

High read speed but slightly lower than RAID 0 because of the overhead from parity calculations and distribution across all disks.
High fault tolerance. Data from one failed drive can be restored using parity information, stored on other array members.

RAID 5 disadvantages:

Storage capacity is reduced due to parity blocks. Space efficiency is described by formula: 1 − 1/n, where n is the number of devices in an array. For instance,
for RAID 5 consisting of 5 drives with total capacity of 1 TB, available space will be reduced by 1/5 (or 200 MB), to 800 MB.
Moderate write speed due to the need for parity calculations and writing both data and parity information.

RAID 5 parameters

When reassembling RAID 5 in Atola TaskForce, the following parameters are available for manual selection:

Device order
Start LBA
Block size
Block order
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See also

RAID 5 with unknown configuration

RAID 5 with a missing drive

Imaging RAID 5 array with 2 damaged drives

RAID 6 (Dual parity)
RAID 6 uses block-level striping (data is shared between drives) with two parity blocks, instead of one, distributed across all member disks. This gives extra
redundancy to an array: RAID 6 can read and write data even if two drives fail at the same time.

This RAID type needs at least 4 drives to function. Storage capacity is reduced because of the dual parity scheme.

RAID 6 is typically used for large file storage, file servers, database servers, app servers.

Thanks to RAID 6 extra redundancy coming from two parity block types, TaskForce can rebuild a RAID 6 array even if two of its members are missing or damaged.

RAID 6 can have different layouts, or block orders, depending on the pattern in which RAID 6 data blocks (“stripes”) and parity blocks are distributed among the
devices in the array. The layout is defined by:

1. The direction of data blocks writing: left to right or right to left on the disk array.
2. The placement of the parity blocks: at the beginning or end of the stripe.
3. Parity block order.
4. The location of the first block of a stripe relative to the parity of the previous stripe.

RAID 6 advantages:

Very high data fault tolerance.
Data can be restored even if two drives fail.

https://atola.com/img/tf2/manual/raid-types-22-raid-6-six-drives.png
https://atola.com/img/tf2/manual/raid-types-22-raid-6-six-drives.png
https://atola.com/products/taskforce/manual/raid-5-forensics.html
https://atola.com/products/taskforce/manual/raid-images-missing.html
https://atola.com/products/taskforce/manual/imaging-raid5-2damaged-drives.html


High reading speed similar to RAID 5, but can be slightly slower due to additional parity calculations.

RAID 6 disadvantages:

Storage capacity is reduced because of the dual parity scheme.
Reduced writing speed due to the usage of two types of parity blocks.
Minimum 4 drives needed.

RAID 6 parameters

When reassembling RAID 6 in Atola TaskForce, the following parameters are available for manual selection:

Device order
Start LBA
Block size
Block order
Parity block order

RAID read and write speeds
The different RAID levels offer various trade-offs in terms of read and write speed, redundancy, and storage efficiency. Below is a comparison of RAID 0, 1, 10, 5,
and 6 regarding their read and write speeds.

Key Points:

RAID 0 offers the best performance both in reads and writes but no redundancy.

RAID 1 provides good read performance and redundancy at the cost of available capacity.

RAID 10 combines the benefits of RAID 0 and RAID 1, offering a good balance of speed and redundancy.

RAID 5 and RAID 6 offer a good balance between storage efficiency, read speed, and redundancy, with RAID 6 providing higher fault tolerance at the cost
of write speed due to additional parity calculations.

RAID
type Read Speed Write Speed

RAID 0 Highest because data is striped across all disks, allowing
simultaneous reads.

Highest because data is striped, allowing simultaneous
writes. No parity calculation delay.

RAID 1 High because data can be read from either of the mirrored
disks, potentially doubling the read rate compared to a
single disk.

Lower than RAID 0 because all data must be written to two
disks, causing a slight overhead.

RAID 10 High, similar to RAID 1 because it combines striping and
mirroring, offering improved read rates through
simultaneous disk reads.

Moderate to High because data is mirrored across pairs,
but the striping allows for higher write speeds compared
to just RAID 1.

RAID 5 High but slightly lower than RAID 0 because of the
overhead from parity calculations and distribution across
all disks.

Moderate due to the need for parity calculations and
writing both data and parity information, which introduces
some overhead.

RAID 6 High, similar to RAID 5, but can be slightly slower due to
additional parity calculations.

Lower than RAID 5 because it requires two parity blocks to
be written, further increasing the overhead compared to
RAID 5.

RAID tags and what they mean

When reassembling a RAID in TaskForce 2, start by selecting the drives and/or images it consists of. The system reads the first 3 million sectors of each RAID
member, analyzes the data and compares the members against each other. TaskForce 2 then labels the RAID members with appropriate tags to help you identify
the condition, relation and possible position.



Spare
The Spare tag informs you that 99.95% of the drive’s initial 3M sectors are filled with zeros.

A spare (aka hot spare) drive in RAID arrays is used as a standby drive reserved to replace a RAID member in case it fails: in this situation the RAID controller uses
redundancy data to reconstruct the data from the failed disk to the spare one. Spare drives are used in RAID 1, RAID 5 and RAID 6.

Mirror
With the Mirror tag, TaskForce 2 informs you that 99.5% out of the analyzed 3M sectors are identical to the same sectors on a different RAID member. It works as a
hint that you are dealing with a RAID 1, RAID 10 or RAID 50.

MBR
MBR (Master Boot Record) points to the drive(s) that contain an MBR. Therefore, it is likely that the drive with detected MBR can be placed first in the given array.

File system tags
The initial 3M sectors of each drive/image are analyzed to identify a boot sector of any known file system. When a partition boot sector is detected, the
corresponding file system tag is added. To see LBA offset and sector count of the partition, hover mouse cursor over the tag.

Supported file system tags: NTFS, ext4/3/2, APFS, HFS, HFS+, exFAT, FAT32, FAT16, XFS.

Additionally, Unknown tag may appear if the file system identification is not supported yet.

Error
The Error tag informs you whether there are read errors encountered in the process of RAID autodetection. To see the exact number of encountered errors, hover
mouse over the Error tag to get the tooltip.
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RAID cheat sheet

When RAID Autodetection finds nothing

Follow these tips if the automatic RAID reassembly module doesn't detect a RAID configuration.

If you know the RAID configuration

If you know the exact RAID configuration, skip waiting for Autodetection to complete and manually select the RAID parameters instead.

If you only know the device order

If you know the exact order of the RAID members, select them in the correct sequence: the RAID Autodetection module prioritizes the device order specified
by the user.

If you know the RAID offset (Start LBA)

If you're aware of a specific disk offset for the RAID members, specify the LBA in the Autodetection module's settings (look for the gear icon). This will enable
the Autodetection to identify a suitable RAID configuration in cases where it previously failed.

Synology NAS RAID detection

If you are certain the devices belong to a Synology NAS RAID but the RAID configuration isn’t detected right away and Autodetection is still running, consider
the following possibilities:

One or more selected devices may not be part of this RAID array.

One or more devices could be missing from the array.

To resolve this, stop the Autodetection process and try selecting a different combination of drives that belong to the RAID array.

Multiple configurations found

If the Autodetection module suggests multiple possible RAID configurations, the best match will always appear first.

Additionally, pay attention to the small tags displaying the accuracy percentage next to the RAID partitions — the higher the percentage, the better the match.
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Tricky cases

Parity order in RAID 6

For RAID 6, the 'Parity Order' parameter is only relevant when a device is missing.

Handling RAID 5 / RAID 6 with missing devices

If you know that a device is missing from your RAID 5 or RAID 6, click ‘Add missing device’ to speed up the Autodetection process.

For RAID 6, you can specify up to two missing devices.

Exclude ‘Spare’ devices

RAID members marked with the ‘Spare’ tag most likely contain only zeroes. It's recommended to remove these devices from the list by dragging them to the
bin icon.

RAID configuration not detected

If the Autodetection module is unable to find a valid RAID configuration, try adjusting the parameters manually.

To help you evaluate the validity of the applied configuration, TaskForce displays a small evaluate the validity of next to each partition.

If a file system is not currently supported, an Unknown tag may appear next to the corresponding RAID member.

RAID member s tagged with ‘Error’

If a RAID member is marked with an Error tag:

Image that drive first, then attempt to reassemble the RAID using the acquired image.

For RAID 5 or RAID 6, remove the device with ‘Error’ from the list, then click ‘Add missing device’. TaskForce will use redundancy to rebuild the RAID.

If it’s RAID 10, remove the faulty from the list. TaskForce will automatically use the mirrored copy to rebuild the array.

Imaging RAID takes too long

RAID capacity can exceed dozens of terabytes, making full physical imaging a time-consuming process.

To speed up access to critical data, start with logical imaging using smart filters to extract only the files of interest. Your can perform a full physical imaging
later by clicking the ‘Go to image’ button.

Not enough drive ports for all RAID members



If you’re dealing with a large array and don't have enough drive ports for all RAID members:

1. image some of the drives to image files.
2. Go to RAID > Select source device > Files > Select files and use these image files instead of physical drives.

Using Web API in a browser

Web API is built into TaskForce 2, and it helps optimize your workflow in many ways.

Web API is extremely handy as it allows you to use it in scripts, via CLI tools like curl, and simply by typing commands in the browser address bar.

Here's how to use Web API in a browser:

1. Scan devices plugged to all source ports. The command powers up all ports and returns the list of drive on each port in Source mode as well as the model
and the serial number of the drive on each port.

Devices identification.

2. Start imaging a source drive plugged into TaskForce 2 SATA 4 port.

Start imaging.

3. Track imaging session status using task key received in response to the command above.
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Check task status.

For more information about these and other commands, see API specification that we made available to public.

Instantly starting 16 imaging sessions using Web API

Imagine you have 16 TaskForce SATA and SAS ports switched to Source mode and source drives plugged into them. Now you can instantly launch 16 imaging
sessions simply starting the script.

Python script utilizes /start-image API request and prints task keys of all launched imaging sessions.

import sys

if sys.version_info[0] < 3:
    raise Exception("Please use Python 3 to run this script")

import urllib.request

ports = ["SATA1", "SATA2", "SATA3", "SATA4", "SATA5", "SATA6", "SATA7", "SATA8", 
         "SAS1", "SAS2", "SAS3", "SAS4", "SAS5", "SAS6", "SAS7", "SAS8"]
tasks = []
errors = {}

for port in ports:
    try:
        res = urllib.request.urlopen("http://10.0.0.4/api/start-image?source=%s&targetFolder=//Vitaliy/Share" % (port))
        tasks.append(res.read().decode('utf-8'))
    except urllib.error.HTTPError as e:
        errors[port] = e.read()

print("IDs of started imaging tasks:")
print('\n'.join(tasks))

The script works in any operating system. To run, perform the following actions:

1. Save the script into image16.py file.

2. Replace 10.0.0.4 with IP address of your TaskForce 2.

3. Replace //Vitaliy/Share with your shared network folder path.

4. Execute the script in the console: python image16.py .

For more information about these and other commands, see API specification that we made available to public.

https://atola.com/img/tf/manual/check-task-api-1.jpg
https://atola.com/img/tf/manual/check-task-api-1.jpg
https://atola.com/products/taskforce/api
https://atola.com/products/taskforce/api


Autostart image analysis when imaging is completed

With TaskForce 2, you can track the status of the started imaging sessions using /check-task API request. It reports the imaging progress enabling you (or your
code) to notice when the task gets completed. Once this notification is received, it makes perfect sense to automatically start the forensic analysis of the target
image.

Powershell script below shows how one can create this kind of automation flow:

1. Start imaging a source drive on TaskForce SATA port 4 to the target folder \\Vitaliy\Share.

2. Wait for imaging completion using /check-task.

3. Launch Autopsy Ingest via command-line when the target image is ready.

Important: Instead of Autopsy, you are free to use any Magnet Forensics products, X-Ways Forensics, or any other forensic analysis toolkit that supports
console launch with arguments.

try {
    $r = Invoke-WebRequest "http://10.0.0.65/api/start-image?source=SATA4&targetFolder=\\Vitaliy\Share"
}
catch {
    Write-Output "$($_.Exception.Message)"
    exit $_.Exception.Response.StatusCode
}

$taskKey = $r.Content
do {
    $check = (Invoke-WebRequest "http://10.0.0.65/api/check-task?taskKey=$taskKey").Content | ConvertFrom-Json
    Start-Sleep -s 1
} while ($check.state -eq "progress")

$windowsPath = "C:\Share\" + ($check.target -replace '[\/]', '\' | Split-Path -leaf)
$caseName = "Case123"
$autopsyArguments = '" --createCase --caseName="' + $caseName + ' --caseBaseDir="C:\Work\Cases"' 
                  + ' --addDataSource --dataSourcePath="' + $windowsPath + '" --runIngest --generateReports' 

Start-Process -FilePath "C:\Program Files\Autopsy\bin\autopsy64.exe" -ArgumentList $autopsyArguments

The script works in Windows with Powershell. To run it, please perform the following actions:

1. Install Autopsy.

2. Create C:\Share folder.

3. Save the script into image.ps1 file.

4. Replace 10.0.0.65 with IP address of your TaskForce 2.

5. Replace \\Vitaliy\Share with your shared network folder path.

6. Execute the script in the console: powershell -ExecutionPolicy ByPass -File image.ps1 .

Autopsy Ingest v4.11 does not work with network file paths from the command line. That’s why this example shows a shared folder located at PC where
PowerShell script is executed. Therefore \\Vitaliy\Share points to C:\Share folder.

For more information about these and other commands, see API specification that we made available to public.
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Multi-launch of single-device operations

To wipe a bunch of target drives for subsequent imaging sessions or verify hash values on multiple drives in your archive, use multi-launch functionality in
TaskForce 2.

The function is currently supported for single-drive tasks: Wiping, Diagnostics, Hashing.

To wipe multiple drives:

1. On the left, click Wipe.

2. On the Select target devices panel, enable Multi-launch and select the drives.

The Multi-launch option.

3. On the wiping settings page, adjust the sessions parameters. They will be applied to all the currently selected drives. If you wish to double-check the list of
selected devices, click the top panel with the number of selected drives. The drop-down provides info about the drives, their health status and case ID.
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The Settings page.

4. Click Start.
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Multiple sessions initiated via multi-launch.

When the Check if device contains data option is enabled, TaskForce 2 scans all selected devices. If any data may be overwritten, the imager will warn you.

The procedure is the same for other single-drive processes. When hashing, multi-launch can be applied to both the devices plugged into the system and the locally
stored image files.

The case management system automatically saves separate reports into the individual cases.

Wiping 26 drives simultaneously

With TaskForce 2, Atola introduced the fastest and most capable imaging engine to the forensic market. While the cumulative imaging speed in TaskForce 2
constitutes 25 TB/h, the engine can wipe up to 26 drives connected to it and achieve an overall performance of up to 100 TB/h.
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Multiple drives connected to Atola TaskForce 2

TaskForce’s task-oriented and efficient user interface is designed to enable the launch of every operation in just a couple of clicks and expedite work with multiple
evidence drives.

TaskForce 2 has 26 ports:

4 NVMe M.2/U.2 PCIe 4.0,
8 SATA,
8 SAS/SATA,
4 USB,
1 IDE,
1 Extension slot for Atola Thunderbolt, Apple PCIe SSD and M.2 NVMe/PCIe/SATA SSD extension modules,

Each port can be used for simultaneous wiping sessions.

TaskForce 2 can wipe 26 devices simultaneously at their top native speeds using the standard wiping method.
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Launch multiple wiping sessions
To perform multiple wiping sessions:

1. Connect the drives to TaskForce.

2. Switch the ports, to which the drives are connected, to Target mode by using the individual Source switches on each port.

3. In the TaskForce user interface, click the Wipe icon on the left.

4. On the Select target device panel, select a drive.
To launch the wiping process for multiple drives simultaneously, tick the Multi-launch box at the top right, and select the drives you want to wipe.
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5. Adjust wiping settings:
the range of sectors to be wiped
wiping method
enter a pattern and select its format (HEX/ASCII)

6. Click Start.

https://atola.com/img/tf2/manual/1wiping-process-multi-launch.png
https://atola.com/img/tf2/manual/1wiping-process-multi-launch.png


Wiping is consecutively launched for each device.

Track the wiping progress
Once the operations have started, track the progress of all tasks on the Home screen. It displays the percentage of wiped drive area and the time left until the end
of the planned session. To see more details on the progress of an individual wiping session, click on that session.

To reveal the current overall wiping speed, click the Atola logo in the center of the top bar. In this case, we were able to achieve 18 TB/h. This high-speed wiping
capability allows a forensic expert to prepare target drives for imaging in minimal time.
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A wiping session can take longer if a different wiping method is selected. E.g. the NIST 800-88 method implies not only wiping but also rereading of the
wiped range. The DoD 5220.22-M method wipes the same range three times.

To ensure maximum transparency and effectiveness, TaskForce 2 documents every operation by creating detailed reports and logs. Click Reports at the top and find
the report in the list or use the Search bar at the top of the page.

https://atola.com/img/tf2/manual/3taskforce-wipingspeed.png
https://atola.com/img/tf2/manual/3taskforce-wipingspeed.png


How TaskForce verifies that wiping is successful
To verify that wiping is successful, TaskForce applies the following algorithm:

1. One hundred sectors, evenly spaced across the wiping range, are filled with the verification ASCII pattern 'AtolaTechnology'.

2. The whole drive or a selected range of sectors on it is wiped by applying the method selected by the user ('Fill sectors with the following pattern' by default).

3. Finally, TaskForce reads the hundred sectors that were filled during the first step and makes sure that none of them contains the pattern 'AtolaTechnology'.

Unclip or change HPA, DCO, AMA limitations

DCO (device configuration overlay), HPA (host protected area), or AMA (accessible max address) features were created by hard drive manufacturers as hidden areas
reserved for storing vendor utilities or simply to make a drive appear to have a certain number of sectors (smaller than the actual drive capacity).

But it is many years ago that end users learned to modify and write to these areas of hard drives with the help of open source and freely available tools. For digital
forensics specialists, it means that without the ability to identify such hidden areas of a drive and image the full physical image including data in these areas, the
evidence they get may be incomplete and lead to inaccurate investigative conclusions.

Atola TaskForce 2 helps you detect, unclip, or change HPA, DCO, AMA limitations.

Detect DCO, HPA, or AMA limitations
When you connect a hard drive to the TaskForce 2 unit, in addition to the standard Identify device command, TaskForce software automatically sends two
commands to look up the drive size as set in drive’s firmware: Read native max address and Device configuration identify. If drive size has been limited by DCO, HPA,
or AMA, TaskForce 2 will draw your attention to these changes by adding the note in red color in the device menu.
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Notification about HPA, DCO, and AMA in device menu.

To get more details about the modifications that have been made to the drive’s firmware, run Diagnose and see the Firmware section of the Diagnostics report.
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AMA limitation is indicated in the Diagnostics summary.

There you will see three lines indicating the drive’s Max Address according to different records in the drive’s firmware:

1. The Max Address according to device ID line shows the max address from the ID sector, affected by DCO and HPA/AMA restrictions if those are applied.

2. Native Max Address indicates max address ignoring HPA/AMA limitation that may have been enabled, yet affected by DCO restriction.

3. Max Address from DCO is the line that gives you the actual drive size.

A Diagnostics report of a drive that does not have HPA/AMA or DCO activated will have the same value in all three lines.
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HPA and DCO restriction details in the Firmware section of the Diagnostics report.

Unclip HPA, DCO, AMA limitations
To disable HPA, DCO, AMA limitations that have been applied to the drive’s firmware:

1. On the left, click Other and then Hidden drive areas.

2. Select device.

3. Click Unclip.

The drive needs to be in the Target mode (use the Source/Target switch on the unit to perform this operation), as Unclip HPA, DCO, AMA limitations
implies making changes to the drive's firmware, and that is not possible when the drive is in the Source mode.
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Remove HPA and DCO by clicking the Unclip button.

TaskForce 2 lifts HPA/AMA and DCO restrictions in a matter of seconds and enables access to all data on the drive.
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HPA and DCO unclip report.

Unclip HPA temporarily (until power cycle)
To ensure the forensically sound process, it can be necessary to avoid making any changes to the drive. Therefore it is prohibited to disable HPA and DCO
restrictions and access data in the hidden areas. With TaskForce 2 it is possible to lift HPA restriction until the next power cycle. This helps avoid permanent changes
to the drive.

To unclip HPA on the source drive until power cycle before imaging:

1. Go to Image.

2. Select source device.

3. Select target devices and click Continue.

4. In Confirmation dialog, suggesting you unclip the drive until power cycle, click Yes.

This will allow temporary access to the data in HPA-protected area, but as soon as you power off or unplug the drive, the HPA will be back again.

After you confirm unclipping HPA until power cycle, the imaging process starts and the following message appears in the imaging log: Source device HPA was set to
native max address until power cycle.
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The message in the imaging log informs that source device HPA was set to native max address until power cycle.

If a drive freezes in the course of imaging TaskForce forcibly performs power cycles to continue imaging the drive. However, such power cycles will not affect
the temporarily disabled HPA. TaskForce will be temporarily removing HPA max address restriction after each power cycle performed during imaging. The
HPA-protected area will remain accessible throughout the imaging process.

Set or change HPA, DCO, AMA limitations
Not all drives support hidden areas. Limitation type supported by the particular drive will be shown in green on the Hidden drive areas page.
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The drive supports DCO and HPA limitations, but does not support AMA.

The DCO and HPA can co-exist on the same drive: max address limited via HPA should be less than DCO.

Expectedly, AMA is supported by new drives and can't exist if DCO or HPA is supported, and vice versa.

If your target device is larger than your source device, but you need hash values for the source and for the target devices to be identical, see Clip target drive to
source evidence size.

To set or change DCO limitation:

1. Make sure that the drive is in the Target mode.

2. On the left, click Other and then Hidden drive areas.

3. Select device.

4. Enter new Native max address. Notice that ID sector max address changes accordingly.

5. Click Change.
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Setting new DCO limitation.

To set or change HPA limitation:

1. Make sure that the drive is in the Target mode.

2. On the left, click Other and then Hidden drive areas.

3. Select device.

4. Enter new ID sector max address.

5. Optional: Check Change ID sector max address temporarily (until power cycle) if needed.

6. Click Change.
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Setting new HPA limitation.

To set or change AMA limitation:

1. Make sure that the drive is in the Target mode.

2. On the left, click Other and then Hidden drive areas.

3. Select device.

4. Enter new ID sector max address.

5. Click Change.

https://atola.com/img/tf/manual/hpa-dco-8.jpg
https://atola.com/img/tf/manual/hpa-dco-8.jpg


Setting new AMA limitation.

Calculating hash during imaging

Atola TaskForce 2 supports hash calculation of both the evidence drive and the image in conjunction with imaging. We have developed highly flexible functionality
to help optimize evidence acquisition process to fit one’s internal procedures, while avoiding further damage to fragile media.

To calculate hash of both the evidence and the image:

1. On the left, click Image.

2. Select the source and target device.

3. On the imaging Settings page, click Change.

4. On the Hashes tab, toggle one or several options how you want to calculate hash:
Pre-hash source device
Hash source during imaging
Post-hash target device
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Selecting hash methods.

Pre-hash source drive option must be used with caution: although pre-hashing can be required by an investigator’s internal procedures, when dealing with drives
that have been diagnosed with hardware failure, this operation may cause further damage to the drive before essential data is imaged.

Hash source during imaging is the most appropriate way to calculate the hash of a fragile source evidence drive. In this case, TaskForce 2 only needs to read the
data on the drive once to both image and calculate the hash, thus minimally using the drive’s hardware.

Linear hash can only be calculated by reading data in sectors consecutively in one pass. When it encounters a bad sector, linear hash calulation is
discontinued. For bad drives we recommend using Segmented hashing.

Post-hash target device option lets you to properly record the calculated hash in the case.

https://atola.com/img/tf/manual/hashing-1.jpg
https://atola.com/img/tf/manual/hashing-1.jpg


Imaging results with hash values for both hash during imaging and post-hash.

Calculating dual hash of an existing E01 file

Some source evidence drives and their images can be involved in a long-running investigation case and wait to be presented in court for months or years on end.
Data stored on such drives and their image files may eventually get corrupt. Therefore it may be critical for an investigator to ensure the integrity of data on such
devices or image files before resuming to work with them or presenting them in court.

Over the years, E01 file format has become a popular format for forensic purposes due to its ability to store not both the image of the drive, but also case and
evidence details. E01 file can also contain both MD5 and SHA-1 hash values.

View the previously calculated hash
To view the previously calculated hash calculated for an E01 file with Atola TaskForce, open the imaging report in the case management system. It contains the hash
values calculated during imaging.
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Alternatively, you can look up the metadata stored in the E01 file itself:

1. At the top, click Devices.

2. Expand the File category and click Select file.

3. Select the E01 file in the file browser.

Hash calculated during imaging stored in E01 file's metadata.

Recalculate the hash for an E01 file
To ensure the integrity of the data in the file, you can recalculate its hash.
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1. On the left, click Other, and then Hash.

2. To choose the file for which you want to calculate hash, expand the File category and click Select file.

3. Select the E01 file in the file browser.

4. Adjust hashing settings. Make sure to select the same hashing types (MD5, SHA1, etc.)

5. Click Start.

Starting hash calculation.

When the hash calculation is completed, you can make sure that the two sets of hashes are identical.
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Comparing the calculated hash values to the ones calculated during imaging.

Segmented hashing for data verification

Segmented hashing allows verifying data, imaged from damaged media. The image can be verified even if data gets corrupt over time.

Segmented hashing produces a CSV file in the following format:
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Segmented hashing vs regular hashing
With conventional hashing method you get a single hash for the entire image, while segmented hashing allows getting many hashes of corresponding LBA ranges
of the image. The sum LBA ranges represents the entire image.

Verifying all hashes in a set allows you to prove that the entire image has not been modified.

Segmented hashing and post-hashing of the target for immediate image verification
1. Go to the imaging Settings.

2. On the Hashes tab, select Segmented hashing method.

3. To obtain both sets of hashes for the evidence drive and the image, toggle Post-hash target devices.
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Selecting hashing method.

Hashing while imaging does not slow down the imaging session:
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TaskForce 2 imaging session.

Post-hashing will commence as soon as the imaging session is completed:
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Atola TaskForce 2: Post-hashing.

In the Imaging completed report you can see imaging results with the link to the file with segmented hashes.

In case you select the post-hashing of the target, you also get the results of cross-checking between the hash sets of the evidence drive and the image.
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Atola forensic imager: Imaging results

Verify damaged images with segmented hashing

Segmented hashing is a non-linear hashing method that allows hashing damaged drives. Hashes are calculated only for the good areas of evidence media, while
bad areas, that are impossible to read and image, are left out of the calculation.

In Atola TaskForce 2, the segmented hashing module produces a list of hashes of corresponding LBA ranges of the image. Then hashes are saved into a CSV file in
the following format: Hash, start LBA, end LBA.

The sum of the LBA ranges represents the entire image. By verifying all hashes in a set you can prove that the entire image has not been modified.
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Benefits of segmented hashing
With the conventional linear hashing method you get a single hash for the entire image. As the linear hashing stops upon encountering the first bad sector, it is
impossible to calculate hash for the entire space of the source evidence drive.

With segmented hashing, hashing can be performed during the multipass imaging of a damaged drive. Hashes are calculated only for the successfully imaged
areas, while all bad sectors are excluded from the calculation.

If an acquired evidence image is damaged at some point in the future, with the regular linear hashes you will get a hash mismatch upon verification, and the entire
image becomes useless. With segmented hashes only the hash of the damaged segment will become invalid.

Calculate segmented hashes of a source and target devices
To calculate segmented hashes of a damaged drive during imaging and post-hash the target for immediate image verification, do the following:
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1. Go to the imaging Settings.

2. On the Hashes tab, select Segmented hashing method and specify Segment size.

3. To obtain both sets of hashes for the evidence drive and the image, toggle Post-hash target devices.

Selecting hashing method.

Hashing while imaging does not slow down the imaging session:
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TaskForce 2 imaging session.

Post-hashing commences as soon as the imaging session is completed:
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Atola TaskForce 2: Post-hashing.

In the Imaging completed report, you can see imaging results with the link to the file with segmented hashes.

In case you select the post-hashing of the target, you also get the results of cross-checking between the hash sets of the evidence drive and the image.
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Atola TaskForce 2: Imaging results.

Verify an image of a drive with segmented hashing
To verify an acquired image file of an evidence drive with segmented hashing, do the following:

1. In the TaskForce window, go to Other > Verify segmented hashes.
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The Verify segmented hashed command on the Other page.

2. The Select device panel opens. Expand the File section and click Select file.
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The Select device panel.

3. Select an image file you want to verify. The E01, AFF4 and Raw formats are supported.
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Selecting an image file to verify segmented hashes.

4. Select the CSV file with segmented hashes that relates to your image file:

a. Choose either Local folder or Network folder or Storage.

b. Click Select.

c. Find and select a CSV file with segmented hashes.

5. Click Start.
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Selecting a CSV file with a list of segmented hashes.

6. TaskForce 2 starts the data verification process.
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The process of verifying segmented hashes.

7. If TaskForce encounters a hash value mismatch, it is reflected in the Hash mismatches counter and in the event log, with Start and End LBA of the respective
segment.
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Hashes of one of the segments do not match.

8. Once verification of segmented hashes is completed, TaskForce 2 generates a detailed report about its results. The report contains information about the
verified image and the file with its segmented hashes, hash type, number of processed hashes and found mismatches if any.
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The report about completed verification of segmented hashes.

Case management system and report types

TaskForce's case management system records every step of the data acquisition process: every operation is automatically added to the case from the moment a
device is identified including date, time, imaging map and hash values. When a hard drive is imaged, its imaging map is recorded detailing all the sectors that have
been skipped.

Whenever an operator connects a hard drive to the TaskForce 2, the system makes an automatic database lookup and retrieves all past records associated with that
particular hard drive. New entries will be added seamlessly to the database. You do not need to enable case management or take any additional actions for it to
start functioning; it is fully embedded into TaskForce 2 and works at all times.

Case number can be assigned and changed at any time. The system also allows browsing through all cases and reports, without corresponding devices being
connected to the unit.

Report types and formats
There are two types of reports in TaskForce 2:

1. Device reports are created every time an action is taken to the drive: drive identification, imaging, hashing, wiping and other operations related to the drive
are documented in these reports.

2. Non-device reports are created to register any changes made to the cases: case opening, case details change, case import and export.

All reports have these key elements: a header that provides device and case details, an action summary and task details (task settings, task log, etc.).
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Imaging report in Atola TaskForce 2.

A diagnostics report contains even more details: it lists the checkup results for all subsystems of a drive and includes oscillograms, SMART table, etc.

https://atola.com/img/tf/manual/atolataskforce-imaging-results_2.jpg
https://atola.com/img/tf/manual/atolataskforce-imaging-results_2.jpg


https://atola.com/img/tf/manual/diagnose-6.jpg
https://atola.com/img/tf/manual/diagnose-6.jpg


Diagnostics report in Atola TaskForce 2.

Add a case

When you identify a device in Atola TaskForce 2 for the first time, the system automatically creates a new case for that device and records every single operation
performed with the device or with the case itself. To know more about how it works, see Case management system and report types.

Until you specify case details, Case ID shows in the TaskForce interface as Not assigned.

To distinguish and search your cases by a case number, investigator’s name, and case description, you can add a case and enter these case details. Also, you can set
TaskForce 2 to remind you to enter case details before starting any task.
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There are several ways to create a new case in TaskForce 2:

From the Devices menu.
From the Cases page.
From the Device page.

Add a case from the Devices menu
1. Connect a device to TaskForce 2.

2. In the TaskForce main window, click Devices.

3. In the Select device panel, in the port with your device, click More icon, and then select Add case.

Adding a device to a new case from the Devices menu.

4. Enter case details and click Continue. TaskForce 2 creates a new case and adds your device to it. The Case created report appears on the Home screen and
on the Reports page.

https://atola.com/img/tf2/manual/taskforce-select-device-add-case.png
https://atola.com/img/tf2/manual/taskforce-select-device-add-case.png


The Case created report on the Home screen.
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Case created report details.

Add a case from the Cases page
1. Connect a device to TaskForce 2.

2. In the TaskForce main window, click Cases.

3. On the Cases page, click Add case.

4. In the Select device panel, click on your device.

5. Enter case details and click Continue. TaskForce 2 creates a new case and adds your device to it. The Case created report appears on the Home screen and
on the Reports page.
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The Enter case details dialog.

Add a case from the Device page
1. Connect a device to TaskForce 2.

2. In the TaskForce main window, click Devices.

3. In the Select device panel, click on the port with your device. TaskForce 2 takes you to the Device page.

4. Optional: If TaskForce 2 hasn’t identified your device yet, then, on the Device page, click Re-identify.

5. In Case ID pane, open the drop-down menu, and then click New.

https://atola.com/img/tf/manual/taskforce-cases-enter-case-details.png
https://atola.com/img/tf/manual/taskforce-cases-enter-case-details.png


Change active case menu is opened on the Device page.

6. Enter case details and click Continue. TaskForce 2 creates a new case and adds your device to it. The Case created report appears on the Home screen and
on the Reports page.

Enter case details before starting any task
Entering case details before performing any operation with a device helps you to keep your cases organized and searchable. TaskForce 2 can be set to request that
you enter case details before starting any task.

To enable this feature, do the following:

1. In the TaskForce main window, go to the Menu > Settings.

2. In the Cases section, toggle Set case details before task start.

Now, TaskForce 2 will ask you to enter case details before performing any operation with a device.
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The Set case details before task start toggle on the Settings page.
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Atola TaskForce 2 asks a user to enter case details before starting diagnostics.

Set default values for all cases
If Investigator, Organization, or Location are the same for all or majority of your cases, set them as default for all new cases, and TaskForce will fill those fields
automatically every time you create a new case:

1. At the top right, go to Menu > Settings.

2. On the Settings page, scroll down to the Cases section.

3. Toggle on Set default values for all cases.

https://atola.com/img/tf/manual/taskforce-enter-case-details-dialog.png
https://atola.com/img/tf/manual/taskforce-enter-case-details-dialog.png


The 'Set default values for all cases' toggle on the Settings page.

4. Next to the toggle, click Change.

5. Fill in the default values for Investigator, Organization, or Location and click Save.
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The 'Set default values' dialog.

Show 'Add case' button
You can add cases right from the TaskForce Home screen before working with the device. To do that, set TaskForce 2 to show Add case button in the top panel:

1. In the TaskForce main window, go to the Menu > Settings.

2. In the Cases section, toggle Show 'Add case' button on TaskForce top panel.

Now, TaskForce 2 shows the Add case button in the top panel.
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The toggle in the Cases section on the Settings page.
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The Add case button in the Atola TaskForce 2 main window.

Add one device to several cases

In Atola TaskForce, you can include the same device in several new or existing cases using the Case management system. When a device is added to more than one
case, TaskForce keeps the tasks and reports, which are associated with each case, separate.

Add a device to another new case
To add your device to several new cases, do the following:

1. Connect a device to TaskForce and identify it.

2. Add first new case and include your device to it. For guidance, see Add a case.

After you have added your device to the first case, do the following steps:

3. In the TaskForce user interface, click Devices.

4. In the Select device window, click on the port with your device. TaskForce takes you to the Device page.

5. In Case ID pane, open the drop-down menu, and then click New.
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The New button in the Change active case menu on the Device page.

6. Enter case details and click Continue.

TaskForce creates another new case and adds your device to it. The Case created report appears on the Home screen and on the Reports page.

Add a device to another existing case
When you already added your device to one case and want to add that device to another existing case, do the following:

1. Connect a device to TaskForce.

2. In the TaskForce user interface, click Devices.

3. In the Select device window, click on the port with your device. TaskForce takes you to the Device page.

4. Optional: If TaskForce hasn’t identified your device yet, then, on the Device page, click Re-identify.

5. In Case ID pane, open the drop-down menu, and then click Select.
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The Select button in the Change active case drop-down menu on the Device page.

6. In the Select active case window, chose your existing case. If needed, use the Search field to find it. TaskForce adds your device to the selected case.
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List of all your cases in the Select active case window.

Switch between cases on the Device page
When a device is added to more than one case, TaskForce keeps reports, which are associated with each case, separate.

To switch between cases on the Device page:

1. In Case ID pane, open the drop-down menu.

2. Click on the case you want to make active. TaskForce shows reports, associated with selected case.
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List of all cases associated with the device in the Case ID pane.

Add several devices to one case

In Atola TaskForce 2, you can have a forensic case that contains more than one device. TaskForce 2 lets you add several devices either to a new or an existing
forensic case.

To add several devices to a new case, you need to create a case first. For guidance, see Add a case.

To add another device to an existing case, do the following:

1. Connect a device to TaskForce 2.

2. In the TaskForce user interface, click Devices.

3. In the Select device window, click on the port with your device. TaskForce takes you to the Device page.

4. Optional: If TaskForce hasn’t identified your device yet, then, on the Device page, click Re-identify.

5. In Case ID pane, open the drop-down menu, and then click Select.
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Change active case menu is opened on the Device page.

6. In the Select active case window, choose your existing case. If needed, use the Search field to find it.
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List of all your cases in the Select active case window.

Now, when you open your case, the Case details page lists all devices associated with the case. The Case details page also contains active tasks and reports for
each device included in the case.
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All devices, active tasks, and reports associated with the case.

Find and edit cases

Atola TaskForce 2 automatically creates reports for every single action applied to each drive connected to it. Whether it is a source drive or a target drive, any
action, be it imaging, wiping or physically switching write protection on or off, will be documented and stored in the system.

To find a case, click Cases in the top left corner, it will redirect you to the case management system.
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Opening case management system.

Search for a specific case or device in the Search bar (by case ID, investigator's name or device details) and sort results by any column.
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Searching and sorting cases in the list.

To open a case, click the respective line in the list.

A case page contains case details, information about the devices associated with the case (name, serial number, capacity etc.), as well as reports for all tasks applied
to the device.

Edit case details
To change case details, click Edit at the top of a case page.
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Case page

It is possible to change the case ID, Description and Investigator. Click Save when done editing.
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Changing case details.

Finding reports

Atola TaskForce 2 automatically creates reports for every single action applied to each drive connected to it. The system also allows browsing through all cases and
reports, without corresponding devices being connected to the unit. The reports are listed and can be easily retrieved in different parts of TaskForce 2 software.

1. Via case page
All reports related to the case are listed at the bottom of the case page. Scroll down and turn pages to view all the reports, sort them by date or by title, use the
search bar to look for specific reports by their titles.

To open a report, click the respective line.
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Case page with reports.

2. Via Reports page
If you need to search among all existing reports, click Reports at the top.
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The Reports button.

This will redirect you to the page with all existing report that can be filtered by date, title, case ID or device details. Search for a specific report by entering report
title or drive details.

Open the report you need by clicking it in the list.
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The Reports page.

3. Via Home screen
Similarly, recent reports can also be found on the Home screen underneath the Active tasks.

On the Home screen you can look up active and completed tasks and view reports for all completed tasks.

Quickly find specific reports by entering filters in the search field.
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Finding reports on the Home screen.

Printing reports from a case

When you work on an investigation and want to have complete information about the evidence drive and all operations that have been taken to diagnose, image,
calculate hash, etc., you can address Atola TaskForce’s case management system to print out all reports concerning your evidence.

To do that:

1. At the bottom of the case page, click Print.
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The Print button an the bottom on the case page.

2. Optional: If you want the printed reports to include logs, go to the the Menu > Settings, scroll down to the Print settings section and toggle Logs.
 

Logs are parts of the reports that give detailed information about the start and the end of a task, problems encountered during the operation (for
example, inability to read a sector within the time allocated for the operation), actions taken (for example, jumps from a bad sector, completed pass
of imaging, performed resets and power cycles etc.)

3. Optional: If you want the printed reports to include the description of all storage devices contained in current TaskForce system, go to the the Menu >
Settings, scroll down to the Print settings section and toggle Information about unit's components.
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The Logs toggle in the Print settings section.

4. After you click Print on the case page, TaskForce takes you to a page with full reports. There they are arranged in same the order, in which they were listed
on the case page (either by date or by title).
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Generated reports.

If you selected the Information about unit's components, the last report generated will include the description of all storage devices contained in
current TaskForce system.
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Generated report listing all storage devices contained in current TaskForce unit.

On this page, there is another Print button. After clicking it you can configure printing settings.

Each report will be printed on a new page.

FAQ and Troubleshooting

Imaging►

RAID configuration autodetection & imaging►

Performance►

Connectivity►

Wiping►

Case management & reports►

Subscription►

https://atola.com/img/tf/manual/print-reports-from-case-4.jpg
https://atola.com/img/tf/manual/print-reports-from-case-4.jpg


Imaging

How do I clone a drive and create multiple
identical copies?

TaskForce 2 is perfectly suited for cloning! Here is how to clone into 4 SATA
drives and 1 RAW file simultaneously.

When you need to create multiple copies, simply:

1. Go to Image.

2. Select a source device.

3. Select up to 5 targets (SATA, USB, SAS or RAW, E01 files) and click
Continue.

4. Click Start.

What's more, TaskForce 2 has 26 ports in total including IDE and Extension
ports in combination with huge overhead capacity to handle many imaging
sessions or other operations concurrently. So if you start a 1-to-5 cloning,
you still have at least 20 ports left for additional cloning/imaging sessions to
run simultaneously. TaskForce is designed to minimize the imaging time.

How do I image to an E01 or a RAW file?

When selecting targets in the slide-out panel, click the Select file tile. It only
works if TaskForce 2 is connected to a network and with an accessible
network folder.

How can I create an E01 image?

To image a source evidence drive to an E01 file, you have to create a new
target file:

1. Go to Image.

2. Select the source evidence drive.

3. On the Select target devices panel, switch to the Files tab and click
Create file.

4. In the file selector, find the folder to store the image and click Create
file.

5. In the Create image file dialog, select the E01 file type.

6. Fill in the E01 file information, and then click Create.

7. On the Select target devices panel, click Continue.

Is there a way to delete an imaging session and
start imaging all over again?

When you select source and target drives previously used in an imaging
session, TaskForce 2 will indicate the progress status of the previous session,
and you will be allowed to resume it.

To start a new imaging session with the same source and target, you will
need to delete the previous one:

1. Go to Image.

2. Select the source drive.

How do I set up an automated launch of
AXIOM after imaging?

You cannot launch third-party software from TaskForce 2 itself. However,
with Magnet AUTOMATE, TaskForce can be integrated into a workflow with
Magnet AXIOM. The Atola team closely cooperates with Magnet's
developers to support and enhance this integration. See how it works.

Another option is a folder monitor/watchdog. Use an app that tracks when a
new image file appears in a specific folder. After that, such an app can
launch Magnet AXIOM against the newly created image. There are many
watchdog tools on the web.

Why does a healthy drive appear to have many
bad sectors during imaging?

The issue is likely caused by a loose port connection, leading to read errors
and even drive identification issues.

To completely reset the physical link, unplug the cable from both the port
and the storage device, wait for a full minute and plug it snugly back in.

It could also be cable wear-out. Swap cables between the "working" and
"non-working" ports and see how it goes. If certain cables repeatedly cause
issues, put them aside.

Why does TaskForce not open the 'Imaging
Settings' page when I click 'Continue' upon
selecting targets?

The issue must have been caused by the browser cache.

1. Go to Chrome browser settings.

2. Open the Clear browsing data option.

3. Clear all the data after selecting the All time range.

Please note that TaskForce works properly only with the Chrome browser.

How do I increase the speed when I image to
the network?

When imaging to the network, there are two potential bottlenecks:

1. Network performance

It can be enhanced with a 10Gb connection. Another important thing:
Jumbo frames should be enabled in the TaskForce settings, on the target
computer/NAS network card, and on all network switches/routers in
between.

2. Write speed of the target network drive

It can be more difficult to improve, especially if you are imaging several
drives to the same network location. This leads to a situation where 8 source
SSDs are read at 500 MB/s speed, but the total writing capability of the
target network drive limits the speed to just 400 MB/s. Distributed between
8 sessions, the speed becomes too low (400/8=50 MB/s per session).
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RAID configuration autodetection & imaging

3. On the Select target devices panel, select the target and click
Continue.

4. Right-click the imaging session.

5. In the context menu, click Allow imaging map deletion. A Trash icon
appears in each imaging progress status tile.

6. To delete the previous imaging session, click the Trash icon. Now you
can start a new session to the same target.

To disable imaging map deletion, click the imaging session again and select
the option in the context menu.

Why does imaging to a NAS end up with a
write error?

Possible causes and solutions:

Maximum file size limitation by the proprietary NAS file system or
OS.

Minimum free space limitation in the NAS setting.

Network folder permissions.

Replace the Ethernet cable. Use Cat6 (with a length of less than 55
meters), Cat6a, Cat7, Cat7a, or Cat8 marking on it.

How do I restore a 520-byte sector-sized image
to a drive?

TaskForce performs imaging and restores images in sector-to-sector mode.
In the process, TaskForce does not convert logical data alignment
depending on sector size, which keeps things simple and explicable.

If you have an image of a drive with a sector size of 520 bytes and you want
to restore it to another drive, you must use a target SAS drive with a sector
size of 520 bytes.

If the SAS drive's sector size is other than 520, you can reformat it in Linux
using the sg_format utility: https://linux.die.net/man/8/sg_format

Then perform imaging to the target SAS drive by selecting the image file as
a source.

The best solutions to achieve top speeds with target network locations:

A RAID consisting of SSDs.

A NAS combined with a 10Gb switch. For example, Ubiquiti
EdgeSwitch 16 XG.

A network server with many drives and great writing performance.

What is Storage mode?

TaskForce treats a target drive as a destination for sector-to-sector imaging
unless you set it to Storage mode.

When the target drive is in Storage mode, it can only be used as a container
for image files (E01, AFF4, or Raw). The software protects you from
accidentally using a Storage drive for sector-to-sector imaging.

Storage mode features:

You must format a target drive into Storage mode using TaskForce
beforehand.

When formatting in Storage mode, TaskForce creates a single exFAT
partition with a large cluster size for the best imaging performance.

TaskForce will automatically mount the target device formatted as a
Storage when you plug it into TaskForce the next time.

It's safe and works simpler than it seems. Format once and use it
many times.

On top of that, you can select a VeraCrypt container instead of a simple
exFAT partition to store image files in an encrypted form.

How can I image a SCSI drive?

Take advantage of USB ports and SCSI-to-USB adapters. There are a number
of these on the market:

Microtech XpressSCSI USB to SCSI adapter
Belkin USB to SCSI Adapter
Shuttle eUSCSI Bridge
Castlewood ORB SCSI to USB adapter

Can TaskForce 2 identify a RAID’s configuration
if I include drives that are not RAID members
(the drives are not marked properly)?

Normally, TaskForce 2 can identify the type of an unknown RAID within a
minute. TaskForce reads data from the initial 3 million sectors of each drive
and searches for the correct relation between the RAID members.

With an odd drive, the module will need more time to identify the
configuration.

In the case of RAID 1 or 10, detected mirrors will be arranged into
groups, the odd drive will be placed separately, and partitions will be
mounted successfully.

Can I select E01 images of drives for RAID
reassembly?

You can select any combination of image files and/or drives constituting a
RAID. See examples:

3 drives + 2 AFF4 files

5 E01 image files

2 raw files + 1 missing member

https://linux.die.net/man/8/sg_format
https://atola.com/products/taskforce/manual/network-setup.html#C2
https://atola.com/products/taskforce/manual/network-setup.html#C2


Performance

If it is a JBOD, the partitions will likely be identified, and the order of
the drives will be correct, with the odd drive placed at the end.

As for RAID 0 or 5, TaskForce won't reassemble such an array: data
from the odd drive is taken into account when TaskForce combines
data from all members.

NB: The autodetection module attempts to identify the configuration from
scratch each time you remove or add a drive. Try removing a drive that
seems odd. Normally, RAID members are drives of the same capacity and
usually of the same type, made by the same manufacturer, etc.

How do I manually reassemble a RAID knowing
configuration parameters?

If you are sure you know all the RAID parameters, you can rebuild the RAID
manually, ignoring the autodetection process.

This is the only way to rebuild and image a RAID array when the TaskForce
RAID module does not recognize partitions because they are either
encrypted or unsupported (for example, ReiserFS).

To rebuild a RAID manually, follow the steps below:

1. Select all RAID members (drives or their images).

2. Specify the following settings manually from the drop-down menus:

a. RAID type (or RAID level)

b. Start LBA (it is an offset for all RAID members)

c. Block size

d. Block order (only for RAID 5 and RAID 6)

e. Device order (use the two-line button to drag and drop)

3. Click the Go to Image button.

Can I image a RAID array that contains a
damaged drive?

The RAID assembly module requires good, readable drives to find a
configuration. When one of the RAID's drives is damaged, it's best to image
the drive first and attempt the reassembly using the image.

However, if the configuration is known and no search is required, you can
try to mount the RAID even with a malfunctioning device. In this case,
specify the configuration manually and proceed with imaging. TaskForce's
multipass imaging engine handles RAID arrays with such issues effectively.

If you are dealing with a RAID 5, RAID 6, or RAID 1, TaskForce will use the
RAID's redundancy when encountering internal read errors.

When one of the drives in a RAID 5 array is seriously damaged, you can add
a virtual Missing device instead of the damaged device. Next, it is possible
to reassemble and image the RAID 5 array from the remaining healthy
drives and 1 "stub" device. TaskForce reconstructs data from such arrays on
the fly during imaging.

Write error at the 16TB threshold occurs when
imaging an assembled RAID. What should I do?

Check the file system of your target folder for maximum file limits. For
example, these file systems are limited to the 16TB threshold:

ext4
NTFS
Btrfs in some Synology NAS

To handle larger files in NTFS, you can reformat an NTFS partition to use a
larger cluster size. By increasing the cluster size to 64 kilobytes (KB), you can
create files up to 256 TB size-wise.

How to reach 25 TB/h?

TaskForce 2 was designed as an ultimate multitasking tool with a huge
overhead capacity. Given that most imaged devices are HDDs, whose data
transfer rate is 200 - 220 MB/s at best, it is not frequently that TaskForce will
reach the limits of its capacity.

Our QA team achieves a speed of 25 TB/hour with this specific setup:

imaging 8 SAS ports to 8 SATA ports (all SSD drives)
imaging 2 NVMe ports to 2 NVMe ports
imaging 1 USB ports to 1 USB ports (all SSD drives)
imaging 2 USB ports to network files (10Gb connection)
imaging the IDE port (with an IDE drive attached) to a network file
(10Gb connection)

Instead of cloning, target drives can be formatted as Storage for
E01/AFF4/RAW image files.

In most cases, you deal with HDDs as source devices, and they are half as
fast as SSDs, which creates a bottleneck.

Performance when imaging to a remote USB
drive (write cache + exFAT)

There are two ways to boost imaging performance:

1. Format the target drive to exFAT. It works faster than NTFS.

2. Enable Windows write cache:

a. Go to Device Manager.

b. In the Disk Drives category, select your drive.

c. On the Policies tab, switch to Better performance.

d. Confirm the reboot of the PC.

Important: When the last imaging session completes, use Eject Removable
media icon in the system tray to guarantee cache-flushing of the last
portions of written data. Here is an article explaining how it works.

https://atola.com/products/taskforce/manual/multipass-imaging.html
https://www.thewindowsclub.com/make-usb-external-media-perform-faster-windows


Connectivity

Another potential performance bottleneck is network bandwidth. To achieve
maximum throughput, connect ETH1 port to a network or NAS, and ETH2
port to another network or NAS. It will give you 20Gb/s of throughput. It
also depends on your network hardware and setup.

To learn about network throughput optimization, read the official TaskForce
manual:

Jumbo frames for fast imaging to server

Network setup

How to connect TaskForce to a fiber optic
network?

Option 1. Use a 10GBASE-T RJ45 Copper Ethernet to 10G SFP+ Fiber Media
Converter.

This device converts signals from your TaskForce’s 10 Gbit Ethernet ports to
a fiber optic SFP+ connection, enabling high-speed network capabilities.

Option 2. Connect through a switch with SFP+ ports.

Integrating a network switch that has SFP+ ports can bridge TaskForce with
fiber optic networks. Ensure that the switch supports 10 Gbit speeds to
match TaskForce's capabilities.

Important considerations:

Ensure that the SFP+ module is compatible with your switch brand
(e.g., Cisco, Juniper).

Use cables shorter than 55 meters with SFP+ modules; otherwise,
these modules might not function properly.

How do I extend my server network with a
DHCP-enabled switch?

Here is an example of a switch that supports static IP setup via simple web
admin. To set the IP addresses for each current server network node:

Ubiquiti EdgeSwitch 16 XG
Four 10Gb Ethernet ports, twelve 10Gb SFP ports

To configure a Ubiquiti DHCP server:

1. Connect PC and TaskForce to Ubiquiti switch.

2. Set static IP address of PC to 192.168.1.4.

3. Open a browser and enter 192.168.1.2 (default Ubiquiti switch IP).

4. Log in with default credentials: ubnt (both name and password).

5. Go to System > Advanced Configuration > DHCP server > Global.

6. Activate Admin mode by checking the required checkbox and
clicking the Submit button.

7. Go to Pool Summary and click Add to make a new address pool.

8. Enter your:
pool name
network base address (192.168.1.0, for example)
network mask (255.255.255.0)

How do I setup Synology DS218?

1. Go to Control panel > File services > SMB > Advanced settings.

2. Set Maximum protocol to SMB3.

3. Go to Control panel > Shared folder.

4. Click the Create button and specify network folder details.

If you need to get a guest account working, perform the following actions:

1. Go to Control panel > User.

2. Edit the Guest user.

3. Clear the Disable this account checkbox.

How do I set up my network shared folder?

Follow these steps to setup Windows network folder:

1. Go to Settings > Network & Internet > Status > Sharing Options.

2. Open Private (current profile) section.

3. Select Turn on network discovery.

4. Select Turn on file and printer discovery.

5. Open Guest or Public section.

6. Repeat steps 3 and 4 for Guest or Public section.

7. Open All Networks section.

8. Select Turn on sharing so anyone with network access can read and
write files in the Public folders.

9. Select Turn off password protected sharing.

10. Click Save changes.

If the above has not fixed the issue, edit the folder share permissions:

1. Open the Computer Management window (press Win button and
type in Computer Management).

2. Expand System Tools > Shared Folders and click Shares in the left-
side tree.

3. Right-click the shared folder in the central pane and click Properties.

4. Select the Share Permissions tab.

5. Click Add to assign permissions to the shared folder for a user group.

6. In the dialog box, type Everyone and click OK.

https://atola.com/products/taskforce/manual/jumbo.html
https://atola.com/products/taskforce/manual/network-setup.html
https://www.amazon.com/Ubiquiti-Networks-ES-16-XG-Edge-Switch/dp/B01K2Y1HP0


put Default Router Address and DNS

After creating your pool, you can change it via Pool configuration
tab.

9. Click the Save configuration button in the upper right corner of the
window and then Save.

Alternatively, there is a tutorial on Youtube.

To enable 10Gb with jumbo frames:

1. Go to Basic > Port summary.

2. Select ports 0/13, 0/14, 0/15 and 0/16 and click Edit.

3. In the Edit Port configuration window, change Maximum Frame Size
to 9014.

Why does an IP address not show despite an
Ethernet cable being plugged into the unit?

Usually, your network router is responsible for assigning IP addresses to
other computers or devices in the same network.

Make sure your router has DHCP support and it is enabled.

There is no DHCP server on our internal lab
network. How do I assign a static IP address to
TaskForce?

1. In TaskForce, click the menu button in the top right corner.

2. Click Settings.

3. In the Network section, find IP settings for both 10Gb Ethernet cards.

4. Click the pencil button to see Use static IP checkbox.

Atola TaskForce demo video includes a basic explanation of the network
settings. Here's a Youtube video on that.

How do I connect TaskForce 2 to a network
domain?

TaskForce 2 does not require a preliminary setup for working in a domain.
Instead, your flow would be:

1. In the left-side taskbar, click the Image icon.

2. In the left slideout panel, select the source.

3. To select the target, in the File section, click Select file.

4. In the file manager's Local network section, click the Connect button.

5. A new dialog appears with the Domain field.

The entered server will remain in the Local Network section list.

Additionally, in Web API, there's a targetFolderDomain parameter of /start-
image command that may be of use.

7. Select Full control permission (Read & Write permissions) for the
user group you have just added.

8. Click OK.

We strongly recommend using the latest OS versions. It is crucial for
reaching high network transfer speeds.

How do I set up the Windows Server share?

In Control panel:

1. Enable the Guest account (Administrative tools > Add users and
computers > Users).

2. Next, go to Network and sharing center and choose Change
advanced sharing settings.

3. Select Turn On network discovery and Turn on sharing (file and
printers + public folders).

4. In the shared folder access options, add Guest or Everyone.

If the shared folder demands restricted access, please follow this guide.

TaskForce booting does not get completed.
What should I do?

To ensure TaskForce boots correctly, reset the device:

1. Power off TaskForce.

2. Detach all devices and cables from the system (including PSU cable,
Extension module, SATA cables, USB devices/cables, etc.). So the
TaskForce should be just by itself with nothing attached to it at all.

3. Give it 3-5 minutes to fully reset. There are a few internal circuits that
need up to a minute to fully reset after powering off, but we
recommend waiting at least 5 minutes to be sure.

4. Plug only the power cable back in (no network/USB/SATA cables,
etc.).

5. Power TaskForce on and wait for 3-4 minutes.

How to see the syslog for more information
about the issue I am facing?

To download the TaskForce logs:

1. Connect TaskForce to the network so that you can access it from your
PC.

2. An IP address is shown on the IP screen on the front panel of the
unit. Let's say, it is 10.0.0.33.

3. On your PC, open the Chrome browser and enter
http://10.0.0.33/syslog.

4. Click Save.

5. This will download the logs to your PC's Downloads folder.

https://www.youtube.com/watch?v=zi4NGCjRtQU
https://youtu.be/d9Oq08RBS0A?t=2868
https://atola.com/products/taskforce/api
https://atola.com/products/taskforce/manual/accessing-password-protected-servers.html


Wiping

Case management & reports

Subscription

How does SSD Trim work and does it wipe a
drive completely?

SSD Trim doesn't instantly wipe sectors (NAND memory cells) of a drive. It
instructs SSD's firmware which sectors can be wiped by marking them as
'dirty'.

The time of erasure of 'dirty' sectors depends on the SSD manufacturer and
firmware. For instance, recent Samsung SSDs have a so-called foreground
garbage collection. It wipes any erased file almost immediately thanks to a
TRIM command proactively executed by the operating system. In older
SSDs, trimmed sectors can remain intact for minutes or even hours.

The most secure way to erase an SSD entirely is using one of the following
methods:

Secure Erase - for SATA drives
Format NVM or Sanitize - for NVMe drives

The drive's internal implementation of these commands is vendor-specific.
In most drives, it ensures full erasure of an SSD including non-addressable
areas.

Can all reports listed on the main page be
sorted, managed, or deleted?

Yes, they can be filtered, sorted, exported, and deleted. The quickest way to
perform a search is by using the Search field above the reports on the main
page. Entering the task name (Image, Diagnose, Wipe) and/or device
model/serial helps get a more specific output.

To sort, export, or delete reports, you can go to Reports in the top menu,
where all case reports are shown in a table view. Save to helps download
the selected reports in a single ZIP file. There is also a Delete button in the
bottom right corner for your needs.

Can reports only be exported in PDF, can I
export them in RTF format instead?

It should be possible to save a page into RTF. For example, in this Chrome
AddOn you can select the reports and click Print. It will generate a single
page with all selected reports, which can be exported to .RTF file.

How do I activate my unit in a network-free
environment?

There is a single way to perform TaskForce 2 activation or subscription
extension:

1. Enter the TaskForce 2 serial number. It can be found at the bottom of
the unit.

2. TaskForce 2 generates a license key (Internet connection is not
required).

3. You find an Internet-connected PC and visit the website: a.atola.com.

4. You enter the license key and several other details.

Why does Internet Explorer rename TaskForce's
.AFM2 firmware file to a ZIP file?

Internet Explorer identifies an AFM2 file as a ZIP file and automatically
renames it to ZIP. Read this article about the reason Explorer does this. This
issue only occurs in the Internet Explorer.

We suggest using other popular browsers, such as Chrome or Firefox.

https://chromewebstore.google.com/detail/webpage-to-docx/lgnilmnjhjckgcgbljmemfmblpjmjfjn?hl=en-GB
https://chromewebstore.google.com/detail/webpage-to-docx/lgnilmnjhjckgcgbljmemfmblpjmjfjn?hl=en-GB
https://learn.microsoft.com/en-us/previous-versions/windows/internet-explorer/ie-developer/platform-apis/ms775147(v=vs.85)
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5. The website generates a TaskForce activation code.

6. You write the code down or take a photo, and then enter it in the
TaskForce activation screen.


